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Safety
The operator of the ImageXpress® Micro System is assumed to be 
trained in the correct operation of the instrument and the safety issues. 
Throughout the ImageXpress® Micro Widefield High Content Screening 
System User Guide, the word “you” refers to this trained operator. 
Using controls, making adjustments, or performing procedures other 
than those specified in this guide can result in hazardous exposure to 
laser light, high voltage, hot surfaces, or moving parts. Exposure to 
these hazards can cause severe or fatal injury. 

Safety Text Used in this Guide 
Make sure you follow the precautionary statements presented in this 
guide. 

CAUTION! Indicates that damage to the instrument, loss of data, or 
individual injury could occur if the user fails to comply with the advice 
given. 

WARNING! Indicates a possibility of severe or fatal injury to 
the user or other persons if the precautions are not observed.

Note: Highlights information that is critical for optimal performance of 
the system or identifies items of general interest.
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Safety
The Protective Housing
The protective outer housing and instrument panel interlocks are 
designed to protect you from exposure to laser light, hot surfaces, or 
moving parts.

Interlock Failure
There are three safety interlocks on the automated door. Do not 
operate this instrument with the door open.

If you experience any of the following symptoms, you might have 
interlock failure:

• The focusing laser stays on after the automated door is opened. 
• The sample stage or filter mechanisms continue to move after 

the automated door is opened. 
If this is the case, it is unsafe to continue using the ImageXpress Micro 
System. Please contact Technical Support immediately (see Obtaining 
Support on page 34). 

WARNING! Do not defeat the interlocks, open the protective 
housing, or try to gain access to the interior of the instrument 
through any other openings, unless specifically instructed by 
one of the user procedures outlined in this user guide. Read 
each procedure carefully and follow all outlined safety 
precautions. Incorrectly opening the outer protective housing 
can damage the instrument components and result in 
hazardous exposure to laser light, hot surfaces, or moving 
parts. 

WARNING! Do not disable any of the interlocks. When the 
automated door is opened, the interlocks trigger both the laser 
light source and the motion control electronics to turn off to 
prevent hazards associated with laser emission or moving 
parts.
10 5015321 B 
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Non-Interlocked Panels
There are several other panels on the instrument that are intended for 
use by field service personnel and are not interlocked. All non-
interlocked service panels are secured to the protective housing using 
screws and require a special tool to remove. 

Laser Safety
The ImageXpress Micro System is a Class 1 LASER product. Contained 
within the instrument is an embedded Class 3b high power LASER 
(used for autofocus), which the user cannot and should not attempt to 
access. The classification and power of the embedded LASER are as 
follows:

Safety interlocks within the instrument allow samples to be loaded and 
unloaded without exposure to LASER radiation. If the top panel is 
removed for service, the LASER beam remains safely contained within 
the optical system until it passes through the microscope objective, 
which diverges the beam and renders incident power levels below 
Class 1 (1 mW/cm2).

WARNING! Make sure the instrument is powered OFF and 
power cable unplugged in the event you are instructed to 
remove non-interlocked panels. Absolutely do not operate or 
access the interior of this instrument with any covers or panels 
removed.

TableS-1 Embedded laser classification and power

Wavelength Power Duration Embedded Laser’s 
Class

690 nm 20 mW Continuous Class 3b

WARNING! Do not attempt to repair or adjust the LASER. 
Deliberate removal of the top panel, safety interlocks, and 
microscope objective while staring into the LASER beam can 
cause severe eye injury and blindness.
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Safety
Lamp Safety
The ImageXpress Micro System is equipped with an external light 
source. The light source for the Standard model of the ImageXpress 
Micro System is equipped with a 300 W Xenon lamp. These lamps have 
a limited lifetime of approximately 500 hours and will need to be 
replaced upon failure (see Maintaining the ImageXpress Micro 
Instrument on page 153).

Liquid Light Guide 
The ImageXpress Micro System uses a liquid light guide between the 
external light source and the instrument. The light source generates a 
very bright light. In addition, the Standard model of the ImageXpress 
Micro System uses a high-powered Xenon lamp. The infrared and 
ultraviolet radiation generated by these lamps can cause significant 
skin burns and eye damage.

WARNING! In the event that a lamp requires replacement, 
ensure that you have allowed the lamp to cool for at least 
30 minutes. The lamp generates an extreme amount of heat 
and attempting to remove the lamp immediately after use can 
result in injury. 

Note: The XL model of the ImageXpress Micro System is equipped with 
an external solid-state light source that has a rated lifetime of more 
than 15000 hours. There are no user-replaceable parts in this light 
source.

WARNING! Do not remove the light guide from the instrument 
or the light source when the lamp is powered on.
12 5015321 B 
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High-Voltage Hazard 
There are no high-voltage electronics found inside the ImageXpress 
Micro System. High-ignition voltages do exist inside the external Xenon 
lamp light-source housing, which can be lethal. 

Moving Parts
The ImageXpress Micro System contains moving parts that can cause 
injury. Under normal conditions, the instrument is designed to protect 
you from these moving parts. The interlocks and protective housing are 
designed so you cannot access the moving parts during a scan. 

Fuses
In the Standard model of the ImageXpress Micro System, the Xenon 
light source contains a fuse. In the event of fuse failure, disconnect the 
power cord from the light source and consult Maintaining the 
ImageXpress Micro Instrument on page 153 for instruction on how to 
replace the fuse.
In the XL model of the ImageXpress Micro System, the supplied 
external power supply for the solid-state light source provides over-
current protection for the light source limited to 7.9A maximum. The 
solid-state light source and power supply contain no user-serviceable 
parts.
The instrument power supply contains a circuit-breaker switch with a 
trip point of 18.75 amps.

WARNING! Do not operate the light source with the housing 
open or powered ON.

WARNING! Do not try to gain access to the interior of the 
instrument unless specifically instructed to do so. The moving 
parts inside the instrument can cause injury. Do not operate 
this instrument with covers or panels removed.
5015321 B 13 



Safety
Power Supply
The ImageXpress Micro System has one cable running from the 
instrument to the external power supply (input voltage range is from 
100 to 240 VAC, 50/60 Hz, 2 A). 

Figure S-1 Power supply label 

Lifting Hazard 

WARNING! Make sure this cable is unplugged before accessing 
any part of the instrument. Failure to do so can result in 
serious harm.

WARNING!  The ImageXpress Micro System weighs 
approximately 180 lbs (82 kg). Do not attempt to lift or move 
the instrument without assistance. Moving your instrument 
can disrupt sensitive optical alignments. Molecular Devices 
recommends that you contact Technical Support to schedule a 
Field Service engineer to help with moving your instrument. 
Your warranty or service contract will not cover problems 
caused during or as a result of shipment or relocation.
14 5015321 B 
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Maintenance and Service
User service and maintenance is strictly limited to the procedures 
outlined in this user guide. Access for the majority of these procedures 
is through the interlocked panels described in The Protective Housing 
on page 10. No other user service that is not outlined within this user 
guide is permitted. If there is a problem or you have questions, please 
contact Technical Support. 

List of Controls 
This guide constitutes a list of controls. 

Hazardous Material Precautions 
Use standard laboratory procedures and cautions when working with 
chemicals. 

WARNING! Use of controls, adjustments, or performance of 
procedures other than those specified within this user guide 
can result in hazardous conditions or injury.

WARNING!  Always follow the manufacturer’s precautions 
when working with chemicals. Molecular Devices is not 
responsible or liable for any damages caused by or as a 
consequence of the use of any hazardous material.
5015321 B 15 



Safety
Safety Label
If the label becomes illegible or is missing for any reason, please 
contact Technical Support for a free replacement label. While waiting 
for a replacement label, copy the label below and attach a copy of the 
label to the instrument.

Figure S-2 Safety label
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Symbol Explanations

TableS-2 Symbols

Symbols Indication

Indicates a potential pinch hazard location

Indicates that the product contains a laser radiation source

Indicates that product documentation needs to be consulted

Indicates heavy object, lifting hazard

Indicates Alternating Current

Indicates Direct Current

Indicates power on

Indicates power off

Indicates the location of the Protective Earth Ground Terminal

Indicates that you must not discard this electrical/electronic 
product in domestic household waste
5015321 B 17 



Safety
Indicates fuse

TableS-2 Symbols (cont’d)

Symbols Indication
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1
Introduction
Overview
The ImageXpress® Micro Widefield High Content Screening System 
from Molecular Devices is an integrated cellular imaging and analysis 
system that is designed for rapid, automated screening of fluorescently 
labeled biological samples in microplates.
The core hardware component of the imaging system is a custom-
designed, fully automated, epi-illumination fluorescence microscope, 
with rapid autofocus and precision sample movement features that 
allow large numbers of high-resolution images to be acquired in the 
shortest possible time. All key optical and mechanical elements are 
motorized, with asynchronous command execution, thereby allowing 
complete real-time control of the instrument configuration through the 
MetaXpress® High Content Image Acquisition and Analysis Software 
interface.
When used in combination with the powerful imaging capabilities of the 
MetaXpress Software, the instrument becomes an extremely flexible 
and programmable device, ideally suited for user-defined, high-speed 
automated assays.
Key components of the instrument include the following:

• External light source connected by a liquid light guide
• User-specified camera

A cooled CCD camera in the standard model
A scientific CMOS camera in the XL model

• Fast laser autofocus system with precision motorized Z (focus) 
stage

• Image-based autofocus
• Precision motorized X-Y (sample) stage
• High-quality user-changeable Nikon objectives in a four-position 

linear selector
• User-changeable filter cubes in a five-position slider
• Selectable binning modes to decrease exposure time and 

increase throughput
• Motorized selection of stage position, filter cubes, and objectives 

with asynchronous operation
• High-transmission fluorescence imaging optics with world-class 

chromatic aberration correction, resolution, and image flatness
• Operation and configuration by integrated MetaXpress Software
• Plate-handling robot (optional) with automated barcode reader
5015321 B 19 
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ImageXpress Micro Instrument

Figure 1-1 ImageXpress Micro System Components

Illumination System: Excitation 

Light Source 

The ImageXpress Micro System has an external light source, which 
provides continuous, high-intensity broadband illumination.

• In the Standard model of the ImageXpress Micro System, the 
300 W, long-life Xenon lamp has an expected lifetime of more 
than 500 hours.

• In the XL model of the ImageXpress Micro System, the solid-
state light source has an expected lifetime of more than 
15000 hours.

Cold Mirror 

In the Standard model of the ImageXpress Micro System, the Xenon 
lamp light source incorporates a cold mirror which prevents light with 
wavelengths longer than 675 nm from reaching the sample. Limiting 
the wavelengths of the light source minimizes sample heating and 
stress on optical components.

DC power

DC power

Camera I/O

USB 2.0

Liquid light
guide

Light
source

Main
power
supply

Camera
power
supply

ImageXpress Micro
System

(main unit)
Computer Monitor

RS-232 to USB 2.0 (XL model only)

Note: In the XL model of the ImageXpress Micro System, the solid-
state light source is limited to between 380 nm and 680 nm.
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Light Guide 

A liquid light guide couples the light from the light source to the 
illumination optics in the ImageXpress Micro System unit. The light 
source assembly is precisely aligned with the light guide during 
manufacture, and requires no further position adjustment. 

Illumination Optics 

The output end of the liquid light guide is imaged onto the sample by a 
set of internal optics and the objective, providing bright and uniform 
illumination of the specimen over a wide field of view. This constitutes 
an Abbé illumination system (also called critical illumination).

Shutter (standard model only)

A solenoid-activated mechanical shutter controls the exposure of the 
sample to excitation light to minimize sample degradation and 
photobleaching. 

Filter Cube Changer 

The 5-position filter cube changer takes standard Nikon TE2000 filter 
cubes. The ImageXpress Micro System uses Semrock filters. 

Objective (Z) Stage 

Motorized Z Stage 

The Z stage is controlled by a linear encoder and has better than 
100 nm resolution. 

Objectives 

Standard objectives are Nikon CFI60 series. The selected objective lens 
focuses excitation light onto the sample, and collects fluorescence light 
emitted by the sample. Molecular Devices offers a wide range of 
objectives to suit your experimental needs. 

Motorized Objective Changer 

There is a 4-position objective changer. Only the selected objective 
moves up and down in Z. 
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Sample (X-Y) Stage 

Sample 

The plate holder is designed for scanning multi-well plastic and glass 
bottom microplates in standard ANSI (SBS) formats, but can 
accommodate other plate formats that have standard microplate 
footprint dimensions. For example, glass slides can be imaged using a 
slide adapter included in the tool kit. Optimum image quality depends 
on plate flatness and optical clarity. 

Plate Holder and Plate Clamp 

A spring-loaded mechanical clamp holds the sample plate securely in 
the plate holder. The clamp automatically opens when the X-Y stage 
moves to the load/unload position, and automatically closes when the 
X-Y stage moves the plate into position for imaging. 

Motorized X-Y Stage 

The X-Y stage is controlled by a linear encoder and has better than 
100 nm resolution. 

Autofocus Laser (optional)
A red (690 nm) diode laser projects a laser spot onto the sample. 
Reflections of this spot from the bottom of the microplate and the 
plate-sample interface are imaged by a dedicated, fast-focus sensor, 
and are used as a reference for focusing using the autofocus feature of 
the MetaXpress Software. 

Imaging System: Emission

Tube Lens

The tube lens collects collimated light from the objective and focuses it 
onto the detector plane of the camera. The emission wavelength range 
is 400 nm to 750 nm.
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Camera

The Standard model of the ImageXpress Micro System is shipped with a 
cooled CCD camera. This camera has a 1392 × 1040 pixel resolution 
(6.45 × 6.45 µm pixel size), and has a peak quantum efficiency greater 
than 60% at 550 nm. 
The XL model of the ImageXpress Micro System is shipped with a 
scientific CMOS camera. This camera has a 2560 × 2160 image sensor 
format (6.5 × 6.5 µm pixel size), and has a peak quantum efficiency of 
60% at 550 nm. The center 2160 x 2160 pixels are extracted during 
plate acquisition to ensure adequate illumination uniformity.

Electronics 
The ImageXpress Micro instrument also contains the following 
components:

• External power supply and cable.
• USB 2.0 port and cable to computer for device control.
• Camera cabling to camera board in computer.

MetaXpress Software
Use the MetaXpress® Software with the ImageXpress Micro System to 
select a standard image analysis routine or to develop a custom 
protocol to fit your specific acquisition and analysis needs. The 
MetaXpress Software workflow is divided into two major parts: 
acquisition and analysis. 

• The acquisition workflow involves configuring settings, acquiring 
images, and storing plate data in a database. See Preparing For 
Acquisition on page 61, Setting Up Plate Acquisition on page 67, 
and Acquiring Plates on page 129.

• The analysis workflow consists of processing, enhancing, and 
analyzing acquired plate data. See the MetaXpress High Content 
Image Acquisition and Analysis Software Analysis Guide 
included on the MetaXpress Software installation USB flash 
drive. 
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Administrator Tasks
Most of the procedures in this document are for the general users. 
However, Molecular Devices recommends that you identify one or more 
users as advanced users or system administrators. The responsibilities 
of the system administrator vary from site to site. Variables include the 
number of users on the system, the type of database used, and the 
type of work done. Some common MetaXpress Software system 
administrator tasks include:

• Installation overview with a Molecular Devices representative
• Post-installation hardware and software testing
• Database planning and implementation
• Custom user and group settings creation
• Maintenance scheduling and software updating

Basic Operational Theory

Fluorescence Imaging 
Fluorescence is a phenomenon observed in certain species of molecules 
(fluorochromes, or dyes) in which photons of a specific wavelength are 
absorbed (excitation), and as a result a very short time later photons 
are emitted at a longer wavelength (emission). The utility of 
fluorescence imaging in biological applications stems from the ability to 
conjugate fluorescent molecules with biologically active probe 
molecules, so that application of the combined dye/probe molecule 
(fluorophore) to the specimen highlights the specific substances or 
regions to which the probe is targeted. 
Further, by attaching different probes to a set of dye molecules with 
non-overlapping excitation and emission spectra, one can stain a 
specimen with multiple fluorophores, and either simultaneously or 
sequentially image different structures or substances within the same 
specimen. The absorption and emission peaks for each dye in a given 
environment are physical characteristics of that molecule, and their 
specific properties determine the initial selection of the optical 
components to be used: emission and excitation filters, and dichroic 
mirror. 
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Excitation and Emission Filters 
In the ImageXpress Micro System, the excitation and emission filters 
are located in a filter cube. 
To selectively excite one fluorophore more intensely than another, or to 
minimize excitation channel crosstalk, it is necessary to provide 
illumination containing only photons with a wavelength range matched 
to the target dye's absorbance (excitation) spectrum. If the primary 
illumination source provided is broadband, such as in the ImageXpress 
Micro System, a bandpass filter in the illumination optical path (called 
the excitation filter, since it filters the excitation light) is used to restrict 
the illumination spectrum to a narrow range of wavelengths. 
Similarly, when imaging the illuminated sample, it is desirable to collect 
only the emission photons from the target fluorophore, rejecting as 
much as possible any reflected or scattered excitation light, any light 
from other dyes, and autofluorescence from the sample and substrate. 
This is accomplished by placing a filter in the collection light path, 
called the emission filter. Emission filters can either be of the bandpass 
variety, for maximum specificity, or longpass, to maximize the amount 
of emission light collected.

Dichroic Mirror 
In the ImageXpress Micro System the dichroic mirror is in a filter cube. 
A dichroic mirror is a specially designed beam splitter that transmits 
light above a certain cutoff wavelength, and reflects light at shorter 
wavelengths. This is the essential component that allows the 
construction of an epi-illumination fluorescence imaging system such as 
ImageXpress Micro System, in which the illumination and imaging 
optical paths overlap at the objective lens. That is, the same objective 
lens is used to focus the illumination light onto the sample as well as 
collect the emitted fluorescent light to form the image. 
In the illumination path, the dichroic mirror reflects shorter 
wavelengths from the light source up through the objective onto the 
specimen, as shown in Figure 1-2.
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Figure 1-2 Dichroic mirror creates two light pathways

Incident light from the illumination source that is longer wavelength 
than the cutoff is transmitted to a beam dump that absorbs and 
diffuses the waste light to prevent it from entering the imaging optical 
path. 
In the imaging optical path, longer wavelength fluorescence light 
emitted by the excited fluorophores in the specimen is collected by the 
objective lens, and transmitted by the dichroic through to the tube lens 
and camera. Incident light from the sample that is shorter wavelength 
than the cutoff (mostly reflected illumination light from the sample) is 
reflected by the dichroic (and further blocked by the emission filter), 
and is therefore prevented from entering the imaging system of tube 
lens and camera. 
Dichroic mirrors are interference filters made by depositing a number of 
thin film coatings on a glass support. Dichroics need to be kept thin for 
high image quality, so the supporting glass is quite fragile, and 
generally the film coating is not protected with a cover glass. This 
means that unprotected dichroics are delicate and easily damaged 
components, and so care must be taken when handling them. 
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Dichroic Transmission Spectrum 

An ideal dichroic mirror would have an infinitely sharp cut-off: that is, it 
would have unity transmittance coefficient at wavelengths longer than 
the cut-off, and zero transmittance (and therefore unity reflectance in a 
non-absorbing dichroic mirror) shorter wavelengths. In practice, the 
characteristic transmission spectrum for a dichroic looks something like 
Figure 1-3.

Figure 1-3 Example of a transmission spectrum of a dichroic

In principle, the cutoff wavelength (or midpoint of the cutoff region) of 
the dichroic should be chosen to lie halfway between the absorption 
and emission peaks of the chosen fluorochrome, as this will 
simultaneously maximize the amount of excitation light available at the 
sample, and also the amount of collected fluorescence emission that is 
transmitted to the camera. In practice, however, additional 
considerations such as fluorochrome efficiency can dictate that the 
cutoff region is biased towards one peak or the other-allowing, for 
example, greater transmission of longer wavelength image photons at 
the expense of less reflection of shorter wavelength excitation light. 
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Objective Lenses 
The ImageXpress Micro System can be configured with any of the high 
quality Nikon objectives listed in Appendix C: Objectives Compatible 
with the ImageXpress Micro System on page 189.
If the objective you want to use is not listed, please contact us to verify 
compatibility with the ImageXpress Micro System. 
Note that the extra-long working distance (ELWD) objectives have 
adjustable spherical-aberration correction collars for imaging through 
thick substrates such as most microplates. Please see Maintaining the 
ImageXpress Micro Instrument on page 153 for details on how to 
calculate and set their correct values.   
Several of the other objectives (such as, CFI SUPER FLUOR 40X) also 
have correction collars for adjustment according to the thickness of the 
glass cover slip being used. Setting of these collars should be done 
according to the cover slip manufacturer’s specifications or through 
optimization of image quality. 
Objectives are classified here according to optical correction, flatness of 
field, numerical aperture, and working distance. Before choosing 
additional objectives to use with your system, it is important to 
consider the types of plates you will be imaging. The plate material 
(plastic vs. glass) and thickness are major considerations when 
choosing an objective. Another important practical note is that 
generally the greater an objective's correction, the greater the number 
of lens elements it contains, with correspondingly reduced light 
transmission, especially in the UV spectrum. In particular, apochromatic 
(“Apo”) objectives tend to have poor UV transmission characteristics. 
For detailed information on objectives, please see the Nikon website 
(www.nikon.com).
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2
Getting Started
This chapter provides a quick overview of the start-to-finish workflow 
for using the ImageXpress® Micro System. The following topics are 
included in this chapter:

• Starting the ImageXpress Micro System on page 29
• Acquiring Data on page 33
• Analyzing Data on page 33
• Maintaining the Instrument on page 33
• Shutting Down the System on page 33
• Obtaining Support on page 34

Starting the ImageXpress Micro System
This section explains how to safely power up the ImageXpress® Micro 
instrument and log in to the MetaXpress® Software.

Powering On the Instrument
1. Ensure that the power cords for the instrument and the lamp are 

connected to a 100 VAC to 120 VAC or 220 VAC to 240 VAC 
power source. 

2. Turn on the power switch on the light source power supply unit.

3. Wait for the light source to stabilize before acquiring images.
In the Standard model of the ImageXpress Micro System, 
the Xenon lamp takes 15 to 20 minutes to stabilize.
In the XL model of the ImageXpress Micro System, the solid-
state light source takes less than a minute to stabilize.

4. Turn on the power switch on the front of the ImageXpress Micro 
power supply unit.

5. Ensure that the camera power supply is plugged in and, if 
required, turned on.

6. Turn on the power to the host computer and the monitor.

Note: Turn on this power supply first to minimize electrical pulse 
interference with the electronic components in your system.
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7. After the computer has started and Windows is running, log in to 
Windows using the User Name/Password combination provided 
for you by your system administrator.

CAUTION! Do not log into your system as “Guest” unless you are 
specifically instructed to do so by your system administrator.

8. Continue to the next procedure, Starting the Software on 
page 30.

Starting the Software
To start the MetaXpress Software, complete the following procedure:

1. Double-click the MetaXpress icon on your desktop or click Start > 
Programs > MetaXpress > MetaXpress. 

Note: This procedure assumes that your ImageXpress Micro System 
and your MetaXpress Software have been properly installed and 
configured by your Molecular Devices representative and your System 
Administrator.

Note: If you encounter or observe actions or results that are 
inconsistent with your expected results when using ImageXpress Micro 
System and your MetaXpress Software, contact your system 
administrator before continuing your experiment.
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The MetaXpress Software title screen appears.

Figure 2-1 MetaXpress Software title screen

2. From the User Name field, select the user name to use and then 
click OK. 

Note: This screen appears only when the MetaXpress Software 
is configured to run in multi-user mode from within the Meta 
Imaging Series Administrator. If you do not see this screen, the 
MetaXpress Software is in single-user mode. Continue to 
Step 3.
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The MetaXpress Software starts and a progress bar at the 
bottom of the dialog indicates the loading progress of the 
program. After the program loads, the Welcome to MetaXpress 
dialog appears.

Figure 2-2 Welcome to MetaXpress dialog 

3. Select the data source to connect to (if there is more than one), 
enter your login name and password, and then click OK. 
A dialog appears prompting you to select a Group.

4. Select one of the groups assigned in the Meta Imaging Series 
Administrator and click OK. 
The MetaXpress Software application starts and initializes the 
various components of the ImageXpress Micro System. If you 
receive error messages when the system is initializing, ensure 
that all hardware connections are plugged in and fully seated.

Note: For versions 4.0 and 5.0 of the MetaXpress Software, the 
default User Login Name is MolDev, the default System 
Administrator Login Name is sa, and the default password for 
both is moldev. For earlier versions of the software, the default 
User Login Name and password was mdc. You might need to 
log in using mdc if you had an earlier version of the software on 
your instrument workstation. If needed, you can change the 
password by clicking Change Password. 
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Acquiring Data
The acquisition workflow involves configuring settings, acquiring 
images, and storing plate data in a database. 
For detailed information, see the following chapters:

• Preparing For Acquisition on page 61
• Setting Up Plate Acquisition on page 67
• Acquiring Plates on page 129

Analyzing Data
The analysis workflow consists of processing, enhancing, and analyzing 
acquired plate data. See the MetaXpress High Content Image 
Acquisition and Analysis Software Analysis Guide included on the 
MetaXpress Software installation USB flash drive.

Maintaining the Instrument
Specific user-level maintenance can be performed on the ImageXpress 
Micro System for changing the lamp and fuse, changing filter cubes, 
Changing and cleaning objectives, and cleaning the instrument as 
described in Maintaining the ImageXpress Micro Instrument on 
page 153.
For all other service and maintenance needs, please contact Molecular 
Devices. See Obtaining Support on page 34.

Shutting Down the System
1. Exit the MetaXpress Software application. 

The software prompts you to save any open images.
2. Turn off the power to the computer and the monitor.
3. Turn off or unplug the power to the camera power supply.
4. Turn off the power to the light source unit.

5. Turn off the power switch on the front of the ImageXpress Micro 
System power supply unit.

Note: Do not power cycle the light source too frequently. It is 
better to leave the light source on for a short while when it is 
not being used than to turn it on and off frequently. If the light 
source is unused for a longer period of time, turn it off.
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Obtaining Support
Part of effective communication with Molecular Devices is determining 
the channels of support for the ImageXpress Micro System, including 
the MetaXpress® High Content Image Acquisition and Analysis 
Software. Molecular Devices provides a wide range of support:

1. Documentation — Check the manuals that are included on the 
installation media and the help that is available within the 
MetaXpress Software. Help for an active dialog box can be 
accessed by pressing the [F1] key. 

2. Online knowledge base — The knowledge base has links to 
technical notes, software upgrades, newsletters, manuals, and 
other resources. Visit the Molecular Devices Support web page 
at www.moleculardevices.com/support and follow the links to 
the knowledge base. 

3. Technical Support — 
Phone: Contact Technical Support at (800)-635-5577 (U.S. 
only) or +1 408-747-1700. 
Online: Visit www.moleculardevices.com/support and follow the 
links in the knowledge base to the Technical Support Request 
Form to send an e-mail to a group of experienced Technical 
Support representatives. 
Please have the system ID number, system serial number, 
software version number, and the system owner’s name 
available when you call.

To find your system ID number, from the Help menu, select 
About MetaXpress. The dialog that appears displays your 
system ID number. 
The system serial number is located on your instrument.

4. Additional support resources include:
Nikon web-based microscopy course — 
http://www.microscopyu.com 
The Molecular Probes handbook — 
http://www.probes.invitrogen.com offers advice on 
fluorescent probes and can help you determine if there are 
better stains available for your analysis.

The following sites offer filter information:
http://www.chroma.com
http://www.semrock.com
http://www.omegafilters.com
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Gathering Support Information

If you need to contact Molecular Devices for support, it is very 
important to have the following information available to help Technical 
Support personnel troubleshoot the problem you are experiencing:

• The steps that led up to the occurrence of the problem
• The settings of any dialogs used when the problem occurred
• The text of any error messages

You should also collect the following information from your system 
whenever reporting software problems:

• Copy of the Plate Acquisition Settings file: By default, the plate 
acquisition settings file is saved to the database. To save the 
settings to a file, go to the Experiment tab of the Plate 
Acquisition Setup dialog, click Save Settings, and then select 
Save to file rather than database. The settings file will then 
be saved to the C:\MX5\HTSSTATE folder by default.

• Journal files: If you were running a journal when the problem 
occurred, include copies of the journal files that you were using. 
By default, journal files are saved in the 
C:\MX5\app\mmproc\journals folder. If you are running journals 
through the review plate data tab, then the journals are saved in 
c:\analysis and c:\assay.

• System Information Report: This report contains information 
about many system settings and the release levels of all the.dll 
files in your currently installed MetaXpress Software. For 
information on how to create a System Information report to 
email to Molecular Devices, see Creating a System Information 
Report on page 37.

Logging AxoTrace Messages to a .txt File
AxoTrace tracks the hardware status of the ImageXpress Micro System 
and logs all the hardware activities of the system. If the error occurs 
downstream of the initial cause, AxoTrace provides a log that Molecular 
Devices Technical Support can use to trace the error back to the 
original cause and pinpoint the problem. Use the procedure below if a 
reproducible hardware error occurs. Follow the AxoTrace setup 
procedure and record the steps that lead to the error. If the error 
results in the instrument not starting up, not responding, or the error 
cannot be reproduced, contact Molecular Devices Technical Support 
immediately.
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To log AxoTrace messages to a .txt file

1. Open the MetaXpress Software and AxoTrace starts 
automatically.
The AxoTrace icon appears in the toolbar.

Figure 2-3 AxoTrace icon in toolbar

2. Close the MetaXpress Software.
3. Double-click the AxoTrace icon in the toolbar.
4. In the AxoTrace window, click Options > Output to File and make 

sure that the Time prefix option is selected.

Figure 2-4 AxoTrace Options menu

5. Click File > Save As.
6. In the Save As dialog that appears, in the Name field, navigate to 

the location where you want to save the log file, type the file 
name (for example, axotrace log.txt) and then click Save to save 
the log file.

7. Close the AxoTrace dialog and then start the MetaXpress 
Software.
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8. Turn off the ImageXpress Micro System and then turn it back 
on. The light source can remain on during this step.

9. Reproduce the error and after the error is reproduced, close the 
MetaXpress Software. 

10. Send the AxoTrace log as an e-mail attachment to Molecular 
Devices Technical Support.

Creating a System Information Report

Much of the required system setting information can be obtained by 
creating a System Information Report. You create this report from the 
About MetaXpress dialog on the Help menu. This report can be printed 
on a printer connected to your system or a network printer, or it can be 
“printed” to a PDF file or to an ASCII text file. After the report is in the 
form of a PDF file or a text file, you can send this report to appropriate 
Molecular Devices support personnel as an email attachment. 
Figure 2-5 shows the About MetaXpress Software dialog.

Figure 2-5 About MetaXpress Software
5015321 B 37 



Getting Started
38 5015321 B 



3
System Installation and Testing
System Installation
The ImageXpress® Micro System is shipped fully configured, and is 
installed at your site by a Molecular Devices field service engineer. The 
base system includes the imaging unit, host computer, and toolkit that 
includes a slide holder, three calibration slides, hex wrenches for 
changing filter cubes, and a TetraSpeck bead plate.
The ImageXpress Micro System host computer is shipped with the 
MetaXpress Software already installed, and the instrument is connected 
to the host computer during installation. There are four main 
connections, excluding power cords: 

• Power supply to the ImageXpress Micro System
• Light guide from the external lamp to the ImageXpress Micro 

System
• USB 2.0 data cable from the ImageXpress Micro System to the 

host computer
• Cable from the camera to the computer
• Camera power supply cable to the ImageXpress Micro System. 

If you need to install or re-install the MetaXpress Software on a new 
computer, please see the MetaXpress High Content Image Acquisition 
and Analysis Software Installation Guide included on the MetaXpress 
Software installation USB flash drive, or contact Technical Support.
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Verifying Device Settings in the Meta Imaging Series 
Administrator

This procedure ensures that the ImageXpress Micro System hardware 
components are properly configured in the Meta Imaging Series 
Administrator application and the MetaXpress Software application. All 
hardware and software configuration settings are implemented in the 
Meta Imaging Series Administrator application.

To check the hardware configuration in the Meta Imaging Series 
Administrator application, complete the following procedure:

1. Use the procedure described in Powering On the Instrument on 
page 29, to power up the system, but do not start the 
MetaXpress Software application.

2. From the Windows Start menu, click AllPrograms > MetaXpress > 
Meta Imaging Series Administrator. 
The Meta Imaging Series Administrator program opens.

3. Select MetaXpress from the List of Groups field.

Figure 3-1 Meta Imaging Series Administrator Program

Note: For additional information about any of the dialogs in the Meta 
Imaging Series Administrator, press the F1 key to access the 
application help for the active dialog. The Meta Imaging Series 
Administrator and the MetaXpress Software application cannot be run 
simultaneously.
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4. Click Configure Hardware.
The Configure Hardware dialog appears.

5. Click Configure Devices. 
The User Settings hardware configuration dialog appears.

Figure 3-2 User Settings hardware configuration dialog

6. Select ImageXpress Micro X from the Claimed Devices list and 
then click Settings. 
The ImageXpress Micro X Settings dialog appears.

7. Increase the step size to 10,000µm.
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Figure 3-3 ImageXpress Micro X Settings dialog 

8. Ensure that Reverse Coordinate System is NOT checked.
9. Click the icon and confirm that the stage responds to the 

control.
10. Change the step size back to 10µm and click OK.
11. Select ImageXpress Micro Y from the Claimed Devices list and click 

Settings. 
The ImageXpress Micro Y Settings dialog appears.

Figure 3-4 ImageXpress Micro Y Settings dialog
42 5015321 B 



ImageXpress Micro Widefield High Content Screening System User Guide
12. Increase the step size to 10,000µm.
13. Ensure that Reverse Coordinate System check box is selected.
14. Click the icon and confirm that the stage responds to the 

control.
15. Change the step size back to 10µm and click OK.
16. Select ImageXpress Z from the Claimed Devices list.
17. Click Settings. 

The ImageXpress Z Settings dialog appears.
18. Verify that the value in the Device Units field is 50.
19. Increase the step size to 1000µm.
20. Click the icon and confirm that the Z Motor responds to the 

control.
21. Change the step size back to 10µm and click OK.
22. Select ImageXpress Objective from the Claimed Devices list and 

click Settings. 
The ImageXpress Objective Settings dialog appears.

Figure 3-5 ImageXpress Objective Settings dialog
5015321 B 43 



System Installation and Testing
23. Confirm that the Objective labels and values in the Num Aperture 
fields match each objective on your system. The Numerical 
Aperture (NA) values are written on each objective. Position 1 is 
the position on the right if you are facing the filter cube access 
door at the front of the instrument.

24. Click the Param Group #1 tab in the Objective Parameters section 
on the bottom half of the dialog. This tab contains the Z offset 
positions in microns for the objectives. Confirm that these are 
valid numbers and all but one are greater than 0.

25. Click Param Group #2, then click Open Control Dialog. 
The Control – ImageXpress Micro Objective dialog appears.

26. Click the arrow buttons and confirm that the objective changer 
is moving appropriately.

27. Click Done, then click OK to close the dialog.
28. Select ImageXpress Micro Filter Cube from the Claimed Devices list 

and click Settings.
The ImageXpress Micro Filter Cube Settings dialog appears.

Figure 3-6 ImageXpress Micro Filter Cube Settings dialog

Note: If you need to determine the offset values, see 
Configuring Parfocality after Changing Objectives on page 165.
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29. Confirm that the filter sets listed in the Filter Labels field are 
correct. Position 1 is the position closest to you if you are facing 
the front of the instrument (the side with the filter cube access 
door).

30. Click Open Control Dialog. 
The Control – ImageXpress Micro Filter Cube Settings dialog 
appears.

31. Click the arrow buttons to confirm that the filter cube is 
responding to the program. 

32. Click Done, then click OK to close the ImageXpress Micro Filter 
Cube Settings dialog.

33. Select ImageXpress Micro Shutter from the Claimed Devices list 
and click Settings. 
The ImageXpress Micro Shutter Settings dialog appears.

Figure 3-7 ImageXpress Micro Shutter Settings dialog

34. Confirm that the Open Delay and Close Delay fields are both set 
to 20 milliseconds.

35. Click Open Shutter Control Dialog. 
The Control – ImageXpress Micro Shutter Settings dialog 
appears.

36. Click Toggle to confirm that the shutter is responding.
37. Click Done, then click OK to close the ImageXpress Micro Shutter 

Settings dialog.

Note: If you have a plate handling robot attached to the 
ImageXpress Micro System, you should confirm those settings 
as well. For information, see Verifying External Control Settings 
on page 197.
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38. Click OK to close the User Settings hardware configuration dialog 
and continue to the next procedure.
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Verifying Camera Settings in the Meta Imaging Series 
Administrator 

Complete the following procedure to ensure that the correct version of 
the ImageXpress Micro System camera driver is installed:

1. From the Configure Hardware dialog, click Configure Acquisition.
2. In the Configure Acquisition dialog, ensure that a driver is listed 

in the Installed Drivers column.
3. If a driver is not listed in the Installed Drivers column, or if more 

than one driver is listed, contact Molecular Devices support to 
determine which driver is required for your system.

4. In the Installed Drivers column, select the appropriate driver.
5. Click Configure to query the camera. 
6. In the camera driver dialog, ensure that the camera is available 

in channel 1. This confirms that the camera is responsive. 
7. If the camera was not queried successfully, ensure that the 

cabling is correct from the ImageXpress Micro System main unit 
to the computer and that the camera power supply is plugged in 
and, if required, turned on.

8. Click OK to close the camera driver dialog.
9. Click OK to close the Configure Acquisition dialog.
10. Click OK to close the Configure Hardware dialog.
11. Click OK to close the Meta Imaging Series Administrator and 

then continue to the next procedure.

Verifying and Backing Up Settings in the MetaXpress 
Software Application

After confirming hardware settings in the Meta Imaging Series 
Administrator, you should also check the following settings from within 
the MetaXpress Software application:

• Magnification Settings
• Illumination Settings
• Calibration Settings
• Laser Autofocus Sensor Settings

During the verification process, it is recommended that you backup 
these settings as described in the procedures. This will allow you to 
restore the settings in case they are lost.
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Verifying and Backing Up Magnification Settings 

You will need to confirm magnification settings for the ImageXpress 
Micro System objectives before using your system. Complete the 
following procedure to check the magnification settings in the 
MetaXpress Software application:

1. Open the MetaXpress Software application and log into the 
database.

2. Select Configure Magnification from the Devices menu. 
The Configure Magnification dialog appears.

Figure 3-8 Configure Magnification dialog 

3. Ensure that the ImageXpress Micro setting exists and its 
checkbox is selected in the Settings field. 

4. Confirm that the Defined Settings field contains a setting for each 
objective on your system.

5. Click Backup. 
The Backup All Magnification Settings dialog appears.

6. Select a name and location for the backup and click Save.
7. Settings can be restored by clicking Restore and choosing the 

saved file.
8. Click Close to exit the Configure Magnification dialog.

Note: For additional information about any of the dialogs in the 
MetaXpress Software application, press the F1 key to access the 
online help for the active dialog.
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Verifying Illumination Settings
You will need to confirm illumination settings for the ImageXpress Micro 
instrument before using your system. Complete the following procedure 
to check the Illumination settings in the MetaXpress Software 
application:

1. Open the MetaXpress Software application and log into the 
database.

2. From the Devices menu, select Configure Illumination. 
The Configure Illumination dialog appears.

3. Ensure that ImageXpress Micro Filter Cube is selected in the 
Device Positions field.

4. Ensure that the ImageXpress Micro Shutter is selected as Active 
for each filter set.

5. Ensure that the correct illuminations are listed in the Defined 
Settings field.

Figure 3-9 Configure Illumination dialog

6. Set up other illumination settings if needed. Note that the value 
in the Wavelength field should match the center wavelength for 
the emission filter.

7. Click Backup. 
The Backup All Illumination Settings dialog appears.

8. Select a name and location for the backup and click Save.
9. Settings can be restored by clicking Restore and choosing the 

saved file.
10. Click Close to exit the Configure Illumination dialog.
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Verifying and Backing Up Calibration Settings 
Complete the following procedure to confirm and backup calibration 
settings in the MetaXpress Software application:

1. From the Measure menu, select Calibrate Distances. 
The Calibrate Distances dialog appears.

2. Confirm that there are calibration settings in the dialog that 
match the objective settings from the Configure Magnification 
dialog.

Figure 3-10 Calibrate Distances dialog

3. Click Save to File. 
The Save Spatial Calibrations dialog appears.

4. Select a name and location for the backup and click Save.
5. Settings can be restored by clicking Load from File and choosing 

the saved file.
6. Click Close to exit the Calibrate Distances dialog.

Table 3-1 shows estimated values that can be used for 
ImageXpress Micro System calibration settings.

Table3-1 Estimated Calibration Settings

Objective Estimated Calibration

1x 6.50 µm/pixel

2x 3.25 µm/pixel

4x 1.63 µm/pixel
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10x 0.65 µm/pixel

20x 0.33 µm/pixel

40x 0.16 µm/pixel

60x 0.12 µm/pixel

100x 0.07 µm/pixel

Table3-1 Estimated Calibration Settings (cont’d)

Objective Estimated Calibration

Note: Make sure the appropriate magnification setting is 
selected for each calibration.

Note: For additional information on creating calibrations 
settings, refer to the MetaXpress Software online help. Press 
the F1 key when the Calibrate Distances dialog is open to 
access its online help. Also refer to the technical note “Spatially 
calibrating images in MetaMorph” available in the Molecular 
Devices support knowledge base at 
www.moleculardevices.com/Support.html.
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Verifying the Laser Autofocus Sensor
This procedure uses a bead plate to test that the laser autofocus (LAF) 
sensor is enabled and functional. Use the following procedure to 
confirm that the Laser Auto Focus is responding in the MetaXpress 
Software application:

1. Power on the system and open the MetaXpress Software 
application if it is not already open.

2. From the Screening menu, select Plate Acquisition Setup.
3. Select the Acquisition Loop tab and ensure that Enable laser-based 

focusing is selected.
4. Click the Plate tab to highlight it.
5. Select the included Costar 96-well Plastic plate type from the 

Plate name field.
6. From the Screening menu, select Plate Acquisition and Control. 
7. The Plate Acquisition and Control dialog appears.
8. Click Eject Plate to move the stage to the load position.
9. Load the bead plate and click Load Plate.
10. Click Go To A1 to move the stage to the A1 position.
11. On the Plate Acquisition Setup dialog, click the Autofocus tab to 

highlight it.
12. Click Configure Laser Settings. 

The Configure Laser Autofocus Settings dialog appears.
13. Click Preview Pass.
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A window opens displaying a graph of focus intensities vs. 
Z-position.

Figure 3-11 Preview Pass graph

14. If the Preview Pass window contains at least one peak, the Laser 
Auto Focus Sensor is enabled and functional. 

15. If the Preview Pass window does not contain any peaks, ensure 
that the plate is properly seated, increase the Exposure value in 
the Configure Laser Autofocus Settings dialog, and try again. 

16. If the Preview Pass window still does not contain a peak, contact 
Technical Support and report the issue. For more information on 
the Preview Pass window, see Confirming Laser Auto Focus 
Settings for Plate Files on page 58.

17. Click Close to exit the Configure Laser Autofocus Settings dialog.
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Verifying the Plate Reference Point (A1 Center)
Complete the following procedure to ensure that the plate reference 
point (A1 center) is properly set:

1. Power on the system and start the MetaXpress Software 
application if it is not already running.

2. From the Screening menu, select Plate Acquisition Setup.
3. Click the Objective and Camera tab to highlight it.
4. Select the lowest power objective from the Magnification 

drop-down list (usually this is a 4x magnification), and then 
enter a binning value of 1 in the Camera Binning field.

5. Select a gain value of 2 in the Gain field.
6. Click the Plate tab to highlight it.
7. Select 96 Wells (8x12) plate type from the Plate name field.
8. Click the Sites to Visit tab to highlight it.
9. Ensure that Site Acquisition Option is set to Single site.
10. Click the Wl (Wavelength) 1 tab to highlight it.
11. Select FITC from the Illumination setting drop-down list and enter 

an exposure time of 100 msec in the Exposure field.

12. From the Screening menu, select Plate Acquisition and Control. 
The Plate Acquisition and Control dialog appears.

13. Ensure that W1 – FITC is selected in the Wavelength field.
14. Enter a step size of 250 in the Step size field.

Note: You need the metal X/Y calibration plate/slide holder that ships 
with the ImageXpress Micro instrument to complete this procedure.

Note: Cubes other than the FITC are acceptable to use however 
the contrast may not be as high as with the FITC. Exposure 
times will vary significantly depending on your light source and 
filter cube choice.
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Figure 3-12 Plate Acquisition and Control dialog

15. Click Eject Plate to move the stage to the load position.
16. Load the metal X/Y calibration plate. Ensure the notch in the 

plate is in the A1 position on the stage.
17. Click Load Plate to load the plate.
18. Click Go To A1 to move the stage to the A1 position.
19. Click Show Live to open a live image window.
20. If you are not using the 4x objective skip, go to Step 23.
21. Use the Z control arrows to step the Z-motor (reducing the step 

size as you get closer to focus if needed) until the A1 pinhole 
comes into focus.
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Figure 3-13 A1 Pinhole in focus at 4X

22. Verify that the hole is visually centered in the field of view. If it 
is not, or if you cannot find the hole, contact Technical Support.

23. If your lowest magnification objective is greater than 4x:
Move the stage up until you are close to focus and left until 
you see the edge of the insert hole. 
Align the left side of the hole with the left side of the image 
window and record the stage X position.
Move the stage to the right until you see the edge of the 
insert hole. 
Align the right side of the hole with the right side of the 
image window and record the stage X position.
Calculate the horizontal center of the reference point.
Repeat Step 23 for the vertical center of the reference point.
Compare this stage position with the position of the stage 
when you click Go To A1.

24. Click F2: Stop to stop the live image.
25. Eject the X/Y calibration plate and continue to the next 

procedure.
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Verifying Plate Types
Complete the following procedure to ensure that the preconfigured 
plate type files included with the MetaXpress Software application are 
available from the Plate Acquisition Setup dialog:

1. Open the MetaXpress Software application if it is not already 
open.

2. From the Screening menu, select Plate Acquisition Setup.
3. Click the Plates tab to highlight it.
4. Select the Plate name drop-down arrow to view the available 

plate type files.

Figure 3-14 Available plate type files

5. If there are a number of custom plate types available, then you 
are finished with this procedure.
OR
If there are no plate types listed except for the three defaults: 
96 Wells (8x12), 384 Wells (16x24), and Custom, continue with 
this procedure to load the preconfigured plate type files.

6. Insert the MetaXpress Software Installation USB flash drive into 
the computer.

7. When the MetaXpress Software installation screen appears, click 
Explore Installation Folders/Files. 
Windows Explorer opens showing the contents of the flash drive.

8. Open the Plates folder. 
This folder contains the preconfigured plate type files (.plt).

9. Copy the plate files that you want available to the Plates 
directory of your MetaXpress Software installation directory (by 
default, C:\MX5\Plates). These files will then appear in the Plate 
name filed in the Plates tab of the Plate Acquisition Setup dialog.

Note: The plate files will be read-only after they are copied off 
the flash drive. You must turn off the Read-only attribute of 
these files before you can use them in the MetaXpress Software 
application.
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10. Using Window Explorer, select all the plate files that you copied 
to the Plates directory (Shift + click to select multiple continuous 
items), right-click the selected files, and select Properties. 
The Properties dialog appears. 

11. Under Attributes, uncheck Read-only, then click OK.

Confirming Laser Auto Focus Settings for Plate Files
Just before each site is acquired during plate acquisition, the laser 
autofocus system automatically moves the vertical (Z-axis) position of 
the objective to a point where the bottom of the well is in focus. Before 
using a plate file, confirm that the laser autofocus settings are optimal 
for the plate. You must prepare the plate that you are going to test by 
putting water or buffer similar to the buffer you will be using for real 
experiments in several of the wells.
Use the Laser Autofocus Wizard, available on the Plate tab, to confirm 
laser autofocus settings. The wizard walks you through the process. 
Additional information is available in the online help, in the topic 
“Configure Laser Autofocus Settings - Dialog Box Options.” 

Verifying Shading Correction Files
Complete the following procedure to ensure that properly named 
shading correction files exist for each objective/filter set combination:

Note: The Laser Autofocus Wizard calculates measurements as 
accurately as possible. Some manual verification and adjustment of 
the settings may be necessary to optimize the results.

Note: If you are using an objective with a correction collar, ensure that 
the correction collar is set appropriately for the plate you are using. 
For information on configuring the correction collar, see Adjusting the 
Spherical-Aberration Correction Collar on ELWD Objectives on 
page 182.

Note: In order for shading correction images to be used during Plate 
Acquisition, the Perform shading correction checkbox must be selected 
in the Acquisition Loop tab of the Plate Acquisition Setup dialog.
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1. Use Windows Explorer to navigate to the C:\Shading Images 
directory or to another location if you have changed the default.

2. Locate the shading correction files. Ensure that they are named 
in the format listed above and that a file exists for each 
objective/filter set combination.

Shading correction files are needed for each objective/filter 
combination and must be generated whenever an objective or filter is 
replaced or added to the system, or whenever the lamp is replaced. For 
information on creating shading correction files, see Updating Shading 
Correction Settings on page 178. 

Note: The shading correction images must be named in the following 
format: shading_<magnification setting>_<wavelength>.tif. For 
example, shading_4x Plan Apo_DAPI.tif.

Note: By default, the MetaXpress Software application looks in the 
C:\Shading Images directory for shading correction images. You can 
change this location by clicking the Directory button on the Acquisition 
Loop tab of the Plate Acquisition Setup dialog and selecting a new 
location.
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4
Preparing For Acquisition
This chapter provides plate acquisition guidelines to consider before 
acquiring experiment plate data. These guidelines help ensure that the 
images you acquire are the best possible quality. Review these 
guidelines before you define your plate acquisition experiment criteria.

Preparing to Acquire Fluorescence Images
When acquiring fluorescence images in a screening environment, follow 
a basic set of rules and guidelines to acquire quality images. As with 
any biological assays, the assay conditions need to be correctly 
evaluated to obtain a meaningful result. Include in your sample 
preparation both negative and positive controls so you can judge the 
validity of your assay. Molecular Devices recommends using a stain 
such as Hoechst or DAPI to stain your cells, since this stain can be used 
for focusing as well as segmentation for your analysis. 
Despite the image enhancement tools and options available to you in 
the MetaXpress® Software application, it is difficult to analyze a poor 
quality image. Starting with quality images helps ensure that your 
image data is more meaningful, and yields more information.
The following are the criteria to consider for attaining the highest 
possible fluorescence image quality:

• Choice of Fluoroprobes: Ensure that you use probes that provide 
good staining and an excitation/emission pattern suitable for the 
filter cubes you have chosen for your ImageXpress Micro 
System.

• Illumination: Check that your light source is functioning 
correctly. The basic design of the ImageXpress Micro System 
light source and light path within the imager help ensure that 
the light reaching your sample is the best possible quality. If you 
find that the light quality has become degraded, contact your 
system administrator or your Molecular Devices representative 
to correct the problem.

• Objective choice: The magnification setting will depend on the 
type of information you are interested in obtaining. In general, 
for counting cells, a 10x objective is suitable. For translocation, 
a 10x or 20x objective is appropriate.

• Wavelength: Select the correct wavelength for your 
fluoroprobes. The Chroma website at www.chroma.com is a 
good resource to help you determine the best filters to use with 
your stain of interest.
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• Exposure: The correct exposure time is crucial for your 
acquisition and analysis. Clicking the Auto Expose button on the 
one of the Wavelength tabs in the Plate Acquisition Setup dialog 
provides you with a good starting point. Adjust the exposure 
time after that so the grayscale intensity within a cell is about 
three times the intensity of the background. In general, that 
means you can reduce your exposure time, which decreases 
your acquisition time.

Evaluating your Experiment Requirements
Nearly all settings for plate acquisition are made in the Plate Acquisition 
Setup dialog. The settings that you choose are dependent on the 
content and distribution of your samples, as well as the requirements of 
your experiment. To help you determine what your settings should be, 
a brief checklist is included in this chapter.
Experiment requirements that you should consider include the 
following:

• What is the nature of your sample material? Is it very dense or 
thin? Dense sample material requires more light and might 
mean that the Z-setting for focus will vary from sample to 
sample. If your sample is very dense, you might need to choose 
the Low Signal algorithm on the Auto Focus tab. If the focal 
plane varies greatly from well to well, you should set up a focus 
configuration to compensate for this.

• Which stains and filter cubes will you use for your samples? Your 
ImageXpress® Micro System uses standard filter cubes to create 
the correct excitation wavelength and the corresponding 
emission wavelength filtration for your experiment. It also uses 
dichroic filtration to separate the excitation wavelength from the 
emission wavelength. Specific filter cubes are designed to be 
used with specific stains. It is important that your filter cubes 
are a correct match for your stains. 

• How many wells are in each plate? For each experiment, you 
must specify the number of wells in the plates that you are 
using. You must use the same type of plate consistently 
throughout the experiment, and you must be sure that the plate 
dimensions are correctly specified. Molecular Devices 
recommends that for any given experiment, you use only one 
brand of plate from a single manufacturer. Mixing various plate 
types from different manufacturers could introduce unknown 
variables and contribute to creating flawed data.

• Which wells need to be imaged? You can acquire images from 
any or all wells in a plate. The Plate tab on the Plate Acquisition 
Setup dialog enables you to choose the specific wells from which 
you want to acquire images. However, you must apply this well 
selection to all plates in the experiment.
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• Will you acquire multiple sites per well? Using multiple sites in a 
single well enables you to acquire images from a greater area of 
the well. If you select the Single Sites option on the Sites to Visit 
tab, an image will be acquired for only a single site located in 
the center of the well. The multiple sites option enables the 
MetaXpress Software application to acquire separate images of 
contiguous areas.
Using the stitch command, you can assemble the smaller 
separate images into a single large image. This capability 
enables you retain or improve image resolution while increasing 
the image area of coverage. Unless you use a journal to change 
settings during the experiment, the sites you select are used 
during the entire experiment. 
Sites can also be used to include specific areas of the wells in 
your experiment data, while at the same time excluding other 
areas of the well.

• Will you use a standard MetaXpress Application Module to 
analyze your data? You need to base your acquisition settings on 
the requirements of the application module used. The most 
important requirements are to prepare your samples correctly 
and to ensure that you use the appropriate filter set for each 
stain that you have applied.

Conditions that Interfere with Obtaining Quality Images
The following conditions or situations can interfere with obtaining the 
highest quality images:

• Optics have been degraded by dust, dirt, fingerprints, or oil 
contamination: If you detect any contamination on your 
objectives, you should inform your system administrator, who 
can take steps to clean the optics and correct the problem.

• Uneven background: The first step to correct an uneven 
background is to check for uneven illumination. If the 
illumination is uneven during fluorescence acquisition, contact 
your system administrator. 

• Uneven illumination: Your ImageXpress Micro System is designed 
to provide high quality, evenly distributed illumination across the 
image field. If you observe that the light across your field is 
uneven, contact your system administrator or Molecular Devices 
representative.

• Poor quality microplates: Not all microplates are the same quality. 
The composition of the material of the bottom of the microplate 
needs to be of optical quality, or the images can be degraded. 
For fluorescence imaging, microplates with black well sides 
usually work the best. Plastic bottom plates are usually more 
uneven and distort light more than glass bottom plates.
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• Incorrect microplates: Some experiments call for black, opaque 
microplates instead of clear ones. To additionally improve 
quality, you can use black opaque covers on your microplates. 
Also, if you are screening multiple plates, be sure that all plates 
are the same type from the same manufacturer. Well spacing 
can vary slightly from one manufacturer to another, and it is not 
possible to continuously change the settings for well spacing.

• For laser autofocus, bottom of plate has dust, dirt, fingerprints, or oil 
contamination: Since the laser measures the reflection from the 
bottom of the plate or from within the sample, interferences 
with reflection caused by dust particles, dirt, fingerprints, and 
scratches will affect the performance of the autofocus. To 
improve the autofocus, it is suggested that you clean the bottom 
of the plate using lens tissue and an optical cleaning solution. 

Additional Guidelines

Magnification
Magnification selection depends on the measurements needed. If you 
are interested in the total number of cells present, a 10x objective 
might be adequate. But if you are interested in co-localization of two 
probes, a higher magnification might be needed. Counting or localizing 
small organelles might require objectives above 40x. 

Exposure Time
The ratio between the Signal (intensity of the interested objects) and 
the Noise (the background and other forms of noise) (S/N) determines 
how hard it will be for the software to discriminate important features 
in an image. If this ratio is relatively small, it is more difficult to 
discriminate between objects and background. One method of 
increasing S/N is to increase the image exposure. Longer exposures 
provide higher signal in an image and, depending upon the sources of 
the noise, might not increase the noise to the same degree.
Conversely, longer exposures can cause photo bleaching damage and 
saturate the camera. Intensity measurements of an overexposed image 
are not accurate and these images should be avoided. One exception to 
this rule is when you are interested in extremely faint features of your 
sample that are otherwise not visible. A good example of this is 
overexposure of a Neurite image where you are not interested in the 
bright cell body but you are interested in the weakly stained 
outgrowths.
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Binning
Another method of increasing the S/N is to bin the pixels from the 
camera. Binning combines the electrons from adjacent pixels to create 
the effect of a single, larger pixel. Binning increases the S/N at the 
expense of decreased resolution. Binning is often used to decrease the 
exposure time dramatically while maintaining the same S/N. Another 
positive feature of binning is that it produces smaller images that 
require less storage space.

Objective Choice
The choice of objective determines the magnification of the image, the 
depth of field of the image, and the brightness of the image. Another 
attribute of the objective is its numerical aperture (NA). With the 
magnification constant, brightness is proportional to NA4. Higher NA 
objectives also produce a sharper picture due to a narrower depth of 
field; this might or might not be an advantage if some of your objects 
are in different Z positions. Unfortunately, higher NA objectives, such 
as a SuperFluor 20x, cannot reach the outer rows and columns of some 
multiwell plates (such as a 384-well plate) because of the of the plate 
skirt height.

Use of Different Fluorochromes
Individual fluorochromes have unique characteristics that help 
determine their best use. Some fluorochromes provide brighter 
intensities and require shorter exposure time, while others do not 
bleach as quickly and enable a longer exposure time. There also might 
be toxicity issues with some cell types or bleed through issues between 
pairs of fluorochromes. These factors should be considered when 
choosing a fluorochrome. 

Shading
Shading is an artifact that can come from the objective, damaged 
optics, misalignment of the light source, or background light from the 
room. Shading should be addressed in the hardware first and if this 
fails, by using the available shading correction within the software.
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Plate Choice
There are numerous types of multiwell plates available from a variety of 
vendors. Molecular Devices recommends determining what plates to 
use for your screening experiments based on the following guidelines:

• Compatibility: Verify that your cells are compatible with the plate 
material. Given the wrong surface, some cells might not bind 
and will act in an unusual manner, such as rounding up, or 
migrating to the edges of the well. If you are using 
immunohistochemistry you might require a much higher 
background staining in plastic as compared to glass.

• Fluorescence background: There is a large difference in auto 
fluorescence between glass and plastic. Also, there can be up to 
a 5X difference in auto fluorescence among plates from different 
manufacturers. If your signal is low, switching plate brands is a 
good troubleshooting tool.

• Plate skirt height: You should use a plate with a small skirt height 
(the height difference between the edge of the plate and the 
bottom surface of the wells) if you are using a high 
magnification or SuperFluor objective. If the skirt height is too 
high, you might not be able to image the outermost parts of a 
plate (the outermost rows and columns on a 384 well plate or 
some sites on the outermost rows and columns on a 96-well 
plate).

• High magnification image clarity: When using high magnifications, 
there are significant differences in clarity between standard 
plastic plates, optically clear plastic plates, and glass bottom 
plates.

• Plate flatness or reproducibility of the Z pattern: A truly flat plate is 
faster to scan than an uneven plate because the search range 
can be made smaller. The reproducibility of a plate allows you to 
set tighter focus ranges specifically for that plate type. This 
reduces the amount of focusing needed and speeds up 
acquisition. The major component in plate flatness is the 
variation from a well to a neighboring well.

• Outside edge of the plate: If you use a plate handling robot, some 
types of plates do not work well with the fingers supplied with 
the robot and will require custom fingers to work correctly. If 
one or more plate types do not work with your robot grippers, 
contact Molecular Devices for assistance.

Correction Collars
If you are using an objective with a correction collar, ensure that the 
correction collar is set appropriately for the plate you are using. For 
information on configuring the correction collar, see Adjusting the 
Spherical-Aberration Correction Collar on ELWD Objectives on 
page 182.
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Setting Up Plate Acquisition
Before configuring an experiment, it is important to become familiar 
with the tools used in the MetaXpress® Software. The foundation of the 
MetaXpress Software is the MetaMorph® Microscopy Automation and 
Image Analysis Software. The MetaMorph Software contains numerous 
dialogs for image acquisition, processing, and analysis. However, the 
majority of the dialogs available are not needed for a typical 
MetaXpress Software plate acquisition. This chapter explains the 
dialogs used to configure a screening experiment.

The MetaXpress Software main menu includes the Screening menu, 
which is used specifically for MetaXpress Software image acquisition 
and analysis. Other menus, such as the Devices menu, provide 
additional dialogs needed to correctly configure the MetaXpress 
Software application.
To help you to become more familiar with the MetaXpress Software 
application and the dialogs that you need to use, the following topics 
include sample images of the dialogs that are essential for acquiring 
plates, and a brief explanation of each one. 

Screening Menu
The Screening menu provides access to all Plate Acquisition-specific 
dialogs. Figure 5-1 shows the options available in the Screening menu.

Figure 5-1 Screening menu

Note: For more information on any dialog, consult the application help 
available within the MetaXpress Software. Help for an active dialog can 
be accessed by pressing the F1 key.
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Plate Acquisition Dialog
The Plate Acquisition dialog is designed to be used after you have 
configured and saved settings using the Plate Acquisition Setup dialog. 
From this dialog, you can choose a settings file, specify an Experiment 
base name, view a summary of your current settings, load specific 
settings from the selected file, and acquire a plate. Figure 5-2 shows 
the Plate Acquisition dialog.

Figure 5-2 Plate Acquisition dialog

Load Plate Acquisition Setting Dialog
After you have selected a settings file, click Load Settings to open the 
Load Plate Acquisition Setting dialog, as shown in Figure 5-3.

Figure 5-3 Load Plate Acquisition Settings dialog

Use the Load Plate Acquisition Settings dialog to load an existing 
settings file and choose the setting groups that you want to apply to 
your experiment. When you load a settings file, you can select one or 
more specific groups of settings to be applied to your experiment by 
selecting the associated checkbox. Settings for checkboxes that are not 
selected are not used. 
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Plate Acquisition and Control Dialog
The Plate Acquisition and Control dialog provides two primary 
functions: Plate Navigation that provides manual control of some of the 
movable physical components of the ImageXpress® Micro imager, and 
Acquisition Control that enables you to prepare and start a plate 
acquisition. In the Plate Navigation group, click the X, Y arrow buttons 
on the left that are organized in a cluster of four to manually move the 
plate from one well to another on the X and Y axes.

Figure 5-4 Plate Acquisition and Control dialog

The Acquisition Control group provides a consolidated organization of 
commands that can also be found in other dialogs. These controls 
enable you to save settings, load previously saved settings, open the 
Plate Acquisition Setup dialog, specify a new experiment base name, 
choose a wavelength, view a live image, snap an image using the 
current wavelength, preview the current selection of wells, and acquire 
an entire plate or all wells selected on the plate.

Note: If sites are enabled, the currently selected site is displayed 
below the arrow buttons along with the selected well. When you move 
from well to well, the selected site will remain the same. To change the 
site selection, use the site selection buttons on the Plate Acquisition 
tool bar, or the Sites to Visit field on the Sites tab of the Plate 
Acquisition Setup dialog.
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Plate Acquisition Setup Dialog
To prepare to use the MetaXpress Software application, you need to 
make the necessary configuration settings in the Plate Acquisition 
Setup dialog. The Plate Acquisition Setup dialog is organized in a 
“top-to-bottom” structure designed to guide you through the process of 
setting up your MetaXpress Software configuration in the correct order. 
The Plate Acquisition Setup dialog has a number of visible tabs that can 
change according to the options that you have selected and the number 
of wavelengths that you are acquiring. Each tabbed area of the dialog is 
dedicated to a specific type of function or setting.

Figure 5-5 Warning Examples in Plate Acquisition Setup dialog

Note: When configuring the Plate Acquisition Setup dialog, you will 
encounter settings highlighted either in yellow or red. A yellow 
highlight can mean that an optional field is not filled in or could 
indicate another minor error. A red highlight means that a required 
field is either not filled in or contains invalid data that should be 
changed. These visual reminders help when configuring an 
experiment. Figure 5-5 shows the dialog with several warnings.
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Using the Experiment Tab
Use the Experiment tab to specify whether you want to create new 
settings or load the settings stored in an existing settings file.

Figure 5-6 Plate Acquisition Setup dialog: Experiment tab
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To load settings on the Experiments tab

The Experiments tab enables you to create a new setting or load a 
previous setting for revision. 

1. From the Screening menu, select Plate Acquisition Setup. 
The Plate Acquisition Setup dialog appears with the Experiment 
tab displayed. 

2. If you are creating new settings, select Create new settings and 
click Next. Proceed to Defining the Names and Description on 
page 73. 

3. If you are using an existing settings file, select Load existing 
setting file. 
The Load Settings button appears.

4. Click Load Settings.
The Load Plate Acquisition Settings dialog appears.

5. If you are loading a settings file that was saved to the database, 
select the settings file from the Settings File field. Select the 
individual settings to load from the file using the checkboxes 
next to each settings group.
OR
If you are loading a settings file that was saved outside the 
database, select From File in the field, and then select the 
individual settings to load from the file using the checkboxes 
next to each settings group.

6. If you are using a settings file from the database, click Load. The 
file loads from the database and the Load Plate Acquisition State 
dialog closes.
OR
If you are loading a settings file saved outside the database, 
click Load. The Load Screen state dialog appears. Navigate to 
the state file (.HTS) you want to open and click Open. The state 
file you selected loads and the Load Screen Acquisition dialog 
closes.

7. Click Summary to view the Summary tab and confirm your 
settings.
OR
Click Next to move to the next tab.

Note: The settings listed here are configured on various tabs of 
the Plate Acquisition Setup dialog.
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Defining the Names and Description
After you have selected your settings file or chosen to create a new 
settings file, you need to designate a name and description for your 
experiment and choose the storage location for your experiment’s data 
using the Names and Description tab. This information is stored with 
the settings file in the database.

Figure 5-7 Plate Acquisition Setup dialog: Names and Description tab
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To add an experiment set name, base name, and 
description

1. Type an experiment set name into the Experiment Set field.

2. Type an experiment base name into the Experiment base name 
field.

3. Select a location where screening images are saved from the 
Storage Location field.

4. Type a description of the experiment into the Description field.
5. Click Next to move to the next tab.

Defining Objective and Camera Magnification 
Settings
For each magnification setting that you have defined, this tab enables 
you to alter camera binning and gain. These settings enable you to 
either improve the image acquisition speed or improve the image 
quality. If sufficient light is available, lower camera binning and lower 
gain values will both increase the image resolution and improve the 
signal-to-noise ratio.

Note: The Experiment Set name can be used to help sort and 
group experiments when you view them using the Review Plate 
Data command.

Note: Image locations are configured in the using the Database 
Utilities command in the Meta Imaging Series Administrator.
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Figure 5-8 Plate Acquisition Setup dialog: Experiment tab

Option Description

Magnification Selects the magnification setting that you want 
to use in your experiment. Magnification 
settings assign X and Y offset values and a Z 
escape distance to a specific objective.

Note: You must assign a calibration to the 
magnification setting using the Calibrate 
Distances dialog accessed from the Measure 
menu. For more information, see the 
application help in the MetaXpress Software by 
pressing F1 while the Calibrate Distances 
dialog is active.
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To change settings on the Objective and Camera tab

1. Select the magnification setting to use from the Magnification 
field at the top of the dialog.

2. Select the amount of binning from the Camera Binning box.
3. Select the amount of gain from the Camera gain field, if 

applicable.

4. Click Next to move to the next tab.

Defining the Plate Dimensions
Use the Plate tab to provide the necessary plate dimensional 
information needed to correctly control the X, Y, and Z movements of 
the ImageXpress Micro System. Correct entry of the plate dimensional 
specifications into the MetaXpress Software application ensures that 
the imager will not make any movements that might create a 
potentially hazardous situation. The dimensional information that you 
enter for the plate also ensures that the laser-based autofocusing is as 
accurate as possible.

Camera binning Specifies the binning value to be applied to the 
camera. Binning combines the output of 
adjacent pixels in square multiples. For 
example, a camera binning value of 1 is only 
one pixel, a binning value of 2 combines 2x2 or 
four pixels in a square, a binning value of 3 
combines 3x3 or nine pixels in a square, and so 
on. This reduces the image file size and 
resolution, but increases signal-to-noise ratio.

Camera gain Specifies the amplification to be applied to the 
camera output.

Figure 5-8 Plate Acquisition Setup dialog: Experiment tab (cont’d)

Option Description

Note: The settings available in the list are created in the 
Configure Magnification dialog in the Devices menu.

Note: For most experiments, use the highest gain possible for 
increased sensitivity.
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Figure 5-9 Plate Acquisition Setup dialog: Plate tab

Option Definition

Plate type Specifies the plate type you are using. Choices 
include generic configurations such as Generic 
96-well, custom configurations, or a previously 
defined configuration. Select the plate size that 
corresponds to your plate, or select Custom to 
specify a non-standard plate configuration. The 
values in the remaining boxes are pre-filled 
according to the plate selected. If your plate is 
not included in the list, you will need to type 
these values. Type the manufacture’s plate 
specification in the setting boxes on this tab. 
There are two values that the manufacturer will 
probably not be able to supply: the optical 
plate thickness (this is not the same as plate 
thickness) and the bottom variation. These two 
values must be measured on the instrument to 
ensure proper focusing. For more information 
on configuring plate types, see Laser Focus 
Troubleshooting Tips on page 127.
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Save Configuration Opens the Save Configuration dialog and 
enables you to name and save a custom 
configuration based on the current values.

Number of columns Contains the number of columns for the 
selected plate type. This value can be changed 
to create a custom configuration if a custom 
plate is selected.

Number of rows Contains the number of rows for the selected 
Plate type. This value can be changed to create 
a custom configuration. This option is available 
only if a custom plate is selected.

Well Shape Selects the shape of the well: either Circle or 
Square.

Note: Each of the following fields has a 
graphic that illustrates the measurement 
defined.

Well diameter Specifies the diameter of the well in microns. 
This value can be changed to create a custom 
configuration if a custom plate type is selected.

Column spacing Specifies the spacing in microns between each 
well on the X axis. Normally this value should 
be the same for both the X and Y axis. 
However, you can specify different values for X 
and Y for plates that use different spacing 
between well on the X and Y axis. This option is 
available only if a custom plate type is selected.

Plate Length Specifies the plate length in microns. This 
option is available only if a custom plate type is 
selected.

Column Offset Specifies the distance in microns between the 
center of a well in the first column of a plate 
and the left edge of the plate. This option is 
available only if a custom plate type is selected.

Row spacing Specifies the spacing in microns between each 
well on the Y axis. Normally this value should 
be the same for both the X and Y axis. 
However, you can specify different values for X 
and Y for plates that use different spacing 
between well on the X and Y axis. This option is 
available only if a custom plate type is selected.

Figure 5-9 Plate Acquisition Setup dialog: Plate tab (cont’d)

Option Definition
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To configure plate settings on the Plate tab

Use the Plate tab to configure and save plate settings for your 
acquisition. The MetaXpress Software application comes with a variety 
of common plate types already configured.
Even if you use an existing plate type file, Molecular Devices 
recommends that you verify the accuracy of the optical bottom 
thickness and the bottom variation on your plates. These parameters 
are critical and can vary from lot to lot. Also, plate manufacturers can 
change plate parameters without changing plate names. For more 
information on configuring these values, see Laser Focus 
Troubleshooting Tips on page 127.
Molecular Devices strongly recommends that you use the Laser 
Autofocus Wizard, available on the Plate tab, to obtain plate bottom 
measurements. Although plate manufacturers generally provide reliable 
plate and well dimensions, you need to calculate the plate bottom 
measurements, such as average thickness and maximum variation in 
thickness of the entire plate. The Laser Autofocus Wizard walks you 
through steps to automatically calculate plate bottom settings as well 
as exposure times for each objective. The MetaXpress Software online 
help topic “Configure Laser Autofocus Settings - Dialog Box Options” 
provides detailed information about the settings that the wizard 
calculates.

Plate Width Specifies the plate width in microns. This option 
is available only if a custom plate type is 
selected.

Row Offset Specifies distance in microns between the 
center of a well on the top row of a plate and 
the top edge of the plate. This option is 
available only if a custom plate type is selected.

Well Depth Specifies the well depth in microns.

Plate Height Specifies the plate height in microns.

Figure 5-9 Plate Acquisition Setup dialog: Plate tab (cont’d)

Option Definition

Note: The Laser Autofocus Wizard calculates measurements as 
accurately as possible. Some manual verification and adjustment of 
the settings may be necessary to optimize the results, particularly for 
thin-bottom plates. Contact Technical Support if you need assistance.
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All plate bottom values are optical thickness (also known as reduced 
thickness) measurements, as measured using the objective. The values 
are not physical thickness measurements.

To configure plates

1. In the Plate name field, select the plate size that corresponds to 
your plate, or select Custom to specify a non-standard plate 
configuration. The values in the remaining boxes are pre-filled 
according to what you select
If you select 96 Wells (8×12) or 384 Wells (16×24), only the 
following options will be available for configuration: Well shape, 
Well depth, Plate height, Optical Thickness, and Bottom 
Variation.
If you select Custom, all options will be available for 
configuration, including Number of columns and Number of 
rows.

2. In the Well shape field, select a square or circular well shape. 
The graphics of the plate are updated to reflect your selection.

Note: You must know the optical thickness and bottom variation for 
your plate. The optical thickness is a value in microns that is the 
average thickness for the well bottom. See the graphic next to the 
Optical Thickness field. The bottom variation is a value in microns that 
is the maximum variation in Z direction between adjacent well 
bottoms. For instructions on determining the optical thickness and 
bottom variation for your plate, see Laser Focus Troubleshooting Tips 
on page 127.

Note: The correct Well depth and Plate height values are needed for 
autofocusing.
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3. Click Laser Autofocus Wizard and follow the steps that the 
wizard provides to calculate plate bottom measurements.
The optical thickness is a value in microns that is the average 
measured thickness for the well bottom using the Laser 
Autofocus. It is proportional but not equal to the physical 
thickness of the bottom plate.
The bottom variation is a value in microns that is the maximum 
variation in Z direction between adjacent well bottoms. 

The MetaXpress Software online help topic “Configure Laser 
Autofocus Settings - Dialog Box Options” provides detailed 
information about the settings that the wizard calculates.

4. If required, in the Well depth and Plate height fields, change the 
values.
Correct Well depth and Plate height values are required for 
autofocusing. 

5. If you selected Custom, complete the fields as required.
6. After you have configured the plate settings, click Save 

Configuration to type a name for your setting and save the plate 
configuration. Configurations that have been saved are then 
available in the Plate name list.

7. Click Next to move to the next tab.

Note: The Laser Autofocus Wizard calculates measurements as 
accurately as possible. Some manual verification and 
adjustment of the settings may be necessary to optimize the 
results.

Note: Adjust any objectives with correction collars to match the 
plate type.
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Specifying the Wells to Visit
The Wells to Visit tab enables you to configure which wells to acquire on 
your plate. This dialog tab displays a graphical representation of the 
type of plate that you are using, based on the settings that you made 
on the Plate tab.

Figure 5-10 Plate Acquisition Setup dialog: Wells to Visit tab

Select the wells to sample during the experiment. You can select from a 
single well up to all the wells in the plate. Click individual well positions 
to toggle wells off and on separately. Right-click a well to move the 
stage to that well. 
Click the column or row buttons to activate or deactivate an entire row. 
Click the All button in the upper-left corner to toggle all wells on the 
plate simultaneously.
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To configure the Wells to Visit tab

The Wells to Visit tab enables you to configure which wells to acquire on 
your plate. 

1. In the Wells To Visit box, click to select the wells that you want to 
visit:

Click individual wells to select or deselect each well.
Click lettered buttons to select or deselect an entire row.
Click numbered buttons to select or deselect an entire 
column.
Click All in the upper-left corner to select or deselect all wells 
on the plate.
Right-click a well to move the stage to the well.

2. Click Next to move to the next tab.

Specifying the Sites to Visit in a Well
Use this optional setting to specify acquisition of more than one location 
in a well. You can configure the vertical and horizontal spacing between 
sites in an image. Both positive and negative values can be entered. 
This enables you either to add a barrier between images (using positive 
values) or to overlap images using negative values.
The number of sites that you can acquire in a well depends on the size 
of the well, the objective magnification, the distribution of sample 
material in the well, the type of plate, and the fluid content of the well. 
Other factors to consider when configuring multiple sites include the 
distribution of the material that you want to acquire, and the amount of 
spacing that you want to have between each acquisition location. All of 
these factors have the ability to influence the image quality.

The focus for individual sites is set on the Autofocus tab. See Defining 
Autofocus Settings on page 96.
The Adaptive Acquisition™ option is a computational algorithm to 
analyze cell number on the fly during sample acquisition, which 
increases the chances of collecting valid data in every well. The 
Adaptive Acquisition option can also significantly reduce acquisition 
time for multi-wavelength acquisition requiring a minimum number of 
cells per well or for samples with differing conditions across the plate. If 
this option is selected, a new tab, Cell Counting, will appear as 
described below. In addition, you will specify a minimum number of 
sites to be collected.

Note: If single site is specified, one site per well is collected at the 
center of each well.
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Figure 5-11 Plate Acquisition Setup dialog: Sites to Visit Tab.

To configure the Sites to Visit tab

1. Specify the number of columns and rows (for example, 2 
columns and 2 rows to acquire up to four sites; 3 columns and 3 
rows to acquire up to nine sites, and so on).

2. To specify a percentage of the width (X) and height (Y) of the 
camera's field of view to acquire, select the Custom Field of 
View check box. 

Note: The maximum number of columns and rows that can be 
configured is 45 × 35.
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The camera's full field of view is 100 percent (100% in the X 
field and 100% in the Y field). So, for example, if the full field of 
view width is 1000, to acquire a width of 500, you would enter 
50 in the X field.
This feature is particularly useful if the image acquired using the 
full field of view is not evenly illuminated or if the image 
acquired includes the area outside the well boundary. By 
reducing the field of view, you can acquire an image of only the 
properly illuminated area or of only the area within the well.

A custom field of view can be used for a single site or for 
multiple sites. 

3. Click Tile Sites to configure the sites with zero spacing between 
them (adjacent). 

4. Click Fit Sites to Well to maximize the spacing between the sites 
within the well.

5. In the graphical display, left-click individual sites to turn off any 
sites that you do not want to acquire, or to turn on any sites 
that are turned off. You can also click and drag to select or 
deselect a rectangular block of sites. Right-click a site to move 
the stage to that site. 
Figure 5-12 shows the configuration of the Sites to Visit tab to 
acquire images at the edges of a round well configured with a 
4x4 arrangement of sites. 
Figure 5-13 shows the configuration of the Sites to Visit tab to 
acquire images at the edges of a square well with a 4x4 
arrangement of sites.

Note: The custom field of view feature can be used with shading 
correction, but shading correction images must have been 
acquired with the full field of view.
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Figure 5-12 Sites to Visit tab showing the acquisition of images at the 
edges of a round well with a 4x4 arrangement of sites
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Figure 5-13 Sites to Visit tab showing the acquisition of images at the 
edges of a square well with a 4x4 arrangement of sites

6. To include a distance between adjacent sites, type the X and Y 
values of the spacing in the Spacing between images (µm) field.
Typing a negative value results in overlapping data between 
adjacent images. You can view the current image size, well size, 
and image spread values on the tab. These values update to 
reflect changes in configuration.

7. Click Next to move to the next tab.

Using the Cell Counting Tab
When in the Adaptive Acquisition mode (set in the Sites to Visit tab), 
the Cell Counting tab appears. In this tab, first select the channel that 
will be used for cell counting. Next, enter approximate values for the 
width and intensity of your nuclei, and then use the Test Settings option 
to optimize your settings on a representative site (see Figure 5-15). 
Note that you should be in an appropriate location on your sample, and 
in focus on the sample. Test Settings will snap an image (see 
Figure 5-16), and count the cells using the current settings, displaying 
both an analysis overlay and the total number of cells counted in the 
image.
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Figure 5-14 Sites to Visit tab with the Adaptive Acquisition mode set

Note: In this mode, the instrument collects a minimum number of 
sites based on the Minimum to visit setting, and a maximum number of 
sites based on the configuration in the Sites to visit tab.
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Figure 5-15 Cell counting tab in the Plate Acquisition Setup dialog

Figure 5-16 Results from Cell counting test settings in the Adaptive 
Acquisition mode
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If you are running in the Adaptive Acquisition mode, a real-time count 
of the cells in the current well will be displayed as the images are being 
acquired. 

Figure 5-17  Plate Acquisition Status dialog in the Adaptive Acquisition 
mode

Setting Timelapse Options
The Timelapse tab enables you to set the loop order to use when 
acquiring images at multiple time points. It also enables you to set the 
number of time points to acquire and the total time needed for all time 
points. 
If you are not using multiple time points in your acquisition, set the 
Number of timepoints value to 1 and click Next to move to the next tab.
The values in the Number of Timepoints, Interval, and Duration fields 
have the following relationship:

Number of Timepoints x Interval = Duration
Changing any of the values will automatically update the others as 
needed.
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Figure 5-18 Plate Acquisition Setup dialog: Timelapse tab

Option Description

Number of timepoints Specifies the total number of time points to be 
acquired. When you change this field, the 
duration field is automatically updated by 
calculating the duration from the number of 
time points and the time interval.

Perform time series for Selects the loop order to be used when 
acquiring images at multiple time points and 
determines the set of images to be acquired at 
each time point.
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To configure the Timelapse tab

1. Select the number of time points to acquire in the Number of 
Timepoints field. Note that changing this value updates the 
Duration field as needed. 

2. Select a loop order to use when acquiring images at multiple 
time points from the Perform time series for field. The following 
options are available:

One site, then next: Acquires all the images at the site and 
then collects the next set of wavelength images after the 
interval has elapsed. After the series is collected, the next 
site is acquired. No refocusing is done after the first 
timepoint. This option is useful to collect large amounts of 
data from a well when image alignment is vital: for example, 
when performing cell mobility analysis.
One well, then next: A set of wavelength images is acquired at 
each site in the well at each time point. No refocusing is 
done. This option is most common for rapid acquisition from 
a well if multiple sites are selected. All sites are acquired per 
timepoint.

Interval Specifies the amount of time between the start 
of acquisition at one time point to the start of 
acquisition at the next time point. If the time 
interval is shorter than the length of time 
required to actually acquire the images, the 
next acquisition will occur as soon as possible 
after the first acquisition is complete. No 
warning notice will be given if the acquisition 
time is longer than the specified interval. Select 
a time unit of ms, sec, min, or hr. Changing the 
interval field updates the duration field by 
calculating the duration from the number of 
time points and the time interval. The interval 
field can be set to 0 to acquire images as fast 
as possible. If the interval is set to 0, the 
duration will be set according to the 
approximate minimum time, and the duration 
field will be inactive.

Duration Specifies the time it will take to acquire the 
number of time points based on the interval. 
Changing this field updates the number of time 
points field by calculating the number of time 
points from the time interval and the duration. 
Select a time unit of ms, sec, min, or hr.

Figure 5-18 Plate Acquisition Setup dialog: Timelapse tab (cont’d)

Option Description
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One row, then next: All the images in one row’s worth of wells 
are collect at each time point. After the series is collected the 
next row is acquired. No refocusing done. This option 
requires a longer time interval because all the wells in a row 
are acquired.
One column, then next: All the images in one column’s worth 
of wells are collected at each time point. After the series is 
collected, the next column is acquired. No refocusing done 
after the first timepoint. 
All selected wells: Every well selected for acquisition is 
acquired at each time point. The well selection is determined 
at the start of the first acquisition. No refocusing is done 
after the first timepoint.

3. Set the amount of time between the start of acquisition at one 
time point to the start of acquisition at the next time point in the 
Interval fields. Select a time unit of ms, sec, min, or hr.

4. If needed, change the amount of time for the entire time series 
in the Duration field. Note that the Duration field value is the 
result of multiplying the number of time points by the interval.

5. Click Next to move to the next tab.

Defining Acquisition Loop Options
The Acquisition Loop tab configures options used to control the events 
of a single acquisition loop. Use this tab to configure the following 
settings:

Number of wavelengths to acquire
Autofocus options
Activation of shading correction during acquisition
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Figure 5-19 Plate Acquisition Setup dialog: Acquisition Loop tab

Option Description

Number of wavelengths The total number of wavelengths that you have 
configured for use during your experiment. Set 
from one to eight wavelengths in this box.

Autofocus options:

• Enable laser-based 
focusing

Selects laser-based focusing for the acquisition. 
Configure laser autofocusing in the Autofocus 
tab.

• Enable image-based 
focusing

Selects image-based focusing for the 
acquisition. Configure image-based focusing in 
the Autofocus tab.

Perform shading correction Enables shading correction for the acquisition. 
If a correction image exists for a wavelength, 
correction is performed. Correction images 
must be named in the following format: 
shading_<magnificationsetting>_<wavelength>
.tif
For example: shading_10x_DAPI.tif.
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To configure the Acquisition Loop tab

1. Select the total number of wavelengths to use during acquisition 
in the Number of wavelengths field.

2. In the Autofocus options field, select one or both of the autofocus 
options.

Directory Opens the Browse dialog. Use this command to 
change the location where the MetaXpress 
Software looks for shading correction images. 
The default location is the 
C:\Shading Images directory.

Figure 5-19 Plate Acquisition Setup dialog: Acquisition Loop tab (cont’d)

Option Description

Note: You must enable at least one wavelength in this field.

Note: Laser-based focusing finds the bottom of the well and 
moves a specified distance up from the bottom. This method is 
generally the fastest and will not cause photo damage to your 
specimen. This method does not work well if the distance above 
the bottom of the well changes in your sample.

Note: Image-based focusing uses a specified algorithm to 
identify the best focus image. This method works best for 
experiments using low power objectives and when the sample 
distance above the bottom of the plate varies. This method can 
be slower than laser-based and can fail if there is out-of-focus 
debris present.

Note: Selecting both Laser-based and Image-based focusing 
uses the laser to get to a specified position above the bottom of 
the well and image-based focusing to fine tune. This method 
works best when there is some variation in the distance above 
the plate bottom. It is especially useful at very high 
magnifications.
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3. Select Perform shading correction to enable shading correction.

4. To change the location where the software looks for shading 
correction images, click Directory and select a new location using 
the Browse dialog. The default location is the 
C:\Shading Images directory.

5. Click Next to move to the next tab.

Defining Autofocus Settings
Autofocus settings are made on a combination of three different tabs in 
the Plate Acquisition Setup dialog and in additional dialogs within the 
MetaXpress Software application. Certain autofocus settings need to be 
made in advance by your system administrator to simplify the daily 
autofocus procedures needed when setting up an experiment. 
Within Laser Autofocus, you can choose to focus on one surface (the 
bottom of the plate) or two surfaces (the bottom of the plate and the 
bottom of the well). You can also choose to use offset values based on 
the laser autofocus position for a particular well to achieve proper focus 
on your samples in the remaining wells. Offset values can also be used 
to achieve focus for different wavelengths without using the laser to 
recalculate the focus distance.
The following tabs and dialogs are used to complete the process of 
configuring autofocus:

• Plate Acquisition Setup dialog
Acquisition Loop tab
Autofocus tab
Wavelength tabs

• Configure Laser Autofocus Settings dialog
• Focus dialog (optional)

Focus tab (optional)
Autofocus tab (optional)

• Configure Laser Autofocus dialog (optional)
The Autofocus tab enables you to configure autofocus options for your 
acquisition. The choices available on this tab vary depending on what 
you select in the Autofocus Options area of the Acquisition Loop tab.

Note: In order for shading correction to be applied during 
acquisition, correction images must exist for each wavelength 
used. The correction images must be named in the following 
format: shading_<magnificationsetting>_<wavelength>.tif. 
For example: shading_10x_DAPI.tif.
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Figure 5-20 Plate Acquisition Setup dialog: Autofocus tab

Option Description

Laser-based Focusing 
options:

• Configure Laser Settings Opens the Configure Laser Autofocus Settings 
dialog. These settings are calculated using the 
Laser Autofocus Wizard. The MetaXpress 
application help topic “Configure Laser 
Autofocus Settings - Dialog Box Options” 
provides detailed information about the 
settings that the wizard calculates.

• Well to well autofocus:

Focus on well 
bottom

This is the recommended option for most 
situations. The initial focus on the plate (Find 
Sample) will focus on both the plate bottom 
and well bottom. As the system moves from 
well to well, it will focus on the well bottom 
only, using the bottom variation from the Plate 
configuration as the focus range.
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Focus on plate 
bottom only, 
then offset by 
bottom 
thickness

Offsets the laser by the bottom thickness of the 
plate, as defined in the Plate tab. Select this 
option if you are using a thin-bottom plate with 
an objective with a large depth of field (low 
magnification or low numerical aperture), if you 
are using a glass slide, or if you are using an 
oil-immersion objective.

Focus on plate 
and well 
bottom

The laser will focus on both the plate bottom 
and well bottom at every well. This is 
recommended for plates with significant 
variation in their optical thickness.

Image-based Focusing 
options:

• Algorithm: Enables you to select the algorithm to use 
when focusing. Valid choices include Standard 
and Low Signal

Standard (default) Algorithm is based on a standard group of 
settings including a normal camera signal level.

Low Signal Algorithm is based on a set of values selected 
to compensate of a low signal level from the 
camera. This setting can compensate for 
situations in which some pixel intensities are 
somewhat brighter when slightly out of focus.

• Camera Settings:

Binning Sets the binning used by the camera during the 
Auto Focus and Show Live commands. 
Horizontal and vertical binning are always set 
the same and should be set to less than four.

Allow custom 
exposure times

Enables setting custom exposure times for 
individual wavelengths during autofocus. If this 
is not selected, the exposure time is calculated 
based on autofocus binning and acquisition 
exposure time.

Initial well for finding 
sample:

Select the well to use when performing the 
initial find sample autofocus.

• First well acquired Finds sample autofocus using the first well.

• Specific well Finds sample autofocus using the well that you 
specify

Figure 5-20 Plate Acquisition Setup dialog: Autofocus tab (cont’d)

Option Description
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• Skip Find Sample 
(select if sample is 
already in focus)

Disables initial find sample autofocus when 
starting a plate. Select this option if your 
sample is already in focus.

Site Autofocus options: Determines how autofocusing is done for each 
wavelength when sites are configured. The 
options include First site only, Center of well, 
and All sites.

• First site only Autofocuses in the top-left site in the well.

• Center of well Autofocuses in the center of the well. This is 
the recommended method.

• All sites Autofocuses for each site.

Note: This option is available only if you have 
already configured the use of multiple sites in 
the Sites tab and enabled image-based 
focusing in the Acquisition Loop tab.

Timelapse Autofocus 
options:

Determines how autofocusing is performed 
when multiple timepoints are selected. The 
options include First timepoint only

• First timepoint only Recommended for fast kinetic acquisitions.

• All timepoints Recommended for long timelapse acquisitions.

• Every Nth timepoint This option is available only when more than 
one timepoint is configured in the Timelapse 
tab.

View Focusing Details 
button

Opens a window with detailed focus 
parameters, useful for diagnostic purposes 
when troubleshooting focusing issues. You can 
click the Copy button to copy the parameters 
as necessary, for example when sending them 
to Technical Support.

Figure 5-20 Plate Acquisition Setup dialog: Autofocus tab (cont’d)

Option Description
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Figure 5-21  Autofocus details

Configuring Laser Autofocus Settings
Use the Configure Laser Autofocus Settings dialog in conjunction with 
the Laser Autofocus Wizard and the Plate Acquisition Setup Autofocus 
tab to configure the settings for the MetaXpress Software laser focus 
system. 

To configure the Autofocus tab (Laser Autofocus only)

1. From the Screening menu, click Plate Acquisition Setup. 
The Plate Acquisition Setup dialog appears.

2. Click the Acquisition Loop tab.
3. On the Acquisition Loop tab, verify that Enable laser-based 

focusing is selected.
4. Click the Autofocus tab.
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5. In the Well to well autofocus field, select:
Focus on plate bottom only, then offset by bottom thickness if 
you plan to focus only on the bottom of the plate and then 
use the bottom thickness value to focus on your sample. 
Focus on plate and well bottom if you are using thin-bottom 
plates. With this option, the autofocus always searches for 
both peaks in every well. This option is recommended if the 
plate bottom variation is at least half the thickness of the 
plate bottom. 
Focus on well bottom if you plan to focus only on the 
bottom of the well.

6. In the Site Autofocus field, if sites are enabled on the Sites tab, 
select the site pattern that you want to use. Select from First Site 
only, Center of well only, or All Sites:

First site only: autofocuses in the top left site in the well.
Center of well: autofocuses in the center of the well. This is 
the recommended method.
All sites: autofocuses for each site.

7. On the Autofocus tab, click Configure Laser Settings to confirm the 
settings that will be used for autofocusing, including exposure 
times. If you need to change the exposure values, on the Plate 
tab, click Laser Autofocus Wizard and follow the steps that 
the wizard provides for measuring exposure times. 

The MetaXpress online help topic “Configure Laser Autofocus 
Settings - Dialog Box Options” provides detailed information 
about the settings that the wizard calculates.

8. On the Autofocus tab, click View Focusing Details if you need to 
view all the settings values that will be applied to your autofocus 
procedures. 

9. Click Next to move to the next tab.

Note: The Laser Autofocus Wizard calculates measurements as 
accurately as possible. Some manual verification and 
adjustment of the settings may be necessary to optimize the 
results.
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To configure the Autofocus tab (Image-based Focus only)

Complete the following procedure if you selected Enable image-based 
focusing on the Acquisition Loop tab:

1. From the Algorithm field, select from one of the following two 
image-based autofocus algorithms:

Standard (default): Algorithm based on a standard group of 
settings including a normal camera signal level.
Low Signal: Algorithm based on a set of values selected to 
compensate for a low signal level from the camera. This 
setting can compensate for situations in which some pixel 
intensities are somewhat brighter when slightly out of focus.

2. In the Binning box, select the binning value that the camera will 
use during image-based autofocus.

3. If you do not want to use a calculated exposure time for each 
wavelength during autofocus, select Allow custom exposure time. 
This will enable you to set an exposure time for each wavelength 
on the Wavelength tabs.

4. To disable the initial find sample autofocus routine when starting 
a plate, click Skip Find Sample.

5. If Find Sample is enabled, select the first well to be used when 
performing the initial find sample autofocus by setting the Initial 
Well for Finding Samples fields. A1 is the default and should not 
need to be changed if you are acquiring the entire plate.

Note: Molecular Devices recommends using Low Signal 
whenever you are using a 20x Apo lens.

Note: Molecular Devices recommends that your binning value is 
set to 3 or less.

Note: Choose this option if your sample is already in focus.
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6. If you enabled Visit multiple sites per well in the Wells to Visit tab, 
select the site autofocus setting in the Site Autofocus field. The 
following choices are available:

First site only: Autofocuses in the top-left site in the well.
Center of well: Autofocuses in the center of the well. This is 
the recommended method. This occurs even if the center of 
the well location is not configured to be acquired.
All sites: Autofocuses at each site.

7. Click Next to move to the next tab.

Defining Wavelength Settings
Use the Wavelength tabs to configure exposure, autofocus, and 
timelapse settings for each wavelength. The total number of 
wavelength tabs depends on the number of wavelengths selected in the 
Acquisition Loop tab. 

Note: This option is available only if you have already configured 
the use of multiple sites in the Sites tab.

Note: There is one tab for each wavelength. The number of 
wavelengths is configured in the Acquisition Loop tab.
5015321 B 103 



Setting Up Plate Acquisition
Figure 5-22 Plate Acquisition Setup dialog: Wavelength tab

Option Description

Exposure options:

• Illumination setting Selects an illumination setting to be used with 
the active wavelength. Illumination settings are 
defined in the Configure Illumination dialog.

• Exposure Specifies the exposure time in milliseconds to 
be associated with the active wavelength. Type 
a value in this box or click Auto Expose to 
automatically determine an exposure time.

• AutoExpose Automatically determines the exposure time for 
the currently loaded sample, and applies it as 
the exposure value. Auto Expose works best 
when used with wells that have the most 
intense signal (for example, a positive control). 
You should set the Target maximum intensity to 
75% of the maximum intensity of the camera.
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• Target maximum 
intensity

Sets the intensity that auto exposure should 
attempt to attain for the brightest pixel in the 
image. The target intensity value default is 
75% of the maximum gray level that the 
camera driver reports as possible to obtain.

Autofocus options: Selects the type of autofocus to be used when 
acquiring images. The options available here 
depend on how the autofocus tab was 
configured.

• None No autofocusing is done. This selection enables 
no other options.

• Laser with Z-offset Uses the laser autofocus based on the settings 
calculated by the Laser Autofocus Wizard (or as 
configured in the Configure Laser Settings 
dialog). Specify an offset to use for the first 
wavelength in the Offset field. The next section 
provides instructions on using the Calculate 
Offset feature. No image-based focusing will be 
performed on this wavelength. This option is 
only available if you selected Enable laser-
based focusing in the Acquisition Loop tab.

• Z-offset from W1 This option moves the specified offset from the 
W1 focus position and is available only for the 
second and subsequent wavelengths. Enter the 
Z-offset value (in µm) in the Offset field. The 
next section provides instructions on using the 
Calculate Offset feature. This option is available 
only if Enable laser-based focusing is selected 
in the Acquisition Loop tab.

• Image-based This option is available for the second and 
subsequent wavelengths if you have selected 
Enable image-based focusing or both Enable 
laser-based focusing and Enable image-based 
focusing in the Acquisition Loop tab). Image-
based focusing is best for complex samples 
with variations in distance between the surface 
of the plate and the sample. It is also useful for 
experiments using magnification settings of 
less than 10X.

Figure 5-22 Plate Acquisition Setup dialog: Wavelength tab (cont’d)

Option Description
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• Laser and image Uses both laser- and image-based autofocusing 
as configured in the Autofocus tab. This option 
is only available for the first wavelength if you 
selected both Enable laser-based focusing and 
Enable image-based focusing in the Acquisition 
Loop tab. With this option, the laser 
autofocuses, then image-based focusing is 
used to fine-tune the image.

• Laser with image 
recovery

Attempts to perform a laser with z-offset focus 
(described above). Only uses image-based 
focusing if laser-based autofocusing cannot find 
the plate or well bottom. The image-based 
recovery search is centered on an estimated 
well bottom offset position. The estimated 
position is calculated by using the plate bottom 
position found during laser autofocus and then 
adding to that the plate bottom thickness and 
post laser offset values. This option is only 
available if both Enable laser-based focusing 
and Enable image-based focusing are selected 
in the Acquisition Loop tab and you have 
selected Allow image-based focusing for recovery 
from laser-based well bottom failures on the 
Autofocus tab.

• Offset (µm) Z motor offset distance for each wavelength 
defined on the Plate Acquisition Setup tab. For 
the first wavelength, if you are using laser-
based focusing, the offset is the distance 
between the bottom of the well and the in-
focus plane (if you are using just image-based 
focusing, no offset is needed for the first 
wavelength). For the second and subsequent 
wavelengths, with laser- or image-based 
focusing, the offset is the difference between 
the focus position of the Z motor using the first 
wavelength and the focus position of the Z 
motor using the second or subsequent 
wavelength. The next section provides 
instructions on using the Calculate Offset 
feature.

• Range Specifies the total focus range that the focus 
operation is permitted to move. This is a plus or 
minus value from the current or previous focus 
position. For example, if the range is +/- 500, 
the Z motor can move a maximum of 500 
microns in either direction from the current or 
previous focus position.

Figure 5-22 Plate Acquisition Setup dialog: Wavelength tab (cont’d)

Option Description
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• Image-based range Specifies the range to use for the image-based 
portions of autofocusing. Laser autofocusing is 
performed to an accuracy equal to this range 
before image-based autofocusing begins. This 
option is available only if both Enable laser-
based focusing and Enable image-based 
focusing is selected in the Acquisition Loop tab.

• Max step (µm) Specifies the maximum step size in microns of 
a single Z move to be used in attaining the 
correct focus position. This setting is dependent 
on the objective used. Use a smaller step size 
with higher NA objectives because the focus 
peak is narrower.

Note: Smaller step sizes typically require 
more steps to arrive at the final focus 
position.

• Exposure (ms) Specifies the exposure time in milliseconds to 
be used when autofocusing.

• Gain Sets the sensitivity of the camera when used 
with the Autofocus command.

Timelapse acquisition 
options:

Specifies the image collection intervals to use 
for each wavelength.

• All time points Acquires an image for each timepoint for this 
wavelength.

• At start Acquires an image at this wavelength for the 
first timepoint only.

• At start and end Acquires images at this wavelength for the first 
and last timepoints only.

• Every nth timepoint Acquires an image at this wavelength at the 
selected timepoint interval beginning at the 
first timepoint.

Image Shading Correction Displays the current status of shading 
correction. This text is only visible if shading 
correction is enabled on the Acquisition Loop 
tab.

Figure 5-22 Plate Acquisition Setup dialog: Wavelength tab (cont’d)

Option Description
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To configure the Wavelength tabs

1. In the Illumination box, select the illumination setting for this 
wavelength. 
The illumination settings are defined in the Configure 
Illumination dialog.

2. In the Exposure box, type or select an exposure time in 
milliseconds or, if you have an appropriate sample in view, click 
Auto Expose to set this value automatically.

3. Enter a value in the Target Intensity field or use the default 
value. 
This value sets the intensity that the auto exposure should 
attempt to attain for the brightest pixel in the image. When Auto 
Expose is selected, the target intensity value default is 75% of 
the maximum gray level that the camera driver reports as 
possible to obtain.

4. Select the type of autofocusing to perform for the wavelength in 
the Autofocus options section (see Figure 5-22 for descriptions of 
the types of autofocusing available).

5. Optionally, in the Autofocus options section, in the Offset field, 
adjust the Z offset used during autofocusing. To use the 
Calculate Offset feature, which automatically determines the 
appropriate Z motor offset distance for each wavelength as 
defined on the Plate Acquisition Setup tab, follow Steps 6-10. 
For the first wavelength tab, the offset is the distance between 
the bottom of the well and the in-focus plane. For the second 
and subsequent wavelength tabs, the offset is the difference 

Note: The options available in the Wavelength tabs vary 
depending on the selection made in the Acquisition Loop and 
Autofocus tabs.

Note: Laser-based autofocusing is recommended under most 
circumstances. It is faster than image-based, less sensitive to 
the sample, and does not cause photo bleaching damage to the 
sample.

Note: The number of options available in the field vary 
depending on selections made in the Acquisition Loop and 
Autofocus tabs.
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between the focus position of the Z motor using the first 
wavelength and the focus position of the Z motor using the 
second or subsequent wavelength. As a simple example, 
suppose the position of the Z motor when the sample is in focus 
using Wavelength 1 is 500 and the position of the Z motor when 
the sample is in focus using Wavelength 2 is 700. The difference 
between the two positions is 200, so the offset for Wavelength 2 
is 200. 
Before using the Calculate Offset feature:

Configure the plate parameters using all of the tabs above 
the Acquisition Loop tab.
If you are using laser-based focusing, configure all laser 
autofocus parameters using either the Laser Autofocus 
Wizard (available from the Plate tab) or the Configure Laser 
Autofocus Settings dialog (available from the Autofocus tab). 
The MetaXpress online help topic “Configure Laser Autofocus 
Settings - Dialog Box Options” provides detailed information 
about the settings that the wizard calculates.
On the Autofocus tab, in the Image-based Focusing section, 
select the algorithm and set the binning. These fields are 
available even if you selected only Laser-Based Focusing on 
the Acquisition Loop tab because part of the Calculate Offset 
feature uses image-based focusing to determine the offset. 
Custom exposure times are not used.
Ensure that the signal/noise is set so that the system can 
focus appropriately (adjust the exposure time if necessary to 
correct a dim or saturated signal). 

The default range and step size that will be used to calculate the 
offset is based on the numerical aperture of the objective in the 
selected setting. For example:

6. If you are using laser-based focusing, either with or without 
image-based focusing, to automatically calculate the Z offset 
using the default range and step size for the first wavelength, 
click Calculate Offset.
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The software focuses on the sample, snaps an image, and 
displays a message indicating the calculated offset value. For 
example:

The offset may be a negative value.
7. Click Yes to replace the current offset value with the newly 

calculated value.
The Post-laser offset field displays the newly calculated value. 
For example:

8. To use a custom range and step size rather than the default 
values, select the Custom Range check box, type a new range 
and step size, and click Calculate Offset again.

Note: If you are using only image-based focusing, you cannot 
set an offset for the first wavelength.
110 5015321 B 



ImageXpress Micro Widefield High Content Screening System User Guide
9. To have the software acquire a Z stack from which you can 
select the most in-focus image that will be used to calculate the 
offset:

Select the Use Z Stack check box and click Calculate 
Offset.

The MetaXpress software acquires a Z stack of images and 
displays the following message:

Use the slider at the top of the Z stack image window to 
navigate to the most in-focus image. For example:

Note: If, in the Autofocus options section, you selected either 
“Laser and Image” or “Laser with Image Recovery,” the offset is 
calculated using the range (total distance) and step size 
displayed in the Calculate Offset section. The offset is not 
calculated using the Image-based range and Max step displayed 
in the Autofocus section (next to the Post-laser offset value).

Note: To acquire fewer or more than the default number of 
planes (25), select the Custom Range check box and type new 
values for the range and step size of the Z stack (the number of 
planes that will be acquired is equal to approximately the range 
divided by the step size). You can acquire as many planes as 
needed.
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With the most in-focus image displayed, click OK.
The software calculates the offset and a message appears, 
indicating the newly calculated offset value. For example:

To replace the current offset value with the newly calculated 
value, click Yes.
Optionally, to save the Z stack, click File > Save As.

Tip! The Test Settings button focuses on the sample and snaps 
an image using the current settings for the selected wavelength.
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10. On the second and subsequent wavelength tabs, repeat Steps 6-
9.

11. If you enabled multiple timepoints in the Timelapse tab, select 
from the Timelapse Acquisition field to set the image collection 
intervals to use for each wavelength. The following choices are 
available:

All time points: Acquires an image for each timepoint for this 
wavelength.
At start: Acquires an image at this wavelength for the first 
timepoint only.
At start and end: Acquires images at this wavelength for the 
first and last timepoints only.
Every nth timepoint: Acquires an image at this wavelength at 
the selected timepoint interval beginning at the first 
timepoint.

12. Click Next to move to the next tab.
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Scheduling Journals
Use the Journals tab to configure specific journals to run during 
different stages of acquisition. For more detailed descriptions of each 
Acquisition step, refer to the help page for the Journals tab in the Plate 
Acquisition Setup dialog.

Figure 5-23 Plate Acquisition Setup dialog: Journals tab

Option Description

Acquisition step: Specifies that a journal should be run for the 
selected step. Only one journal can be assigned 
to each step. Select the checkbox next to the 
step that you want to use, and then click File 
Open to assign the journal to the step. After 
you have assigned a journal to a step, you can 
temporarily deactivate the running of the 
journal by clearing the checkbox for the step. 
To reactive a pre-assigned journal, select the 
checkbox.

• Before each Image Runs only during the acquisition loop, after the 
illumination is set and focusing is done. 
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• After each image Runs only during the acquisition loop, after the 
shutter is closed and before images are saved.

• Before focusing Runs only during the acquisition loop, just 
before focus evaluation begins.

• Start of site Runs only during the acquisition loop, before 
any images are acquired from each site.

• End of site Runs only during the acquisition loop, after all 
images have been acquired from each site.

• Start of well Runs only during the acquisition loop, at the 
beginning of each well, before any images are 
acquired from a well.

• End of well Runs only during the acquisition loop, at the 
end of each well, after all images have been 
acquired from a well.

• Start of plate Runs after the stage is moved to the find 
sample position, but before the find sample 
action is performed.

• End of plate Runs after the last acquisition for a plate is 
complete.

• Start of time point Runs only during the acquisition loop, at the 
beginning of each time point, before any 
images are acquired for a time point.

• End of time point Runs only during the acquisition loop, at the 
end of each time point, after all images have 
been acquired for a time point.

File Open Opens the Select Screen Acquisition Journal 
dialog. Use this dialog to select and assign a 
journal to a step. Also use this dialog to clear a 
journal from a step. To assign a journal, select 
the checkbox for the acquisition step and click 
the File Open button.

Journal Lists the names of the journals that you have 
assigned to each step.

Prevent asynchronous 
hardware moves

Select this option if any of the journals you run 
move hardware (change shutters, move focus, 
etc.). This ensures that the journals will run 
correctly.

Figure 5-23 Plate Acquisition Setup dialog: Journals tab

Option Description
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To configure the Journals tab

1. Select one of the checkboxes under the Acquisition Step to 
select when to run a journal.

2. Click the folder icon next to the selected acquisition step. 
The Select Screen Acquisition Journal dialog appears with the 
contents of the Journals folder displayed by default.

3. Select the journal that you want to run at the selected 
acquisition step, and click Open. If the journal is not located in 
the Journals folder, browse to the folder it is in, select it and 
click Open. 

4. Repeat Step 1 to Step 3 as needed to assign journals to run at 
additional acquisition steps.

5. If any of the journals you run move hardware (change shutters, 
move focus, etc.), select Prevent asynchronous hardware moves 
to ensure that the journals will run correctly.

6. Click Next to move to the next tab.

Defining Display Settings
Use the Display Settings tab to configure the MetaXpress Software 
desktop appearance during acquisition. You can choose to use the 
default display settings or create custom settings. The default display 
settings tile and autoscale all acquired images, and ensure that the 
status dialog is unobstructed.
Use this tab to configure the MetaXpress Software desktop appearance 
during acquisition.

Note: If you do not need to run any journals during the acquisition, 
click Next to move to the next tab.
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Figure 5-24 Plate Acquisition Setup dialog: Display Settings tab

Option Description

Use default display settings Uses the MetaXpress Software default settings 
for displaying images and dialogs during 
acquisition. Images are tiled and autoscaled 
and the status dialog is unobstructed.

Manually set image displays 
properties

Makes the Display Images button visible, which 
enables you to change the configuration of the 
MetaXpress Software desktop during 
acquisition.

Display Images Previews the current display settings by 
opening the Screening Status dialog and 
acquiring an image for each wavelength. After 
all images have been acquired, you can change 
the configuration of the display by arranging 
the image windows and dialog and changing 
the size, scaling, and LUT of images. These new 
settings are saved and used during acquisition.

Display images during 
autofocus

Displays the images acquired during autofocus. 
Disabled by default.
5015321 B 117 



Setting Up Plate Acquisition
To configure the Display Settings tab

To change the default display settings, complete the following 
procedure:

1. Select Manually set image display properties.
2. Click Display Images. 

The Screening Status dialog appears and an image is acquired 
for each configured wavelength.

3. Change the configuration of the display by arranging the image 
windows and dialogs. You can change the location, size, zoom, 
scaling, gamma, and LUT of images. These new settings are 
saved and used during acquisition.

4. To display images acquired during autofocus, select Display 
Images during autofocus.

5. Click Next to move to the next tab.

Setting Post Acquisition Options
Use the Post Acquisition tab to choose a specific analysis to run on a 
data set after the acquisition is complete. The data set will added to the 
Auto Run queue for analysis by a system set to Auto Run mode. You 
can select from a list of saved settings from any application modules or 
journal assays saved to the database. 

Display images during 
acquisition

Causes each image to be displayed as it is 
acquired. Disabled by default.

Figure 5-24 Plate Acquisition Setup dialog: Display Settings tab (cont’d)

Option Description

Note: If you do not need to change the display settings, ensure that 
Use default display settings is selected and click Next to move to the 
next tab.

Note: The Display Images during autofocus is disabled by 
default.
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Note: If you do not want to automatically run post-acquisition 
analysis, ensure that Auto Run analysis after acquisition is not 
selected and click Next to move to the next tab.

Note: The list of available assays and settings is the same list that is in 
the Assay tab of the Review Plate Data (DB) dialog.

Figure 5-25 Plate Acquisition Setup dialog: Post Acquisition tab

Option Description

Auto-Run analysis after 
acquisition

Activates the Analysis field that enables you to 
select an assay to auto-run on a separate 
MetaXpress Software computer after each plate 
that is acquired. For more information, refer to 
the Auto Run Mode help file.
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To configure the Post Acquisition tab

To select an analysis to automatically run after acquisition, complete 
the following procedure:

1. Select Auto Run analysis.
2. Select the assay (Application module or Journal Assay) to run 

after acquisition from the Analysis field.
3. Select a setting file from the Settings field. 

The field below the Settings field displays a description of the 
settings if one exists.

4. Select a base folder in which to store measurement results from 
the Base Folder field. To select a new location, click Select and 
click the button to open the Measurements Sets dialog. This 
enables you to select another base folder within the database to 
store measurements results.

5. Click Next to move to the next tab.

Analysis Selects the assay to run. This list includes any 
application modules or journal assays saved to 
the database.

Settings Selects the setting to use for the selected 
assay. The list includes all settings previously 
saved to the database. The list of available 
assays and settings is the same list that is in 
the Assay tab of the Review Plate Data (DB) 
dialog.

Base Folder Shows available folders in the database to store 
measurement results.

Figure 5-25 Plate Acquisition Setup dialog: Post Acquisition tab (cont’d)

Option Description

Note: You can configure and save settings in the Review Plate 
Data (DB) dialog.
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Viewing the Summary Tab
Use the Summary tab to view a list of all current settings for the 
acquisition, save the settings to a file, and start acquiring images.

Note: The information in the summary tab is identical to the 
information displayed when you click the Summary button on the 
bottom of the dialog.

Note: If you want to make any changes to the stage or Z Position, or 
snap an image to test the current settings before starting the 
acquisition, use the Plate Acquisition and Control dialog or the Plate 
Acquisition Toolbar to perform these and other tasks.

Note: If an error message appears after you click Acquire, the most 
likely cause is a configuration error. Read the text in the message to 
determine the error.

Note: After your acquisition is complete and the images have been 
saved to the database, you can use the Review Plate Data (DB) dialog 
to view the images and setup analysis.
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Figure 5-26 Plate Acquisition Setup dialog: Summary tab

Option Description

Summary Lists the current settings selected for your 
acquisition, the number of selected wells, the 
number of sites in each well, the distance 
between images, the number of wavelengths, 
the total number of images, the amount of 
storage required, and the specified type of 
focusing for each wavelength for both the first 
and the remaining sites in the well.

Acquire Plate Starts the sequential acquisition of images from 
a plate based on the current settings.
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To save settings and start acquisition

Complete the following procedure to save your settings file and start 
acquisition:

1. Click Save Settings to open the Save Acquisition Settings dialog 
and save the current settings to a file on the local hard drive or 
to the database. See Save Acquisition Setting Dialog on 
page 123.

2. If you want to print the settings summary, click Print to open the 
Print Setup dialog and then print the settings.

3. Click Acquire Plate to acquire images from a plate based on the 
settings made in the Plate Acquisition Setup dialog. 
The Plate Acquisition Setup dialog closes and the Screen Status 
dialog appears. Each image appears briefly on the MetaXpress 
Software desktop as it is acquired and saved to the database. 
After the last image is acquired and saved, the Screen Status 
dialog closes and the Plate Acquisition Setup dialog reopens.

4. Click Close to exit the Plate Acquisition Setup dialog.

Save Acquisition Setting Dialog
After configuring the Plate Acquisition Setup dialog, save the settings. 
The Save Acquisition Setting dialog enables you to save your settings to 
the database or a file on a local or network drive.

Figure 5-27 Save Acquisition Setting dialog

• Save to file rather than database: Enables the state file to be saved 
to a file on the local computer instead of in the database.

• Setting Name: Type a State file name in this field.
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• Stored Settings: Contains a list State files saved in the screening 
database.

• Save: Saves the current acquisition state to the database using 
the name selected in the Settings Name field. If Save to file 
rather than database is selected, the Save button opens the 
Screen Acquisition State dialog.

• Cancel: Closes the dialog without taking any action.

To save the Plate Acquisition Settings

1. From the Screening menu, open one of the following:
Plate Acquisition and Control
Plate Acquisition
Plate Acquisition Setup

2. Click Save Settings. 
The Save Acquisition State dialog appears.

3. To save the State file on the local computer, select Save to file 
rather than database and proceed to Step 4. To save the State file 
to the database, go to Step 6.

4. Click Save. 
The Screen Acquisition State dialog appears.

5. Type the name of a new state file that you want to create in the 
File name field, or select a listed state file name to overwrite an 
existing state file and click Save.

6. To save the State file to the database, ensure that Save to file 
rather than database is not selected and type the name of a new 
state file that you want to create in the Setting Name field, or 
select a listed state file from the Stored Settings field to overwrite 
an existing state file in the database and click Save.

Load Plate Acquisition Setting Dialog
The Load Plate Acquisition Setting dialog allows you access previously 
saved settings files that were created using the Plate Acquisition Setup 
dialog. You can load all or part of a saved settings file using the 
checkboxes to select specific conditions or groups of settings.
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Figure 5-28 Load Plate Acquisition Setting dialog

Saved settings files can be loaded using any of the following dialogs 
from the Screening menu:

• Plate Acquisition Setup
• Plate Acquisition and Control
• Plate Acquisition

• Settings File List: Selects a saved settings file from the database 
or from a local file on your hard drive.

• Checkboxes for Settings: These checkboxes enable or disable the 
loading of specific settings from a settings file. The settings 
listed are configured on the various tabs of the Plate Acquisition 
Setup dialog. Select the checkbox next to each setting to load it 
with your settings file. 

• Select All: Selects all the settings options
• Clear All: Clears all the settings options.
• OK: Loads the selected settings file from the database or opens 

the Load Plate Acquisition Setting dialog, which enables you to 
select a saved settings file stored outside the database.

• Cancel: Cancels the command and closes the dialog.

Note: You can also use the Load Settings button on the Plate 
Acquisition toolbar to access the Load Plate Acquisition Settings 
dialog.

Note: To select a settings file stored outside the database, select 
From File in the Settings field.
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To load the Plate Acquisition Settings File

1. From the Screening menu, open one of the following:
Plate Acquisition Setup
Plate Acquisition and Control
Plate Acquisition

2. Click Load Settings. 
The Load Plate Acquisition Settings dialog appears.

3. If you are loading a settings file saved to the database, select 
the settings file from the field, select the individual settings to 
load selecting the checkboxes for each settings group, and then 
click OK.
The file loads from the database and the Load Plate Acquisition 
Settings dialog closes.

4. If you are loading a settings file saved to your hard drive, select 
From File in the field, select the individual settings to load using 
the checkboxes for each settings group, and then click OK.

5. In the HTSSTATE folder, navigate to the state file (.HTS) you 
want to open and click Open. 
The selected state file loads and the Load Plate Acquisition 
Settings dialog closes.

Using a Saved Setting For a New Plate
This procedure explains how to use a previously saved settings file to 
rerun an experiment on a new plate. This procedure uses the Plate 
Acquisition and Control dialog to load the settings file and start the 
acquisition. You can also use Plate Acquisition, Plate Acquisition Setup, 
or the Plate Acquisition toolbar to perform these tasks.

To load a saved plate setting and begin an acquisition

1. From the Screening menu, select Plate Acquisition and Control. 
The Plate Acquisition and Control dialog appears.

2. Click Load Settings. 
The Load Plate Acquisition Settings dialog appears.

Note: This procedure assumes that the settings file is configured 
correctly for the new plate. If you need to make changes to the 
settings file before acquiring, use the Plate Acquisition Setup dialog.
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3. If you are loading a settings file saved to the database, select 
the settings file to load from the field, and then select the 
individual settings to load from the file using the checkboxes for 
each settings group.
OR
If you are loading a settings file saved outside the database, 
select From File in the field and then select the individual 
settings to load from the file selecting the checkboxes for each 
settings group.

4. If you are using a settings file from the database, click OK. The 
file will load from the database and the Load Plate Acquisition 
State dialog will close.
OR
If you are loading a settings file saved outside the database, 
click OK. In the Load Plate Acquisition Setting dialog, navigate to 
the state file (.HTS) you want to open and click Open. The state 
file you selected loads and the dialog closes.

5. Click Summary to open the Screen Summary dialog and review 
your settings. Close the dialog when finished.

6. If you need to make any changes to your settings, click Setup to 
open the Plate Acquisition Setup dialog and make the changes.

7. Click Acquire to begin the acquisition with the loaded settings.

Laser Focus Troubleshooting Tips
• If the focus was found for some wells and lost for others, that 

usually means that the Bottom Variation value entered in the 
Plate tab of the Plate Acquisition Setup dialog is not large 
enough. Increase the Bottom Variation value by 10 µm, or 
measure the wells in question to get a more accurate read. 
Repeat steps as needed.

• Check for scratches, dirt, or condensation on the bottom of the 
plate and correct as needed.

• Ensure that there is liquid in each well.
• If the well bottom has a very weak laser signal, which is possible 

with samples containing a high percentage of glycerol, select 
Find plate bottom only, and then offset by bottom thickness on 
the Autofocus tab in Plate Acquisition Setup. This option is also 
necessary for low NA objectives, such as 2x or 4x.

• If you have recently changed objectives, ensure that you 
complete the procedures in Updating the System After Adding or 
Replacing an Objective on page 163. 
If you are still unable to successfully use the laser autofocus 
with your plate type, contact Technical Support.
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6
Acquiring Plates
Plate Acquisition can be initiated from any of the following locations in 
the MetaXpress® Software application:

• Plate Acquisition and Control dialog
• Plate Acquisition Setup dialog: Summary tab
• Plate Acquisition dialog
• Plate Acquisition toolbar

Each of these locations is intended to serve a specific function in the 
plate acquisition flow. Depending on where you are in this process, you 
need to determine which dialog is most appropriate to use for the type 
of plate acquisition that you need to run. For example, when you are 
first designing your experiment, you would most likely be initiating 
acquisition from either the Plate Acquisition and Control dialog or the 
Summary tab of the Plate Acquisition Setup dialog. After all settings are 
complete, you would most likely initiate acquisition from the Plate 
Acquisition dialog or the Plate Acquisition toolbar.

Plate Acquisition and Control Dialog
At the beginning of the process, while designing your experiment, you 
will most likely need to make changes to the X, Y, and Z positions to 
accomplish correct plate and focus alignment. The Plate Acquisition and 
Control dialog provides controls that enable you to simplify and 
expedite this process. You can also use this dialog as a starting point 
for configuring the Plate Acquisition Setup dialog. Click Setup to open 
the Plate Acquisition Setup dialog. Other controls on this dialog enable 
you to initiate Autofocus, specify the Experiment base name, Load 
Settings, Save Settings, display the Summary, open a Live window, 
open a Preview window, Snap an image, and Acquire a Plate. For 
additional information about this dialog, see the following topics or 
refer to the application help available in the MetaXpress Software.

Note: If you are using a robotic plate handler to load your plates, 
acquisition is initiated from within the environment of the software 
that controls the plate handler device.
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Using the Plate Acquisition and Control Dialog

Use the Plate Acquisition and Control dialog to acquire images from 
multi-well plates using the settings defined in the Plate Acquisition 
Setup command. You can also control the stage and Z-motor from this 
dialog, as well as change the current wavelength and save and load 
settings.

There are several possible workflows available for your acquisition. One 
typical workflow for multi-well plate acquisition is as follows:

• Configure and save your settings file using the Plate Acquisition 
Setup dialog.

• Use the Plate Acquisition and Control dialog or toolbar to do the 
following:

Load your settings file and review the settings using the 
Summary button.
Confirm your settings if needed using the available tools.
Enter an experiment base name.
Start the acquisition. During acquisition, the acquired 
images are saved into the database.

• If you want to make any changes to the stage or Z Position, or 
snap an image to test the current settings before starting the 
acquisition, use the Plate Acquisition and Control dialog or the 
Plate Acquisition Toolbar to perform these and other tasks.

• Perform any post-acquisition analysis using the Review Plate 
Data or Plate Data Utilities dialogs. This can be configured to 
start automatically from the Plate Acquisition Setup dialog, if 
desired.

Note: Most of the tools available in the Plate Acquisition and Control 
dialog are also available in the Plate Acquisition toolbar. To display the 
Plate Acquisition toolbar, click Window>Toolbars>Plate 
Acquisition.
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Figure 6-1 Plate Acquisition and Control dialog

Option Description

Plate Navigation:

• X, Y Controls Moves the stage in increments of one well in 
the direction of the selected arrow button.

• Well Indicates the well currently in position for 
image acquisition.

• Site Indicates a site within a specific well that is 
currently in position for image acquisition.

• Go to well Moves the stage to the well number that you 
type into the Go to well box.

• Go To A1 Moves the stage to the A1 position.

• Z Controls Moves the Z-motor in one-step increments in 
the direction of the selected arrow button. The 
step size is set in the Step Size field.

• Go to Origin Moves the Z-motor to the focus position as 
defined in the Focus dialog.

• Step size Sets the size of the individual focus increments 
using the Z control arrows.

• Find Sample Performs a very coarse auto focus on the 
current well position. The range covered in Find 
Sample is the same as the initial Find Sample 
when starting an Acquire.
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• Autofocus Performs autofocus on the current well as 
configured for the current wavelength in the 
Autofocus plane of the Plate Acquisition Setup 
dialog.

Acquisition Control:

• Load Settings Loads the selected settings from an existing 
screening settings file. Settings files are stored 
either in the database or on the file system. 
When you click Load Settings, the Load Screen 
Acquisition dialog appears. Check the boxes for 
the conditions and groups of settings that you 
want to load from the settings file, clear the 
ones that you do not want to load. Click Select 
All to load all conditions; click Clear all to clear 
all selections. Click Load to load your selected 
conditions. The Load Settings function is 
identical to the Load Settings option in the 
Experiment tab of the Plate Acquisition Setup 
dialog.

• Summary Lists the current settings selected for your 
acquisition, the number of selected wells, the 
number of sites in each well, the distance 
between images, the number of wavelengths, 
the total number of images, the amount of 
storage required, and the specified type of 
focusing for each wavelength for both the first 
and the remaining sites in the well. The 
Summary function is identical to the Summary 
tab in the Plate Acquisition Setup dialog.

• Save Settings Saves the current settings to a file on the local 
hard drive or to the database. When you click 
Save Settings, the Save Acquisition dialog 
appears. Type the name of a new settings file 
that you want to create, or select a listed 
settings file name to overwrite an existing 
settings file.

• Setup Opens the Plate Acquisition Setup dialog and 
enables you to change acquisition settings.

• Experiment base name Defines the base file name.

• Wavelength Selects the wavelength to use for your snap or 
live image.

Figure 6-1 Plate Acquisition and Control dialog (cont’d)

Option Description
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To use the Plate Acquisition and Control dialog

The controls on the Plate Acquisition and Control dialog allow you to 
manually control certain microscope functions to enable you to test 
settings and conditions and acquire preliminary or test images of 
samples. The Acquire button is used to begin the automated acquisition 
process configured in the Plate Acquisition Setup dialog. Use the 
following procedure to familiarize yourself with the controls on the Plate 
Acquisition and Control dialog:

1. Click Screening > Plate Acquisition and Control.
The Plate Acquisition and Control dialog appears.

2. Ensure that a plate is in place on the microscope stage.
3. Click Go To A1 to move the plate to A1. 

OR
Type the well number that you want to view in the Go to well 
box, and click Go to well. The plate moves to the desired 
location.

• Snap Current Acquires a single image of the currently in 
place well at the current settings for stage (XY-
position), focus (Z-position), wavelength, well, 
site, and exposure.

• Show Live Continuously acquires images based on the 
current settings, and updates the image as 
settings are changed.

• Preview Previews the current display and exposure 
settings by opening the Plate Acquisition Status 
dialog and autofocusing and acquiring an image 
for each wavelength. After all images have 
been acquired, you can change the 
configuration of the display by repositioning the 
image windows and dialog and changing the 
size, scaling, and LUT of images. These window 
new settings will be saved and used during 
acquisition.

• Acquire Starts the sequential acquisition of images from 
a plate based on the settings made in Plate 
Acquisition Settings dialog.

Reset IX Micro Turns off and then turns on the ImageXpress 
Micro instrument

Close Closes the dialog.

Figure 6-1 Plate Acquisition and Control dialog (cont’d)

Option Description
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4. To change the Z-focus motor position, use the Z-control arrows. 
5. Select a step size in the Step size field. Use a large value for 

course movement or a small value for fine movement.
6. Click Go to Origin to move the Z focus motor to its origin position 

as defined in the Focus dialog.
7. Click Find Sample to initiate the Find Sample focusing routine on 

the current well.
8. Click Autofocus to autofocus on the current well using the 

wavelength selected in the Wavelength field. 
9. Click Load Settings to open the Load Plate Acquisition Settings 

dialog and load a previously saved settings file.
10. Click Save Settings to open the Save Plate Acquisition Settings 

dialog and save the current settings to a file on the local hard 
drive or to the database. 

11. Click Summary to open the Plate Acquisition Summary dialog and 
view your current settings.

12. Click Setup to open the Plate Acquisition Setup dialog and change 
your acquisition settings.

13. Click the Wavelength field to select a wavelength that has been 
defined for the current setting in the Plate Acquisition Setup 
dialog.

14. Click Snap Current to acquire a single image with the current 
settings.

15. Click Show Live to acquire images so you can manually focus the 
microscope.

16. Click Preview to open the Plate Acquisition Status dialog and an 
image view dialog for each wavelength. During this time, you 
can adjust the display of images and windows so that they will 
be appropriately sized and positioned for acquisition.

17. Click Acquire to acquire images.
18. Click Close to exit the dialog.
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Plate Acquisition Setup dialog: Summary Tab
The Plate Acquisition Setup dialog Summary Tab includes an Acquire 
Plate button from which you can initiate plate acquisition. This button is 
located on the last tab of the dialog. Normally, you should arrive on the 
Summary tab after making all required settings for acquisition, thus it 
is a logical place from which to initiate plate acquisition.

Figure 6-2 Plate Acquisition Setup dialog: Summary tab

Using the Plate Acquisition Setup dialog: Summary Tab

Use the Summary tab to view a list of all current settings for the 
acquisition, save the settings to a file, and start acquiring images. Use 
the following procedure to save your settings file and start acquisition.

Note: The information in the Summary tab is identical to the 
information displayed when you click the Summary button on the 
bottom of the dialog.
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To use the Summary tab

1. Click Save Settings to open the Save Plate Acquisition Settings 
dialog and save the current settings to a file on the local hard 
drive or to the database.

2. If you want to print the settings summary, click Print to open the 
Print Setup dialog and then print the settings.

3. Click Acquire to acquire images.
The Plate Acquisition Setup dialog closes and the Screen Status 
dialog appears. Each image appears briefly on the MetaXpress 
Software desktop as it is acquired and saved to the database. 
After the last image is acquired and saved, the Screen Status 
dialog closes and the Plate Acquisition Setup dialog reopens.

4. Click Close to exit the Plate Acquisition Setup dialog.

Plate Acquisition Dialog
The plate acquisition dialog has the least number of controls and 
options compared to the other three locations from which you can 
initiate plate acquisition. You can do only the following procedures:

• Select or type an Experiment base name
• Select and load the Settings file that you want to use for the 

acquisition.
• View the summary of acquisition settings.
• Acquire a plate.

Note: If you want to make any changes to the stage or Z Position, or 
snap an image to test the current settings before starting the 
acquisition, use the Plate Acquisition and Control dialog or the Plate 
Acquisition Toolbar to perform these and other tasks.

Note: If an error dialog appears after you click Acquire, the most likely 
cause is a configuration error. Read the text in the dialog to determine 
the error.

Note: After acquisition is complete and the images have been saved to 
the database, you can use the Review Plate Data (DB) dialog to view 
the images and setup analysis.
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Figure 6-3 Plate Acquisition dialog

Using the Plate Acquisition Dialog

Use the Plate Acquisition dialog to quickly start acquiring plates using 
any of the settings defined in the Plate Acquisition Setup command. You 
can also view a summary of the current settings file and change the 
base name of the experiment from this dialog.

There are several possible workflows available for your acquisition. One 
typical workflow for multi-well plate acquisition is as follows:

• Configure and save your settings file using the Plate Acquisition 
Setup dialog.

• Use the Plate Acquisition and Control dialog or toolbar to do the 
following:

Load your settings file and review the settings using the 
Summary button.
Confirm your settings if needed using the available tools.
Enter an experiment base name.
Start the acquisition. During acquisition, the acquired 
images are saved into the database.

• Perform any post-acquisition analysis using the Review Plate 
Data or Plate Data Utilities dialogs. This can be configured to 
start automatically from the Plate Acquisition Setup dialog if 
desired.

Note: To perform additional configuration of the experiment before 
starting the acquisition, use the Plate Acquisition and Control dialog.
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To use the Plate Acquisition dialog

1. Click Screening > Plate Acquisition. 
The Plate Acquisition dialog appears.

2. Ensure that a plate is in place on the microscope stage.
3. Select a Settings file to use from the Settings field.
4. To change the experiment name, type a name in the Experiment 

Base Name field.
5. Click Summary to view details about the current settings.
6. Click Load Settings to open the Load Plate Acquisition Setting 

dialog. 
7. Select the checkboxes for the conditions and groups of settings 

that you want to load from the settings file, or click Select All to 
load all conditions. 

8. Click OK to load your selected conditions.
9. Click Acquire to acquire images from a plate based on the 

current settings.
10. Click Close to exit the dialog.

Observing Acquisition Progress
The following dialogs enable you to observe and determine the status 
of the progress of your plate acquisition:

• Screen Summary dialog
• Plate Acquisition Status dialog

Screen Summary Dialog

The Screen Summary dialog shows a complete summary list of all of 
the settings in the Plate Acquisition Setup dialog. This same information 
is also repeated on the Summary Tab of the Plate Acquisition Setup 
dialog. 
To view the Screen Summary dialog, click the Summary button on the 
Plate Acquisition and Control dialog.
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Figure 6-4 Screen Summary dialog

Plate Acquisition Status

This dialog shows the progress of your plate acquisition by indicating 
the wells scheduled for acquisition, the wells that have been completed, 
and the well currently being acquired. 
To view the Plate Acquisition Status dialog, click Preview in the Plate 
Acquisition and Control dialog.
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Figure 6-5 Plate Acquisition Status dialog

Legend: 
White: Wells not scheduled for acquisition
Green: Wells scheduled for acquisition
Green with Gray outline box: Wells that have completed acquisition
Green with Black outline box: Well currently being acquired
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Using the Plate Acquisition Toolbar
The Plate Acquisition toolbar contains tools used to control the 
hardware on the ImageXpress Micro System.
If the Plate Acquisition toolbar is not currently loaded, click Window > 
Toolbars > Plate Acquisition.

Figure 6-6 Plate Acquisition toolbar

Icon Description

Moves the stage up in one-well increments

Moves the stage down in one-well increments

Moves the stage forward in one-well increments

Moves the stage backward in one-well increments

Moves the stage forward in one-site increments

Moves the stage backward in one-site increments

Moves the stage to the load/eject position.

Current well and/or site position

Moves the Z position (focus) upward in single step 
increments

Moves the Z position (focus) downward in single step 
increments

Performs a very coarse auto focus on the current well 
position. The range covered in Find Sample is the same as 
the initial Find Sample when starting an Acquire.

Performs auto focus on the current well as configured for 
the current wavelength in the Autofocus plane of the Plate 
Acquisition Setup tool
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Selects the wavelength to use for the snap or live image

Acquires a single image of the currently in place well at 
the current settings for stage (XY-position), focus (z-
position), wavelength, well, site, and exposure

Show Live continuously acquires images based on the 
current settings, and updates the image as settings are 
changed

Loads the selected settings from an existing screening 
settings file. Settings files are stored either in the 
database or on the file system. When you click Load 
Settings, the Load Screen Acquisition dialog appears. 
Check the boxes for the conditions and groups of settings 
that you want to load from the settings file, clear the ones 
that you do not want to load

Screen Summary lists the current settings selected for 
your acquisition, the number of selected wells, the 
number of sites in each well, the distance between 
images, the number of wavelengths, the total number of 
images, the amount of storage required, and the specified 
type of focusing for each wavelength for both the first and 
the remaining sites in the well

Previews the current display and exposure settings by 
opening the Plate Acquisition Status dialog and 
autofocusing and acquiring an image for each 
wavelength. After all images have been acquired, you can 
change the configuration of the display by repositioning 
the image windows and dialog and changing the size, 
scaling, and LUT of images. These new settings will be 
saved and used during acquisition

Starts the sequential acquisition of images from a plate 
based on the settings made in Plate Acquisition Settings 
dialog

Figure 6-6 Plate Acquisition toolbar (cont’d)

Icon Description
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7
Customizing the MetaXpress Software 
Application
A powerful feature of the MetaXpress® Software is the ability to 
customize the operation of the software for your users. Different 
objectives and workflows call for customized settings that can be 
switched as needed. Applications within the MetaXpress Software 
application, such as the Meta Imaging Series Administrator and the 
Create Taskbar command, allow you to create settings that match the 
needs of your users. The following topics will be covered in this section:

• Users and Groups in the Meta Imaging Series Administrator
• Custom Toolbars and Taskbars
• Default Paths for Data

Users and Groups in the Meta Imaging Series 
Administrator

The Meta Imaging Series Administrator commands enable you to define 
and configure settings for individual users and groups in the 
MetaXpress Software application. There are two modes for the 
Administrator: Single-User Mode and Multi-User Mode.
In Single-User mode, the Administrator enables you to select hardware 
settings and configure drop-ins and toolbars for groups that have 
already been created. In Multi-User mode, you create new groups, add 
users to different groups, and define hardware settings for groups. As a 
System Administrator, you will be working in Multi-User mode, creating 
groups and users for your MetaXpress system. For detailed instructions 
on setting up users and groups, refer to the online help for the Meta 
Imaging Series Administrator.
Your ImageXpress Micro System ships with a number of groups and 
hardware settings predefined. The number of groups depends on the 
configuration of your system. Figure 7-1 shows the Multiple User 
Configuration screen in the Meta Imaging Series Administrator.

Note: The concepts of users and groups discussed in this chapter are 
specific to custom hardware and drop-ins/toolbars settings for the 
MetaXpress Software application. They are NOT related in any way to 
configuring users and groups within the database. For information on 
setting up users and groups with the database, refer to the MDCStore 
High Content Data Management Solution Database Schema 
Installation and Update Guide included on the MetaXpress Software 
installation USB flash drive.
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Figure 7-1 Sample of the Multiple User Configuration screen

This sample shows a system with the following groups defined:
MetaMorph: This is the default MetaMorph® Software 
application group. 
MetaXpress: This is the ImageXpress Micro System and 
MetaXpress Software application group.
MetaXpress Robot: The hardware settings in this group 
enable the optional CRS robot to be used with the 
MetaXpress system.

To enable a group (that is, to use the hardware and software settings 
created for a group), you must create users and assign them to the 
group.

Note: For more information on creating users and groups in the Meta 
Imaging Series Administrator, refer to the application help (press F1 to 
access the help).
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Creating an Offline Version of the MetaXpress 
Software Application
Molecular Devices recommends creating an offline group for 
MetaXpress Software users. This offline group has no hardware settings 
and is useful for analysis of acquired images. Since the offline group 
has no hardware settings, it does not attempt to establish 
communication with the other MetaXpress components. This allows the 
application to start faster, and allows you to run the software without 
turning on any hardware. Use the following procedure to create an 
offline MetaXpress group in the Meta Imaging Series Administrator:

1. From the Windows Start menu, click All Programs > 
MetaXpress > Meta Imaging Series Administrator. 
The Meta Imaging Series Administrator program opens.

2. If the program opens in Single User Configuration mode, 
click Enter Multi-User Mode.

3. Click Create Group. 
The Create Group dialog appears.

Figure 7-2 Create Group dialog

4. Type a group name into the Group Name field, for example, 
MetaXpress Offline.

Note: You must exit the MetaXpress Software application before using 
the Meta Imaging Series Administrator. The two programs cannot run 
at the same time.

Note: For additional information about any of the dialogs in the Meta 
Imaging Series Administrator, press the F1 key to access the 
application help for the active dialog.
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5. Select MetaXpress from the Application field.
6. Select Offline from the Hardware Configuration field.
7. Select None from the Copy Settings From field.
8. Click Create. 

The Create Group dialog closes and the new group is listed in 
the Groups field.

9. Select the new group in the Groups list, select a user from the 
Users list, and then click <<Add Users to add the user to the 
new group. Add users to the groups as needed.

10. Click OK to exit the Meta Imaging Series Administrator 
program.

Creating Group Icons and Adding Them to the 
MetaXpress Software Desktop
After creating the MetaXpress Offline group and adding users using the 
above procedure, you should use the Create Icons command to create 
icons for the new group. This command installs shortcuts for any new 
groups to the Meta Imaging Series folder on the MetaXpress Software 
desktop. These shortcuts can then be copied directly to the MetaXpress 
Software desktop. This enables users to choose which version to start 
from the desktop. Use the following procedure to create and add group 
icons to the MetaXpress Software desktop:

1. From the Windows Start menu, click All Programs > 
MetaXpress >Meta Imaging Series Administrator. 

2. In the Meta Imaging Series Administrator, click Create Icons to 
create the icons. 

3. Click OK to exit the Meta Imaging Series Administrator.
4. Double-click the MetaXpress 5.0 shortcut on your desktop.
5. In the MetaXpress 5.0 folder, confirm that a shortcut for the 

group that was created in the Creating an Offline Version of the 
MetaXpress Software Application on page 145 is listed.

6. Select and right-click the shortcut (for example, MetaXpress 
Offline), and then select Send To > Desktop. 
The shortcut is created on the desktop.

7. Double-click the desktop shortcut to open that instance of the 
application.

8. Repeat Step 6 as needed to add other shortcuts to the desktop.

Note: You must add at least one user to the new offline group 
for it to be available.
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Custom Toolbars and Taskbars
Now that you have the groups configured and the icons on the desktop, 
you can create or modify custom toolbars and taskbars to include 
specific combinations of tools and commands.

Customizing Toolbars
With the Configure Dropins/Toolbars command, you can add menu 
commands to toolbars, move commands from one tool bar to another, 
and add or remove journals to toolbars. Use the following procedure to 
customize the toolbars:

1. From the Windows Start menu, click All Programs > 
MetaXpress > Meta Imaging Series Administrator.

2. In the Meta Imaging Series Administrator, select the group that 
you want to edit the toolbar in from the Groups list and click 
Edit Group.

3. In the Edit Group dialog, click Drop-ins/Toolbars. 
4. In the Configure Dropins/Toolbars dialog, click the Toolbars 

tab, and clear the Use default toolbars checkbox.
5. Select Menus to add menu commands to toolbars.

OR
Select Toolbars to add toolbar commands to other toolbars.
OR
Select Journals to add journals to any toolbar or to create new 
Journal toolbars.

6. To add any command to a toolbar, click and drag a command 
from the left window to the appropriate toolbar folder in the 
right window.

7. Click OK when finished. 
8. Click Yes in the dialog to confirm that you want the users in the 

group to use the modified configuration.
9. Click OK to exit the Edit Groups dialog.
10. Click OK to exit the Meta Imaging Series Administrator. 

The modified toolbars will be available the next time you start 
the corresponding version of the MetaXpress Software 
application.

Note: You can use the Control or Shift keys in combination with 
a mouse click to select multiple commands, and then drag the 
commands to the appropriate toolbar folder.
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Creating Taskbars
Taskbars are created directly in the MetaXpress Software application 
and are a convenient way to access frequently used commands and 
journals. Each taskbar can consist of up to 48 buttons in a configuration 
of rows and columns of your choosing. You can mix and match journals, 
commands, or other taskbars within the same taskbar. Taskbars differ 
from toolbars in that they enable you to add journals as well as 
commands. Molecular Devices recommends creating taskbars that 
combine commands and journals specific to your experiments. Use the 
following procedure to create and load a taskbar.

1. Start the MetaXpress Software application.
2. Click Journal > Taskbars > Create Taskbar. 

The Taskbar Editor dialog and Taskbar window open. Position 
them so that you can see both the dialog and the window at the 
same time.

3. Select the number of rows and columns for the taskbar by 
dragging the thick border of the Taskbar window until the 
desired number of rows and columns appear in the window. 

4. Select the width of the buttons in the taskbar by dragging the 
thick border of the active button until the buttons are the 
desired width.

5. Select the desired category for the first item you want to add to 
the taskbar from the Category group.

6. When you have located the item you want to add to the taskbar, 
double-click its entry in the list to add it to active button in the 
taskbar as shown in Figure 7-3. 

Note: If you selected Journal or Taskbar as the Category, the 
directory names are displayed in square brackets in the list box 
below Category. Double-click a directory name to display the 
appropriate files in that directory or double-click the double 
period (..) to go up one level in the directory structure.
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Figure 7-3 Adding a function to a taskbar

7. Repeat Step 5 and Step 6 for each item you want to add to the 
taskbar. 

8. If necessary, click Undo to undo the last command or click 
Clear Button to clear an item from the active button.

9. If you want to rename the taskbar, click Rename Taskbar, and 
type the new name in the Taskbar Title field of the Rename 
Taskbar dialog. Click OK.

10. Click Save, and type a name in the File Name field of the Save 
As dialog. Navigate to the appropriate drive and folder, if 
necessary. Click Save.

11. To use the new taskbar (or a different taskbar) immediately, 
click Journal > Taskbars > Load Taskbar. Select the desired 
taskbar file and click Open.

12. Click Close to close the Taskbar Editor dialog.
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Default Paths for Data
The Configure Default Paths command in the MetaXpress Software 
application is used to change the default file paths for each group or 
user. You can modify these paths so that the users on the system have 
their own dedicated data folders. These folders contain log files, 
calibration settings, and other data unique to each user. Molecular 
Devices recommends changing the following default paths on a 
MetaXpress system:

• Default Data Paths: Your MetaXpress computer has a dedicated 
hard drive partition for data. The default data file paths for each 
user should all point to this data drive. For example: 
D:\Data\Bob. The following data file types should have their file 
paths changed to point to the data drive:

Log files
Memory lists
Calibrations

• Default HTS State Path: The MetaXpress settings file path 
should also point to the data drive. For example: 
D:\MX\HTSSTATE\.

• Default Assay Path: This path should point to an assay folder on 
the root directory of your C drive. For example: C:\Assay\.

Note: The MetaXpress settings file is saved to the database by 
default.

Note: Molecular Devices recommends making monthly backups 
of the Data, HTS State, and Assay files.
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Use the following procedure to edit the default data paths for a group:
1. Start the MetaXpress Software application.
2. Click Edit > Configure Default Paths.

Figure 7-4 Configure Default Paths dialog

3. In the Configure Default Paths dialog, select the item whose 
default file path you want to modify.

4. Click Modify.
The Browse for Folder dialog appears.

5. Select the folder that you want to use for the new default path, 
or click New to create a new folder.

6. Click OK.
7. In the Configure Default Paths dialog, click OK to apply the 

new default path and close the dialog.
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8
Maintaining the ImageXpress Micro 
Instrument
User Safety Instructions 
To avoid personal injury or damage to your equipment during user 
service and maintenance, it is important to strictly observe the safety 
information outlined below: 

• Ensure that the power supply for the ImageXpress® Micro 
instrument is turned OFF and that the power cable is unplugged. 
If the MetaXpress® Software is running, first exit the program 
before turning off the instrument. 

• Disconnect the USB connection to the hardware server (host) 
PC, and turn off any attached peripherals, such as the robot 
plate-loading arm. 

• Access ONLY the user-serviceable components inside the 
enclosure. Avoid contact with other components as they can be 
damaged or knocked out of alignment.

CAUTION! Be sure not to touch the autofocus laser. 

• Keep liquids, vapor, and dust well away from the interior of the 
instrument. Do not attempt to clean inside the enclosure. 

• Do not leave the interlocked access panels open for extended 
periods of time. 

• Ensure all components and access panels are replaced before 
restarting the instrument. 

Light Source
The ImageXpress Micro System is equipped with an external light 
source. The light source for the Standard model of the ImageXpress 
Micro System is equipped with a fuse-protected 300 W Xenon lamp. 

Note: The XL model of the ImageXpress Micro System is equipped with 
an external solid-state light source that has a rated lifetime of more 
than 15000 hours. There are no user-replaceable parts in this light 
source.
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Changing the Lamp
When it is time to replace the lamp in the ImageXpress Micro System 
light source, be aware that the entire lamp assembly must be replaced, 
and not the bulb alone. For the Xenon lamp, this includes the bulb and 
heat sink.
Instructions for changing the lamp are available in the Molecular 
Devices knowledge base. Visit www.moleculardevices.com and follow 
the links to the knowledge base.

Changing the Light Guide
A liquid light guide couples the light from the light source to the 
illumination optics in the ImageXpress Micro System unit. The light 
source assembly is precisely aligned with the light guide during 
manufacture, and requires no further position adjustment. However, 
the light guide needs to be replaced if it is worn or damaged.
Instructions for replacing the light guide are available in the Molecular 
Devices knowledge base. Visit www.moleculardevices.com and follow 
the links to the knowledge base. 

Changing the Light Source Fuse 
The ImageXpress Micro System light source ships with a spare fuse, if 
applicable. 
Instructions for replacing the fuse are available in the Molecular 
Devices knowledge base. Visit www.moleculardevices.com and follow 
the links to the knowledge base. 

Replacing the Shutter (standard model only)
A solenoid-activated mechanical shutter controls the exposure of the 
sample to excitation light to minimize sample degradation and 
photobleaching. The shutter has an expected lifetime of 1 million 
cycles.
Instructions for replacing the shutter are available in the Molecular 
Devices knowledge base. Visit www.moleculardevices.com and follow 
the links to the knowledge base. 

WARNING! In the event that a lamp requires replacement, 
ensure that you have allowed the lamp to cool for at least 
30 minutes. The lamp generates an extreme amount of heat 
and attempting to remove the lamp immediately after use can 
result in injury. 
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Filters Cubes 
If you decide to replace or add to any of the optical components in the 
factory-standard ImageXpress Micro instrument, there are two 
procedures that need to be completed: 

• Changing the component within the instrument.
• Updating the software to reflect the new hardware 

configuration. 

Changing Filter Cubes 
The ImageXpress Micro instrument’s filter cubes are mounted in a five-
position slider within the instrument enclosure. Filter cubes are delicate 
components, and special care is required when handling them. Please 
follow these outlined instructions for adding or replacing a filter cube. 
You can leave the lamp powered on during this procedure. 

CAUTION! We advise wearing powder-free gloves during the following 
procedure to prevent skin oils from damaging optical coatings. Read 
and follow the User Safety Instructions on page 153 for safe user-
service procedures. 

1. From the Windows Start menu, click AllPrograms > MetaXpress 
Meta Imaging Series > Meta Imaging Series Administrator. 

2. Click Configure Hardware. 
3. Click Configure Devices. 
4. Select ImageXpress Micro Filter Cube Changer. 
5. Click Settings. 
6. Click the Eject Filter Cubes button. 
7. Close the Meta Imaging Series Administrator program. 
8. Power OFF the ImageXpress Micro instrument at the main power 

switch, which is located on the external power supply. 
9. Open the door on the front of the instrument that allows access 

to the filter cube changer. 
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10. Pull up on the front latch to release the filter cube cassette from 
the filter cube changer. 

Figure 8-1 Removing filter cubes

11. Remove the filter cube cassette. 
12. Loosen the hex screw that holds the filter cube in place, and 

remove the cube. 
13. Slide the new cube into place and lightly tighten the hex screw. 
14. Place a finger underneath the ejected filter cube changer in the 

instrument to hold it in place. Carefully line up the filter cube 
cassette with the changer, and push the filter cube cassette back 
into place until the latch engages.   

CAUTION! If you feel resistance while replacing the filter cube 
cassette, do not proceed. Remove it and recheck to make sure 
that it is lined up correctly with the changer. 

15. Power ON the ImageXpress Micro instrument at the main power 
switch, which is located on the external power supply. 

16. Update the software to reflect the new hardware configuration. 
See Updating the System After Adding or Replacing a Filter Cube 
on page 157.
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Updating the System After Adding or Replacing a 
Filter Cube 

After installing a new filter cube, you must update the filter settings in 
the Meta Imaging Series Administrator and then update settings within 
the main MetaXpress Software program.

Editing the Filter Settings in the Meta Imaging Series 
System Administrator
Complete the following procedure to update your filter settings:

1. From the Windows Start menu, click AllPrograms > MetaXpress 
Meta Imaging Series > Meta Imaging Series Administrator. 

2. Select MetaXpress from the List of Groups field.
3. Click Configure Hardware. 
4. Click Install System Devices. 
5. From the Installed Devices list, select ImageXpress Micro Filter 

Cube and click Settings. 

Figure 8-2 ImageXpress Cube Settings dialog
5015321 B 157 



Maintaining the ImageXpress Micro Instrument
6. Edit the name of the filter cube you are adding or replacing in 
the appropriate Position Labels field.

7. Click OK to close the Install System Devices dialog and return to 
the Configure Hardware dialog.

8. In the Configure Hardware dialog, ensure that the hardware 
settings you are using are selected in the Hardware Settings list 
and then click Configure Devices. 
The User Settings hardware configuration dialog appears.

9. From the Claimed Devices list, select ImageXpress Micro Filter 
Cube and click Settings. 
The ImageXpress Micro Filter Cube Settings dialog appears.

10. Again, edit the name of the filter cube you are adding or 
replacing in the appropriate Position Labels field.

11. Click OK to close the User Settings dialog and return to the 
Configure Hardware dialog.

12. Click OK to exit each dialog and close the Meta Imaging Series 
System Administrator.

Note: The next steps involve entering the values again, this 
time starting from the Configure Devices dialog. This is to 
ensure that the settings carry over for all hardware profiles.
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Updating Illumination Settings
Complete the following procedure to update illumination settings within 
the MetaXpress Software application:

1. Open the MetaXpress Software application and log into the 
database.

2. Click Devices > Configure Illumination. 
The Configure Illumination dialog appears.

Figure 8-3 Configure Illumination dialog

3. Ensure that the illumination device you changed is selected in 
the Device Positions field and select the filter that you installed 
from the corresponding drop-down box.

4. Select the ImageXpress Micro Shutter checkbox and select Open 
for the shutter. If you are doing a florescence experiment with 
transmitted light, select Closed.

5. Enter the name of the new filter in the Name field.
6. Enter the emission wavelength of the new filter in the 

Wavelength field.
7. Click Add/Replace to add this setting to the Defined Settings list.
8. If you replaced a filter with an existing setting, select the old 

setting from the Defined Settings field and click Remove.
9. After the settings are updated, click Backup.
10. Click Close.
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Objectives
If you decide to add or replace any of the optical components in the 
factory-standard ImageXpress Micro System, there are two parts to the 
procedure: 

• Changing the component within the instrument. 
• Updating the software to reflect the new hardware 

configuration.   

CAUTION! Read the section Correct Objective Placement before 
installing or replacing an objective. 

Correct Objective Placement
Molecular Devices recommends that users place the ELWD objectives 
(20X, 40X, 60X) or any other objective with a correction collar in one of 
the two outer positions (1 or 4) so that the correction collar can be 
accessed from one of the side panels. 

Changing Objectives
The ImageXpress Micro instrument’s objectives are mounted in a four-
position linear selector. Objectives are very delicate components, and 
special care is required when handling them. Objectives can be added 
or replaced by following these steps. 
You can leave the lamp powered on during this procedure. 

CAUTION! We advise wearing powder-free gloves during the following 
procedures to prevent skin oils from damaging optical coatings. 

1. Read and follow the User Safety Instructions on page 153 for 
safe user-service procedures. 

2. Read and follow Correct Objective Placement on page 160. 
3. In the MetaXpress Software or the Meta Imaging Series 

Administrator move the objective changer to an appropriate 
position for installing the objective. 

Selecting position 1 (the position on the right) moves the 
objectives to the left. 
Selecting position 4 (the position on the left) moves the 
objectives to the right. 

4. Exit the MetaXpress Software and turn off the ImageXpress 
Micro instrument at the main power switch, which is located on 
the instrument's external power supply. 
160 5015321 B 



ImageXpress Micro Widefield High Content Screening System User Guide
5. Place the new objective in its protective casing on a clean work 
area surface near the front of the ImageXpress Micro 
instrument. 
While moving objectives in and out, beware of the free-moving 
stage. It slides around loosely when the instrument is powered 
off. This can be a hazard to the objective in your hand. 

6. Remove the left or right (as appropriate) side panel of the 
instrument by grasping the handle, pulling it away from the 
instrument, and supporting the back of the door with your other 
hand. 

7. Reach in and unscrew any objective you want to remove. 
To access position 2, you need to remove the objective in 
position 1. 
To access position 3, you need to remove the objective in 
position 4. 

8. Set the objective’s correction collar, if applicable. 
9. Reach in and screw in the objective. 
10. Replace the side door by aligning the tabs at the back of the 

door, and then snapping the front of the door into place. 
11. Turn ON the ImageXpress Micro instrument at the main power 

switch, which is located on the instrument's external power 
supply. 

12. Update the software to reflect the new hardware configuration. 
See Updating the System After Adding or Replacing an Objective 
on page 163.

Cleaning Objectives 
In the event that debris or contaminants have collected on an 
objective, follow these instructions for cleaning the objective lens: 

1. Read and follow the User Safety Instructions on page 153 for 
safe user-service procedures. 

2. In MetaXpress Software or the Meta Imaging Series 
Administrator Software select the desired objective.   

3. Open the top door. 
4. Exit MetaXpress Software and turn off the ImageXpress Micro 

instrument at the main power switch, which is located on the 
instrument's external power supply. 

5. To remove dust, use compressed air to blow dust contaminants 
off objectives. 

CAUTION! Do not use a product that disperses aerosol 
propellants or fluid onto the lens surface. 
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CAUTION! Do not invert the compressed air can, as that 
disperses aerosol propellants. 

6. To wipe the objective free of contaminants, use lens paper and 
solvent of choice. If unsure which solvent to use, consult the 
objective manufacturer for preferred cleansing solvent and 
procedure. 

CAUTION! Do not use Kimwipes to wipe a lens.   

Using Oil-Immersion Objectives 
Oil-immersion objectives can be used with the ImageXpress Micro 
System for research-mode imaging. Please consult with your sales 
representative for ordering information. 
To apply oil to the objective: 

1. Eject the plate to open the top door.   
2. Remove any plates in the system.   
3. Sparingly add oil to the top of the appropriate objective using a 

dropper bottle.   
4. Insert the sample, either with a thin glass coverslip or in a 

microplate with a thin glass bottom. Oil-immersion objectives 
are not compatible with plastic microplates.   

In the MetaXpress Software, slowly step up the objective until you are 
near to focus. Please note that oil-immersion objectives are not 
recommended for scanning entire microplates. 
When you are done with the oil-immersion objective, eject the plate, 
remove the sample, and clean the top of the objective with a piece of 
lens paper. 
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Updating the System After Adding or Replacing 
an Objective 

After installing a new objective, you must update the objective settings 
in both the Meta Imaging Series Administrator and the main 
MetaXpress Software program. If the objective you are replacing was 
the one used to determine the plate bottom reference point, you will 
also need to repeat the procedure Determining the Plate Bottom 
Reference Point after Changing the Reference Objective on page 167, 
or contact Molecular Devices for technical support.

Editing the Objective Settings in the Meta Imaging 
Series System Administrator
Complete the following procedure to update your objective settings and 
enter Maintenance Mode:

1. From the Windows Start menu, click AllPrograms > MetaXpress > 
Meta Imaging Series Administrator.

2. Select MetaXpress from the List of Groups field.
3. Click Configure Hardware. 
4. Click Install System Devices. 
5. Select ImageXpress Micro Objective from the Installed Devices list 

and click Settings. 

Figure 8-4 ImageXpress Objective Settings dialog
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6. If necessary, edit the text in the Objective # field for the new 
objective.

7. Change the Refractive Medium/Index value if needed.
8. Enter the numerical aperture for the new objective in the 

corresponding Num. Aperture field (the value is written on the 
objective).

9. Click OK to close the ImageXpress Micro Objective Settings dialog.
10. Select ImageXpress Micro from the Installed Devices list and click 

Settings. 
The ImageXpress Micro Settings dialog appears.

11. Ensure that the Parameter Group #1 tab is active and select the 
Maintenance Mode checkbox.

12. Click OK, and then click OK again as needed to return to the 
Configure Hardware dialog.

13. In the Configure Hardware dialog, ensure that the hardware 
settings you are using are selected in the Hardware Settings list 
and then click Configure Devices. 
The User Settings hardware configuration dialog appears.

14. Double-click ImageXpress Micro Objective in the Claimed Devices 
list. 
The ImageXpress Micro Objective dialog appears.

15. Enter the same information about the new objective that you 
entered in Step 6 and Step 8.

16. Click OK, and then click OK as needed to exit the Meta Imaging 
Series Administrator and continue to Configuring Parfocality after 
Changing Objectives on page 165. 

Note: Make a note of the values you entered in Step 6 and 
Step 8. You will need to enter this information again for your 
specific hardware settings.

Note: The next steps involve entering some of the values again, 
this time starting from the Configure Devices dialog. This is to 
ensure that the settings carry over for all hardware profiles.
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Configuring Parfocality after Changing Objectives
To configure parfocality, you must use the MetaXpress Software 
application to find valid focus values for each objective and then enter 
them into the MetaXpress Objective dialog in the Meta Imaging Series 
System Administrator. Complete the following procedure to configure 
parfocality:

1. Open the MetaXpress Software application.
2. Open the following dialogs:

Devices > Configure Magnification 
Acquire > Acquire 
Devices > Stage > Move Stage to Absolute Position 

3. If the following toolbars are not open, click Window > Toolbars 
and select the Device Control and the Plate Acquisition toolbars.

4. Click Devices > Configure Magnification.
5. If not selected, select the checkbox next to the ImageXpress 

Micro Objective.

Figure 8-5 Configure Magnification dialog

6. Select the objective with the highest numerical aperture (NA) 
that is in position #1 from the field.

7. Select the FITC (or other visible light) illumination setting from 
the Illum field on the Device Control toolbar, as shown in 
Figure 8-6.

Figure 8-6 Partial Device Control toolbar
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8. Click the Stage Load/Eject button on the Plate Acquisition toolbar 
to move the stage to the load position.

9. Load the bead plate that shipped with the instrument on to the 
stage, and then click the Stage Load/Eject button again to return 
the stage to its previous position.

10. In the Acquire dialog, click Show Live to open a live image 
window.

11. In the Move Stage to Absolute Position dialog, use the Current 
Position X, Y, and Z controls to find and focus a sample in the live 
image window.

Figure 8-7 Move Stage to Absolute Position dialog

12. When the sample is in focus, write down the Current Position Z 
value in the Focus Value column in Table 8-1.

Table8-1 Objective Focus Value

Objective Number Focus Value

1

2

3

4

166 5015321 B 



ImageXpress Micro Widefield High Content Screening System User Guide
13. Use the field in the Configure Magnification dialog to switch to the 
objective in position #2 with the next highest NA.

14. Repeat Step 9 to Step 12 for each objective, writing down the 
focus values for each in Table 8-1. You will use these values to 
determine the Z-offsets for each objective (which is different 
than configuring Z offsets for laser autofocus).

15. After you have written down the focus values, close the 
MetaXpress Software application.

16. If the objective you are changing was the one used to determine 
the plate bottom reference point, see Determining the Plate 
Bottom Reference Point after Changing the Reference Objective 
on page 167.
OR
If the objective was NOT the one used to determine the plate 
bottom reference point, see Entering the Plate Bottom 
Reference Objective Value in the MetaXpress.ref Configuration 
File on page 173.

Determining the Plate Bottom Reference Point 
after Changing the Reference Objective
The plate bottom reference point is a setting that the MetaXpress 
Software application uses for autofocusing. It is set when your system 
is configured before shipment. The reference point is determined using 
a particular objective (usually 10x) in a specific objective position. If 
you change this objective, you must determine the new plate bottom 
reference point and enter this value in the Meta Imaging Series 
Administrator.

Note: You will need to refer to these values later in subsequent 
procedures.

Note: It is important that you use the same filter set for all 
objectives.

Note: Since you found the X and Y coordinates of the sample in 
Step 11, you need to change only the Z position for each 
additional objective.
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The objective position used for this setup is specified in a line of the 
system calibration file MetaXpress.ref, located in the Hardware folder of 
your root install directory (C:\MX5\Hardware by default). The line is:

PlateBottomReferenceObjective=X
where X is the position of the objective used. If you need to update the 
plate bottom reference point, the value in the calibration file must also 
be updated. 
Complete the following procedure to determine both the plate bottom 
reference objective and the plate bottom reference point. 

1. Enter Maintenance mode. For information on how to enter 
Maintenance mode, see Editing the Objective Settings in the 
Meta Imaging Series System Administrator on page 163.

2. Remove any plates from the stage, and load one of the flat-field 
correction (FFC) plates that shipped with your system.

3. Click Device > Configure Magnification. 

Note: Molecular Devices recommends that you leave the reference 
objective in place and only replace other objectives.

Note: Molecular Devices recommends that you contact Technical 
Support before attempting this procedure.

Note: You do NOT need to perform this procedure unless you replaced 
the reference objective. If you did not replace the reference objective, 
see Editing the Objective Settings in the Meta Imaging Series System 
Administrator on page 163.
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The Configure Magnification dialog appears.

Figure 8-8 Configure Magnification dialog with objective # 
highlighted 

4. Select the objective you want to use as the reference from the 
field, and write down the plate bottom reference objective 
number (highlighted in Figure 8-8) in Table 8-2.

5. Close the Configure Magnification dialog. If a dialog appears 
prompting you to replace the stored setting, click No.

6. Open the following dialogs if they are not already open:
Devices > Stage > Move Stage to Absolute Position 
Devices > Focus 

7. In the Move Stage to Absolute Position dialog, type 8000 in the 
Current Position: Z field and press Enter to move the Z-motor.

8. Type 64000 in the Current Position: X field and 33000 in the 
Current Position: Y field and press Enter to move to the 
approximate center of the plate.

9. In the Focus dialog, select the Autofocus tab, and then click 
Configure Laser.

Table8-2 Plate Bottom Reference Objective

Plate Bottom Reference Objective

Note: You will refer to this value in Entering the Plate Bottom 
Reference Objective Value in the MetaXpress.ref Configuration 
File on page 173.
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The Configure Laser Autofocus dialog appears.

Figure 8-9 Configure Laser Autofocus dialog

10. Select Start from current z-position.
11. Set the Full range value to 1000 microns (µm).
12. Set the Exposure 1st surface value to 10 microseconds (µs).
13. Set the Coarse step value to 10 microns (µm).
14. On the Autofocus tab of the Focus dialog, click Preview Pass. 

A window opens displaying a graph of focus intensities vs. 
Z-position. Ideally, the graph should contain a sharp peak, made 
up of a red line and a green line, as shown in Figure 8-10.
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Figure 8-10 Preview Pass dialog

15. If there is a peak in the graph, go to Step 16. If there is no 
peak, try the following:

In the Focus dialog, increase the Current Position value by 
1000 and click Preview Pass. Repeat as needed until you 
cover a range between 8000 and 12000. If there is a peak in 
the graph, go to Step 16. If there is no peak, continue to the 
next step.
Try moving to a new area of the FCC plate and repeat 
Step 14. If you still cannot find a peak after moving to a new 
area of the FCC plate twice and covering a z-range from 
8000 to 12000, contact Technical Support.

Note: The top of the red peak represents the brightest pixel of 
the preview pass. The top of the green peak represents the 
highest focus score.
5015321 B 171 



Maintaining the ImageXpress Micro Instrument
16. When you see a peak (or 2 peaks) on the preview pass, click the 
trace line at the top of the green line of the first peak. 
The X, Y position is displayed as a tool tip as shown in 
Figure 8-11. This gives the Z-position of the plate bottom. In 
this example, the current Z-position value is 9172.8.

Figure 8-11 Z-position of peak

17. Write down the Z-position value for the center position in 
Figure 8-3. 

Table8-3 Plate Bottom Reference Point

Position X Value Y Value Z Value

1 Center 64000 33000

2 Upper Left 150000 11000

3 Lower Left 150000 74000

4 Upper Right 114000 11000

5 Lower Right 114000 74000
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18. Repeat Step 7 through Step 17 for each corner of the FCC plate. 
Enter the X and Y values in Figure 8-3 into the Move Stage to 
Absolute Position dialog. Write down the Z-position values 
(rounded off) for each corner in the Z Value column of 
Table 8-3.

19. Circle the lowest Z value in Figure 8-3. 
This value is the Plate Bottom Reference Point. You will refer to 
this value in Entering the Focus Objective Values in the Meta 
Imaging Series Administrator on page 174.

20. Exit the MetaXpress Software application and continue to 
Entering the Plate Bottom Reference Objective Value in the 
MetaXpress.ref Configuration File on page 173.

Entering the Plate Bottom Reference Objective Value 
in the MetaXpress.ref Configuration File
Complete the following procedure to enter the value in the 
MetaXpress.ref configuration file:

1. Click Start > AllPrograms > Accessories > Notepad and then open 
the MetaXpress.ref file in the MetaXpress Hardware folder 
(C:\MX5\Hardware by default).

2. Edit the following line in the file, replacing the number with the 
objective position you entered in Table 8-2.

[system calibration]
PlateBottomReferenceObjective=4

3. Save the modified file and close Notepad.

Note: Only perform this procedure if you needed to complete 
Determining the Plate Bottom Reference Point after Changing the 
Reference Objective on page 167.

Note: Make sure that the copy of the MetaXpress.ref that you 
open is located in the Hardware folder of the MetaXpress folder 
(For example, C:\MX5\Hardware) and NOT in the root directory.

Note: Do NOT use the Save As option in Notepad, as this causes 
a .txt extension to be added to the saved .ref file.
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Entering the Focus Objective Values in the 
Meta Imaging Series Administrator
The next step is to open the Meta Imaging Series Administrator and 
enter the values you recorded in the previous procedures. You also 
need to turn off Maintenance mode before you can continue to 
configure the device. Complete the following procedure to turn off 
Maintenance mode and enter the values in the Meta Imaging Series 
Administrator.

1. Start the Meta Imaging Series System Administrator.
2. Click Configure Hardware, and then click Install System Devices. 
3. Double-click ImageXpress Micro in the Installed Devices list. 
4. Clear Maintenance Mode.
5. Click OK to exit the ImageXpress Micro dialog
6. Double-click ImageXpress Micro Objective in the Installed Devices 

list. 

Figure 8-12 ImageXpress Objective Settings dialog
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7. Type the focus value for Objective #1 from Table 8-1 into the 
Position #1 Z Offset field.

8. Repeat Step 7 for Position #2 to 4 Z Offset fields.

9. Click Normalize Offsets to calculate the offsets for each Z 
position.

10. Click OK to exit the ImageXpress Micro Objective dialog.
11. If you needed to complete the Determining the Plate Bottom 

Reference Point after Changing the Reference Objective on 
page 167, continue to Step 12.
OR
If you did not change or replace the reference objective, go to 
Step 15.

12. Double-click ImageXpress Micro Z in the Installed Devices list. 
The ImageXpress Micro Z dialog appears.

13. Type the value you circled in Step 19 of the Determining the 
Plate Bottom Reference Point after Changing the Reference 
Objective on page 167 into the Plate Bottom Reference field.

14. Click OK to exit the ImageXpress Micro Z Settings dialog, and then 
click OK to return to the Configure Hardware dialog.

Note: The Position 1-4 Z Offsets refer to Objective numbers 1-4 
and are not in order of magnification. Refer to the Objective 
Labels fields to match the objective number with its 
magnification.

Note: In some cases, there might not be an objective in each 
position of the turret. If this is the case, enter the focus value 
for the highest magnification objective that you do have in each 
of the empty Position 1-4 Z Offset fields. Do not leave any of 
these values as 0.

Note: The next steps involve entering some of the values again, 
this time starting from the Configure Devices dialog. This is to 
ensure that the settings carry over for all your hardware 
profiles.
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15. From the Configure Hardware dialog, ensure that the hardware 
settings you are using are selected in the Hardware Settings list 
and then click Configure Devices. 
The User Settings hardware configuration dialog appears.

16. Double-click ImageXpress Micro Objective in the Claimed Devices 
list. 
The ImageXpress Micro Objective dialog appears.

17. Edit the Objective Labels, Refraction Medium/Index, and Num. 
Aperture fields with the same values you entered in Step 6 to 
Step 8 of Editing the Objective Settings in the Meta Imaging 
Series System Administrator on page 163.

18. Repeat Step 7 through Step 9 to enter and normalize the Z 
offsets.

19. If you needed to complete the Determining the Plate Bottom 
Reference Point after Changing the Reference Objective on 
page 167, double-click ImageXpress Micro Z in the Claimed 
Devices list and enter the Plate Bottom Reference number as in 
Step 13.

20. Click OK to exit each dialog and close the Meta Imaging Series 
System Administrator.

Updating Magnification and Calibration Settings
Complete the following procedure to update magnification and 
calibration settings within the MetaXpress Software application:

1. Open the MetaXpress Software application and log into the 
database.

2. Click Devices > Configure Magnification. 
The Configure Magnification dialog appears.

3. Ensure that ImageXpress Micro Objective is selected in the 
Settings field and select the installed objective from the field.

4. Enter the name of the new objective in the Name field.
5. Click Add/Replace to add this setting to the Defined Settings list.
6. If you replaced an objective with an existing setting, select the 

old setting from the Defined Settings field and click Remove.
7. After the settings are updated, click Backup.

Note: If you use more than one hardware profile, repeat 
Step 15 to Step 18 as needed for each hardware profile.
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8. Click Close to exit the Configure Magnification dialog.
9. Click Measure > Calibrate Distances. 

The Calibrate Distances dialog appears.
10. Click the Setup tab.
11. Click New, and type the name of your new objective in the 

Calibrations field. Press Enter. 
The fields in the lower half of the dialog become active.

12. Select Edit Units/Pix in the Define Calibrations By field.
13. Enter the calibration value for the new objective in the X and Y 

fields. The following estimated values can be used for 
ImageXpress Micro System calibration settings:

14. Select the new objective from the Magnification field.
15. Click Done.
16. After the settings are updated, click Save to file.
17. Click Close.

Table8-4 Estimated Calibration Settings

Objective Estimated Calibration

1x 6.50 µm/pixel

2x 3.25 µm/pixel

4x 1.63 µm/pixel

10x 0.65 µm/pixel

20x 0.33 µm/pixel

40x 0.16 µm/pixel

60x 0.12 µm/pixel

100x 0.07 µm/pixel

Note: For additional information on creating calibrations 
settings, refer to the application help available within the 
MetaXpress Software (press F1 when the Calibrate Distances 
dialog is open to access help). 
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Updating Shading Correction Settings 
This section explains how to run a journal to create shading correction 
files to use during plate acquisition in the MetaXpress Software 
application. Shading correction files are needed for each objective/filter 
combination and must be generated whenever an objective or filter is 
replaced or added to the system, or whenever the lamp or liquid light 
guide is replaced. You will need a flat-field correction (FFC) plate to 
focus the objective. 

This procedure assumes that if you have added or replaced an 
objective, you have already performed the following procedures.

• Editing the Objective Settings in the Meta Imaging Series 
System Administrator on page 163.

• Configuring Parfocality after Changing Objectives on page 165.
• Updating Magnification and Calibration Settings on page 176.

Note: The taskbar used for this procedure is the System Maintenance 
Taskbar.JTB which is part of the Main Taskbar.JTB. To determine if this is 
installed on your system, select Journal > Taskbar > Load taskbar, 
navigate to C:\MX5\Taskbars (or the directory where the current 
version of the software is installed) and then select the System 
Maintenance Taskbar.JTB file. If this taskbar is not installed on your 
system, contact Technical Support to obtain the journal suite file 
IXMTaskbar_v#.jzp. Once you have obtained the journal file, 
import it using the procedure in To import the journal suite into 
the MetaXpress Software on page 179.

Note: For shading correction images to be used during Plate 
Acquisition, the Perform shading correction checkbox must be 
selected in the Acquisition Loop tab of the Plate Acquisition 
Setup dialog.
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This section includes the topics:
• To import the journal suite into the MetaXpress Software on 

page 179
• To run the shading correction journal from the Main taskbar on 

page 181
You will need FFC plates appropriate for the filter sets you are using to 
generate the shading correction files. These plates are part of the 
accessory kit that shipped with the instrument. Remove the paper 
backing from each plate before use. Handle the plates by the edges to 
avoid getting fingerprints on the imaging surface. Never use alcohol or 
other solvents to clean the plates. You can use compressed air to 
remove dust from the plates. Table 8-5 lists the correction plate used 
for each filter set.

To import the journal suite into the MetaXpress Software 

Follow this procedure if the Main taskbar is not installed on your 
system. If the Main taskbar is installed, skip this section and proceed to 
To run the shading correction journal from the Main taskbar on 
page 181.
This procedure is easier to perform prior to creating additional groups 
(configurations) in the Meta Imaging Series Administrator. Once you 
have followed this procedure, you can then create additional groups by 
using the option to copy settings from an existing group.

1. Contact Technical Support to obtain the Journal Suite file, 
IXMTaskbar_v#.jzp (# is the current version of the software). 

2. Download the IXMTaskbar_v#.jzp file to the ImageXpress Micro 
System workstation.

Table8-5 Flat-field Correction Plates for each Filter Set

FFC Plate Filter Set

DAPI Pink

Fura-2 Pink

CFP Pink

YFP Red

FITC Red

Cy3 Green

Rhodamine Red

Texas Red Red

Cy5 Red
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3. Start and log in to the MetaXpress Software.
4. Click Journal > Import Journal Suite. 

The Import Journal Suite dialog appears.
5. Click Select Journal Suite. 

The Select Import Suite File Name dialog appears.
6. Navigate to the IXMTaskbar_v#.jzp file and click Open. 

The path to the journal suite is displayed at the top of the 
Import Journal Suite dialog.

7. Click Select Import Location, and navigate to 
C:\MX5\TASKBARS and click OK. 
The path of the import location is displayed at the bottom of the 
Import Journal Suite dialog.

Figure 8-13 Import Journal Suite dialog

8. Click Import. 

9. Click Close.
10. Click Journal > Run Journal.
11. Navigate to C:\MX5\TASKBARS\Install, select the IXM 

Taskbar Installer.JNL file, and click Open.
12. In the Select System Type dialog, select either IXM 

(Standard) or IXM-XL.
The MetaXpress Directory dialog appears.

Note: There is no visual confirmation that the import is 
complete.
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13. Follow the prompts in the subsequent dialogs to confirm that the 
current version of the MetaXpress Software is installed in the 
correct directory (typically C:\MX5).

14. In the Taskbar Installation Final Steps dialog, click 
Continue.

15. Click Journal > Journal Control > StartUp Journal.
16. Navigate to C:\MX5\StartUp, select the startup journal (the 

name of the journal includes the appropriate ImageXpress Micro 
System model: Standard or XL), and click OK.

17. Exit and restart the MetaXpress Software.
18. Click Journal > Recording Tools and confirm that the Pick 

Point option is listed (it may be grayed out but it must be listed; 
if it is not listed, contact Technical Support for assistance).

19. Proceed to the next section to run the shading correction journal 
from the Main taskbar.

To run the shading correction journal from the Main 
taskbar

1. On the Main taskbar, select System Maintenance and then 
click Set up Shading Correction.

2. Follow the prompts to focus on the plates and create shading 
correction files.

Note: If the default file paths for journals, images, data, and so 
on do not go to the C:\MX5 folder, you will be prompted to reset 
them to go to that folder.

Note: Press <F4> on your keyboard to show or hide the taskbar 
that was most recently used.
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Adjusting the Spherical-Aberration Correction Collar 
on ELWD Objectives

The ELWD (extra long working distance) Nikon objectives that can be 
supplied with the ImageXpress Micro System have adjustable 
correction collars, used to minimize spherical aberration in the image of 
the specimen. The collars have a range of 0-2 mm correction, and 
changing this setting adjusts the distances between components inside 
the objective barrel. Image quality and resolution is largely dependent 
on properly setting these collars.   
The settings to be used depend on the thickness of the microplate well 
or slide on which the specimen is mounted. In general, the correction 
collar should be set for the physical thickness of the plate or slide that 
you are imaging. The physical thickness can be determined by: 

• Obtaining the plate specifications from the plate manufacturer. 
• Smashing a spare plate and using calipers to measure the 

thickness. 
• Measuring the optical thickness with the laser autofocus and 

multiplying it by the refractive index (1.59 for polystyrene; 1.52 
for glass).   

After you have determined the thickness of your plate or slide, follow 
these steps to adjust a given correction collar:    

1. Read and follow the User Safety Instructions on page 153 for 
safe user-service procedures. 

2. Follow the steps in Changing Objectives on page 160 for 
accessing the objective selector and lenses. If you put these 
objectives in the outer two positions, they can be accessed from 
the two side doors, which can be removed by hand. 

3. Locate the correction collar on the objective that you want to 
adjust.

4. Rotate the correction collar to its new setting. 
5. Securely close the access doors. 
6. Test the correction collar setting by examining the image quality 

of acquired images. If the quality has degraded, re-adjust the 
correction collar. 

Note: The graduated scale on the barrel and its current setting. 
You might have to use a flashlight to view the markings. 
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Cleaning the ImageXpress Micro System

The following procedure is designed to clean the plate-loading region of 
the instrument without damaging the internal components of the 
imaging system. 
To prevent damaging the instrument, please read and follow these 
precautionary guidelines carefully when cleaning your instrument:

• To protect the ImageXpress Micro System optics and electronics, 
do not remove the front panels of instrument during the 
cleaning procedure. 

• Do not use any cleaning agents other than those recommended 
in this procedure without first contacting Molecular Devices 
Technical Support. 

• Do not use ultraviolet light for sterilization, as this can damage 
plastic components. 

• Do not use any organic solvents. 
• Do not pour or squirt water or alcohol directly onto the 

instrument, to prevent damaging internal components. 
The following cleaning procedure is compatible with disinfectant wipes 
(or Kimwipes wipers with 70% ethanol).
You can leave the lamp powered on during this procedure. 

To clean the ImageXpress Micro instrument 

1. Read and follow the User Safety Instructions on page 153 for 
safe user-service procedures. 

2. In MetaXpress Software, open the instrument’s door. 
3. Exit the MetaXpress Software and turn off the ImageXpress 

Micro instrument at the main power switch, which is located on 
the instrument’s external power supply. 

4. Ensure that the side panels have not been removed, the filter 
cube access door is closed, and no sample is loaded. 

5. With gloved hands, use a damp wipe to wipe down the entire 
outer surface including side panels and top panels of the 
instrument. Then, use an alcohol wipe or a disinfectant wipe and 
go over the entire surface again. 

6. Use forceps wrapped with Kimwipes to gently wipe the 
perimeter of the plate/stage region where a plate would 
normally be loaded. Wipe with damp Kimwipes first, and then 
with an alcohol or disinfectant wipe. 

Note: This procedure does not guarantee that your instrument is 
decontaminated or sterile.
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7. The stage is freely moving without power, so to clean the 
plate/stage region underneath where the plate is loaded, you 
can open the door and slide the stage around.

8. Use a fresh damp wipe to wipe down the stage area underneath 
and around the plate loading region, followed by wiping with an 
alcohol wipe or disinfectant wipe. 
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Operational and Environmental 
Specifications
Operational and environmental specifications are shown in Table A-1.

TableA-1 Operational and Environmental Specifications

Specification Measurement

Base Unit Weight 82 kg

Base Unit Dimensions 
(H x W x D)

490 mm x 460 mm x 800.5 mm

Mains Power Input 100 to 240 VAC, 50/60 Hz, 400 VA, 
2.0 A maximum

Options Controller 100 to 240 VAC, 50/60 Hz, 960 VA, 8 A

Camera Power Supply Standard: 100 to 240 VAC, 50/60 Hz, 240 VA, 
2.0 A
XL: 100 to 240 VAC, 50/60 Hz, 120 VA, 1.0 A

Light Source Power Supply Standard: 100 to 240 VAC, 50/60 Hz, 360 VA, 
300 W
XL: 100 to 240 VAC, 50/60 Hz, 288 VA, 2.5 A

Host Computer 100 to 240 VAC, 50/60 Hz, 690 VA, 5.8 A

Computer Monitor 100 to 240 VAC, 50/60 Hz, 35 W

Mains Voltage Fluctuations Not to exceed 10% of nominal supply voltage

Equipment Class 1

Pollution Degree 2

Installation Category 2

Operating Environment Indoor Use Only

Altitude Not to exceed 2000 m

Operating temperature 15°C to 30°C

Humidity 35% to 50% non-condensing

Ingress Protection IP20

WARNING! If the ImageXpress Micro System is used in a 
manner not specified by Molecular Devices, the protection 
provided by the equipment might be impaired.
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WARNING! The ImageXpress Micro System is an Equipment 
Class 1 product that relies on protective earth grounding for 
safe operation. Any interruption of the protective earth ground 
conductor, inside or outside the instrument, or disconnection 
of the protective earth ground terminal can result in personal 
injury.

WARNING! Do not position the equipment so that it is difficult 
to operate the circuit breaker switches on the front of the 
equipment.

WARNING! For Environmental Control Options a tank or house 
CO2/air mixture (for example, 5% CO2/95% air) is required 
with an adequate CO2 regulator that can supply a maximum of 
20 PSI (138 kilopascal) to the CO2 inlet on the rear of the 
Options Controller. 
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B
Site Requirements
The ImageXpress® Micro System is designed to operate indoors under 
laboratory conditions. For optimal performance, site requirements must 
be met. As with any precision optical instrument, care should be taken 
to maintain a low-dust, low-vibration environment. Temperature and 
humidity extremes can compromise performance. 
TableB-1 Site Requirements

Item Description

Environmental Temperature 50° to 86° F (10° to 30° C). 

Environmental Humidity 5% to 95% non-condensing. 

Altitude Up to 1.25 miles (2000 m). 

Power Requirements The ImageXpress Micro System can be directly 
connected to all international supply voltages. 
The input voltage range is from 100 to 240 V~ 
and input frequency range 50 to 60 Hz. No 
range switching is required. Fluctuations must 
not exceed ±10% of the nominal voltage. Use 
the included IEC power cord to connect the 
external power supply to a GROUNDED power 
receptacle that is rated for 15 A. If using a 
power strip, do not connect the acquisition 
computer to the same power strip as the 
instrument and light source. 

Power Consumption ImageXpress Micro System power 
consumption is 1100 watts for 2 to 3 seconds 
at initialization, 800 watts average operating 
RMS. 

Space Requirements Table or bench top 30 inches (76 cm) deep. 
There needs to be space below the table for 
the light source and power supply such that 
the light guide and power cable can easily 
reach the back of the instrument. 

Rear Clearance The rear of the instrument should be no closer 
than 6 inches (15 cm) to a wall. 

Weight Requirements Sufficient to support 180 lbs (82 kg) with 
minimal vibration. 
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C
Objectives Compatible with the 
ImageXpress Micro System
Table C-1 details the Nikon objectives that are compatible with the 
ImageXpress® Micro System. It also provides plate compatibility 
information.

TableC-1 Nikon Objectives Compatible with the ImageXpress Micro System

Objective 
Magnification 
and Type

Molecular 
Devices 
Part 
Number

Phase 
Contrast

Numerical 
Aperture

Working 
Distance Plate Compatibility

1x 
Plan Achromat

6500-0119 No 0.04 3.2 mm Thin bottom (0.17 mm)1 
Thin bottom (0.17 mm) 
No Skirt
Thick bottom (0.25 mm 
to 1 mm)1 

2x 
Plan Apo

1-6300-0451 No .010 8.5 mm Thin bottom (0.17 mm)
Thin bottom (0.17 mm) 
No Skirt
Thick bottom (0.25 mm 
to 1 mm)

4x 
S Fluor

1-6300-0189 No .020 15.5 mm Thin bottom (0.17 mm)
Thin bottom (0.17 mm) 
No Skirt
Thick bottom (0.25 mm 
to 1 mm)

4x 
Plan Apo

1-6300-0121 No .020 15.7 mm Thin bottom (0.17 mm)
Thin bottom (0.17 mm) 
No Skirt
Thick bottom (0.25 mm 
to 1 mm)

4x 
Plan Fluor DL

1-6300-0292 Yes, PhL .013 16.2 mm Thin bottom (0.17 mm)
Thin bottom (0.17 mm) 
No Skirt
Thick bottom (0.25 mm 
to 1 mm)

10x 
Plan Fluor

1-6300-0790 No .030 16.0 mm Thin bottom (0.17 mm)
Thin bottom (0.17 mm) 
No Skirt
Thick bottom (0.25 mm 
to 1 mm)
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10x 
S Fluor

1-6300-0122 No .050 1.2 mm Thin bottom (0.17 mm)
Thin bottom (0.17 mm) 
No Skirt
Thick bottom (0.25 mm 
to 1 mm)2 

10x 
Plan Apo

6500-0120 No 0.45 4.0 mm Thin bottom (0.17 mm)1 
Thin bottom (0.17 mm) 
No Skirt
Thick bottom (0.25 mm 
to 1 mm)

10x 
Plan Fluor DLL

1-6300-0294 Yes, Ph1 0.30 16.0 mm Thin bottom (0.17 mm)
Thin bottom (0.17 mm) 
No Skirt
Thick bottom (0.25 mm 
to 1 mm)

10x 
Plan Fluor DL

1-6300-0293 Yes, Ph1 0.30 15.2 mm Thin bottom (0.17 mm)
Thin bottom (0.17 mm) 
No Skirt
Thick bottom (0.25 mm 
to 1 mm)

20x 
Super Plan Fluor 
ELWD cc 0 mm 
to 2 mm

6500-0108 No 0.45 8.1 mm to 
7.0 mm

Thin bottom (0.17 mm)3 
Thin bottom (0.17 mm) 
No Skirt3 
Thick bottom (0.25 mm 
to 1 mm)

20x 
S Fluor

1-6300-0411 No 0.75 1.0 mm Thin bottom (0.17 mm)1 
Thin bottom (0.17 mm) 
No Skirt

20x 
Plan Apo

1-6300-0196 No 0.75 1.0 mm Thin bottom (0.17 mm)1 
Thin bottom (0.17 mm) 
No Skirt

20x 
Plan Fluor DLL

1-6300-0295 Yes, Ph1 0.50 2.1 mm Thin bottom (0.17 mm) 
Thin bottom (0.17 mm) 
No Skirt 
Thick bottom (0.25 mm 
to 1 mm)2 

TableC-1 Nikon Objectives Compatible with the ImageXpress Micro System (cont’d)

Objective 
Magnification 
and Type

Molecular 
Devices 
Part 
Number

Phase 
Contrast

Numerical 
Aperture

Working 
Distance Plate Compatibility
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20x 
Super Plan Fluor 
ELWD DM cc 
0 mm to 2 mm

6500-0111 Yes, Ph1 0.45 8.1 mm to 
7.0 mm

Thin bottom (0.17 mm)3 
Thin bottom (0.17 mm) 
No Skirt3 
Thick bottom (0.25 mm 
to 1 mm)

40x 
Super Plan Fluor 
ELWD cc 0 mm 
to 2 mm

6500-0109 No 0.60 3.7 mm to 
2.7 mm

Thin bottom (0.17 mm)3 
Thin bottom (0.17 mm) 
No Skirt3 
Thick bottom (0.25 mm 
to 1 mm)

40x 
Plan Apo

1-6300-0412 No 0.95 0.14 mm Thin bottom (0.17 mm)1 
Thin bottom (0.17 mm) 
No Skirt

40x 
S Fluor cc 
0.11 mm to 
0.23 mm

1-6300-0197 No 0.90 0.3 mm Thin bottom (0.17 mm)1 
Thin bottom (0.17 mm) 
No Skirt

40x 
Plan Fluor Oil

1-6300-0416 No 1.30 0.2 mm Thin bottom (0.17 mm)1 
Thin bottom (0.17 mm) 
No Skirt

40x 
Plan Fluor DLL

1-6300-0297 Yes, Ph2 0.75 0.72 mm Thin bottom (0.17 mm)1 
Thin bottom (0.17 mm) 
No Skirt

40x 
Super Plan Fluor 
ELWD ADM cc 
0 mm to 2 mm

6500-0112 Yes, Ph2 0.60 3.7 mm to 
2.7 mm

Thin bottom (0.17 mm)3 
Thin bottom (0.17 mm) 
No Skirt3 
Thick bottom (0.25 mm 
to 1 mm)

60x 
Super Plan Fluor 
ELWD cc 0.1 mm 
to 1.3 mm

6500-0110 No 0.70 1.8 mm to 
2.62 mm

Thin bottom (0.17 mm)3 
Thin bottom (0.17 mm) 
No Skirt3 
Thick bottom (0.25 mm 
to 1 mm)

60x 
Plan Fluor

1-6300-0414 No 0.85 0.3 mm Thin bottom (0.17 mm)1 
Thin bottom (0.17 mm) 
No Skirt

60x 
Plan Apo Oil

1-6300-0417 No 1.40 0.21 mm Thin bottom (0.17 mm)1 
Thin bottom (0.17 mm) 
No Skirt

TableC-1 Nikon Objectives Compatible with the ImageXpress Micro System (cont’d)

Objective 
Magnification 
and Type

Molecular 
Devices 
Part 
Number

Phase 
Contrast

Numerical 
Aperture

Working 
Distance Plate Compatibility
5015321 B 191 



Objectives Compatible with the ImageXpress Micro System
1 Potential interference with microplate skirt when imaging edge wells.
2 Image degradation above microplate thickness 0.3 mm.
3 20x and 40x ELWD will image through cover slips, but other objectives will give 

better resolution and shorter exposures.

60x 
Plan Fluor ELWD 
ADL cc 0.1 mm 
to 1.3 mm

6500-0113 Yes, Ph2 0.70 1.8 mm to 
5.62 mm

Thin bottom (0.17 mm)3 
Thin bottom (0.17 mm) 
No Skirt3 
Thick bottom (0.25 mm 
to 1 mm)

100x 
Plan Fluor

1-6300-0415 No 0.95 0.2 mm Thin bottom (0.17 mm)1 
Thin bottom (0.17 mm) 
No Skirt

100x 
Plan Fluor Oil

1-6300-0418 No 1.30 0.2 mm Thin bottom (0.17 mm)1 
Thin bottom (0.17 mm) 
No Skirt

TableC-1 Nikon Objectives Compatible with the ImageXpress Micro System (cont’d)

Objective 
Magnification 
and Type

Molecular 
Devices 
Part 
Number

Phase 
Contrast

Numerical 
Aperture

Working 
Distance Plate Compatibility

Note: When used with thin-bottom plates, the short working distance 
of 20X S Fluor, 20X Plan Apo, 40X S Fluor, 40X Plan Apo, 40X Plan 
Fluor Oil, 60X Plan Fluor, 60X Plan Apo, 100X Plan Fluor, and 100X Plan 
Apo objectives can cause interference with microplate skirt when 
imaging edge wells. Molecular Devices recommends to either omit the 
edge wells or use a plate with a low skirt.
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D
Filter Set/FFC Plate Combinations
TableD-1 Recommended Filter set/FFC plate combinations

Filter Set FFC Plate

DAPI Pink

FITC Red

TRITC Red

Cy3 Green

Cy5 Red

CFP Pink

YFP Red

Texas Red Red

GFP Red

Fura-2 340x (must be installed 
adjacent to Fura-2 387x)

Pink

Fura-2 387x (must be installed 
adjacent to Fura-2 340x)

Pink
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E
File Privileges for the MetaXpress 
Software Application
This appendix describes which directories must be accessible to 
MetaXpress® Software administrators and users.

Software Administrator
Read/write access is required for everything under the C:\MX5 tree. 
The Software Administrator also needs to create and periodically 
modify shading correction images on the C:\Shading Images directory. 
Because this is a possible security violation, this operation can be 
accomplished by the System Administrator so that the Software 
Administrator is not given write access to the root directory.

Note: The following assumes that the MetaXpress Software application 
has been installed in C:\MX5 (the default location).

Note: There are no restrictions as to where the software is installed. 
There is nothing that prevents you from installing the software to the 
path: C:\Program Files\MX5.
5015321 B 195 



File Privileges for the MetaXpress Software Application
Standard Users

Read Only access needed:

C:\MX5
C:\MX5\app\mmproc
C:\MX5\app\mmproc\Dropins
C:\MX5\Help\C:\MX\Help\ - all subdirectories - 
C:\MX5\Groups\

If the system is set up for multiple users:
C:\MX5\Groups\MetaXpress
C:\MX5\Groups\MetaXpress\Users

If the system is an acquisition computer:
C:\MX5\Hardware\
C:\MX5\Hardware\ - all subdirectories -
C:\MX5\Plates\
C:\MX5\Vinput\ - all subdirectories -

Read/Write and Modify Access needed:

C:\Analysis
C:\Assay
C:\Backup
C:\Shading

If the system is set up for a single user:
C:\MX5\Groups\MetaXpress

If the system is set up for multiple users:
C:\MX5\Groups\MetaXpress\Users\Individual user
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F
Robotic Plate Handling
If your ImageXpress® Micro System has a robotic plate handler 
integrated with the base imaging system, there are additional hardware 
and user procedures to become familiar with. The robotic plate handler 
is integrated with the ImageXpress Micro System in such a way that 
plates can be scanned for barcodes, loaded onto the imaging system 
where images are acquired, and then returned to a home location.
If you want to upgrade your system with a robotic plate handler, 
contact Molecular Devices sales support. 
A robotic plate handler is easily integrated with the ImageXpress Micro 
Imaging System. The Robot step-by-step protocol is as follows:

1. Fetch a microplate from a hotel shelf. 
2. Scan the microplate barcode. 
3. Load the microplate onto the ImageXpress Micro System. 
4. Acquire images.
5. Unload the microplate from the ImageXpress Micro System. 
6. Return the microplate to the original hotel shelf. 

Verifying External Control Settings
If you have a robot attached to the ImageXpress Micro System, you 
need to confirm that the External Control settings in the Meta Imaging 
Series Administrator are enabled and that the correct COM port is 
selected. Use the following procedure to confirm that the External 
Control settings in the Meta Imaging Series Administrator are enabled:

1. From the Windows Start menu, click AllPrograms > MetaXpress > 
Meta Imaging Series Administrator.

2. In the Meta Imaging Series Administrator, select MetaXpress from 
the List of Groups field.

3. Click Configure Hardware.
4. In the Configure Hardware dialog, click Install System Devices. 
5. In the Install Systems Devices dialog, ensure that External Control 

is listed in the Installed Devices list. If it is not, select it from the 
Available Hardware list and click Install>>.

6. Select External Control from the Installed Devices list and click 
Settings.

7. In the External Control Settings dialog, click the Connections 
Settings tab.
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Robotic Plate Handling
CRS Catalyst Express Robot User Procedures 

Loading Plates onto the CRS Catalyst Express Robot 
In order to use the CRS Catalyst Express robot to scan barcodes and to 
load and unload plates onto the ImageXpress Micro instrument, you 
must properly load your plates onto the hotels of the robotic plate 
handler. If the plates are not loaded in the correct orientation, two 
errors will occur: 

• The barcode will not be scanned. 
• Well position A1 will not be correctly located in the front-left 

corner of the plate-loading region on the ImageXpress Micro 
instrument.   

The following steps will prevent these errors: 
1. If you plan to scan barcodes, properly affix the barcode labels 

before loading plates onto the robotic plate handler. We 
recommend that labels are located on the front left side of the 
plate and they must be consistently located in the same position 
on all plates being scanned. For example: 

Figure F-1 Boxed region shows barcode affixed on front of 
microplate 

Note: We suggest using labels with a minimum line width of no 
less than 7.5 mm, preferably 10 mm. For recommendations on 
compatible barcode vendors, please contact Molecular Devices 
Technical Support.
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2. The CRS Catalyst Express has three vertical racks (“hotels”) 
onto which you can load microplates. The directions that follow 
assume you are positioned in front of the robot as pictured 
immediately below. The hotel numbers (1 to 3) are at the front 
of the robot. 

Figure F-2 Numbers mark the three hotel racks where 
microplates are loaded 

3. Plates need to be loaded into the hotels with the barcodes facing 
the front of the robot. 

Figure F-3 Box shows barcode centrally located on the 
microplate, which should be facing toward the front of the hotel 

4. When correctly placed in the hotels, well position A1 is located in 
the front left corner as viewed from the front of the robot. 
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Robotic Plate Handling
5. If your plates are loaded with the barcode facing front and A1 in 
the front left location, then your plates will be scanned and 
correctly loaded onto the ImageXpress Micro System plate-
loading region. 
200 5015321 B 



G
Electromagnetic Compatibility (EMC)
REGULATORY INFORMATION FOR CANADA 
(ICES/NMB-001:2006)

This ISM device complies with Canadian ICES-001.
Cet appareil ISM est confomre à la norme NMB-001 du Canada.

ISM EQUIPMENT CLASSIFICATION (Group 1, Class A) 
This equipment is designated as scientific equipment for laboratory use 
that intentionally generate and/or use conductively coupled radio-
frequency energy for internal functioning, and are suitable for use in all 
establishments, other than domestic and those directly connected to a 
low voltage power supply network which supply buildings used for 
domestic purposes.

INFORMATION FOR THE USER (FCC NOTICE)
This equipment has been tested and found to comply with the limits for 
non-consumer ISM equipment, pursuant to part 18 of the FCC Rules. 
These limits are designed to provide reasonable protection against 
harmful interference in a non-residential installation. This equipment 
generates, uses, and can radiate radio frequency energy and if not 
installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If 
this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from 

that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for 

help.
In order to maintain compliance with FCC regulations, shielded cables 
must be used with this equipment. Operation with non-approved 
equipment or unshielded cables is likely to result in interference to 
radio and TV reception. The user is cautioned that changes and 
modifications made to the equipment without the approval of the 
manufacturer could void the user's authority to operate this equipment.
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Acquisition Loop tab 93
adjusting

correction collars 182
altitude, site requirement 187
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Nikon TE2000
filter cubes 21

non-interlocked service panels 11
numbering

hotel racks 199

O
Objective and Camera tab 74
objectives 21

changing 160
cleaning 161
correct placement 160
Nikon, compatible with system 189
oil-immersion 162

optical path 26

P
peripherals 153
plate

clamp 22
Plate Acquisition and Control dialog 69
Plate Acquisition dialog 68
Plate Acquisition Settings dialog 68
Plate Acquisition Setup dialog 70
Plate dimensions 76
plate holder 22
plates

loading 198
Post Acquisition tab 118, 120
power

consumption 187
requirements 187

power supply 14
external 14

protective housing 10

R
replacing

filter cube 155
fuse 154

research-mode imaging 162

S
safety interlocks 10
Save Acquisition dialog 123
scheduling journals 114
Screening menu 67
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site requirements 187

power 187
space 187
weight support 187

Sites to Visit tab 83
solid-state lamp 12, 153
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site requirements 187
Summary tab 121
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temperature
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Timelapse options 87
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